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Getting Started 
The term "PowerPack emulator" refers to any PowerPack® in-circuit emulator for embedded 
system development. The terms "PP", "SW", and "EA" refer to the PowerPack PP, SW, and 
EA emulators respectively. The terms "SLD software", "emulator inteiface", and "debugger 
software" refer to the SLD™ source-level debugger. 

This chapter describes the emulator and debugger documentation, host system requirements, 
and how to contact Microtek International for information and technical support. 

Documentation 

Resource 

Hardware 
Reference 

User's Manual 

How to ... 

SW User's Manual 

The following describes the printed and on-line documentation 
resources for the PowerPack emulators. The manuals in your emulator 
package are the SW™ Source-Level Debugger User's Manual 
(referred to as the User's Manual) and either the PowerPack® EA/SW 
In-Circuit Emulator Hardware Reference, the PowerPack® EA-NS486 
In-Circuit Emulator Hardware Reference, or the PowerPack® PP In­
Circuit Emulator Hardware Reference (each referred to as the 
Hardware Reference and formerly known as the Up & Running). 
Other, related publications described at the end of this list are not 
included in your emulator package. 

Chapter 

Getting Started 

Software Installation 

Contents 

Parts, features, documentation, support 

Configuring your PC or workstation; 
installing the SLD software 

Hardware Installation Installing the PowerPack hardware; running 
the confidence tests 

Tutorial 

Target Hardware 

Getting Started 

Defining the Debug 
Environment 

Debugging in Source 

I 

Practicing basic emulator tasks 

SAST board schematics; signals 

Host sytem requirements; contacting Microtek 

Creating a loadfile; starting and exiting the 
SLD software; configuring memory and 
registers; using an initialization file 

Viewing source code, disassembly, and stack; 
editing variables; controlling emulation 
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Reference 

~ 
PowerPack 

SLD Help 

For help on using 
online help, choose 
How to Use Help from 
any SLD Help menu or 
press <F1 > twice. 

Related 
Publications 

Getting Started 

Debugging in 
Registers and 
Memory 

Debugging with 
Triggers and Trace 

powerpak.ini File 

Toolbar 

Shell Window 

Source Window 

Variable Window 

Breakpoint Window 

CPU Window 

Stack Window 

Memory Window 

Peripheral Window 

Trace Window 

Event Window 

Trigger Window 

Accessing CPU and peripheral signals and 
numeric or disassembled memory contents 

Emulation and trace control using triggers; 
numeric and symbolic address formats 

powerpak.ini file contents 

Toolbar controls 

Shell window contents, controls, commands 

Source window contents, controls 

Variable window contents, controls 

Breakpoint window contents, controls 

CPU window contents, controls 

Stack window contents, controls 

Memory window contents, controls 

Peripheral window contents, controls 

Trace window contents, controls 

Event window contents, controls 

Trigger window contents, controls 

Whether or not the emulator is active, you can invoke the SLD online 
help from within Windows. Choose the SLD Help icon (shown at left). 
SLD online help conforms to the standard Windows help interface, as 
described in your Microsoft Windows documentation. 

For help from within the SLD software, choose a Help menu item; or, 
press <Fl> at any time. In most SLD dialog and message boxes, you 
can choose a Help button for context-sensitive help. In the Shell 
window, you can list Shell command syntax with a Help command. 

Topic Resource 

Windows 3.1; Windows 95; 
Windows for Workgroups 3.11 

Your target processor 

Your toolchain and loadfile 
format 

C++ name mangling 

2 

Microsoft documentation 

Your chip vendor documentation 

Your compiler, assembler, linker, 
and converter documentation 

The Annotated C++ Reference 
Manual, Margaret Ellis and Bjarne 
Stroustrup (Addison-Wesley, 1990) 
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How to Contact M icrotek 

To register for technical support and ongoing product information, 
complete and mail the registration card enclosed with the emulator. 

Contact Microtek/DSD to purchase an Extended System Warranty 
(ESW). An ESW provides firmware, software, and hardware updates 
and priority service, in addition to repairs. 

As a Microtek customer, you can contact Microtek technical support for 
help with an emulator problem during your warranty period. The email 
and fax lines are operational 24 hours a day, 7 days a week. 

Internet email csupport@microtekintl.com (technical support) 
info@microtekintl.com (other information) 

World Wide Web http:\\www.microtekintl.com (product news) 

Microtek/DSD, 
Western USA 

Microtek, 
Eastern USA 

Microtek, 
Hsinchu, Taiwan 

Adara 

(503) 645-7333 voice; (503) 629-8460 fax 
(voice contact available Monday through Friday, 
8:00 am to 5:00 pm USA Pacific Time) 

(610) 783-6366 voice; (610) 783-6360 fax 
(voice contact available Monday through Friday, 
8:00 am to 5:00 pm USA Eastern Time) 

+886-35-77-2155 voice; +886-35-77-2598 fax 
(voice contact available Monday through Friday, 
8:00 am to 5:00 pm Taiwan Time) 

+886-2-501-6699 voice; +886-2-505-0137 fax 
International, (voice contact available Monday through Friday, 
Taipei, Taiwan 8:00 am to 5:00 pm Taiwan Time) 

Before you call, please read the PowerPack® Emulator Problem Report 
Form in the SLD on-line help. 

When you call, please be at your computer with the SLD software 
running and have the emulator documentation and filled-out problem 
report form (printable from the on-line help) nearby. 

Host System Requirements and Recommendations 

SLD User's Manual 

• An Intel486 or Pentium processor based or 100% compatible PC 

• Windows 95; or, MS-DOS 5.0 or 6.x with Windows 3.1 or 
Windows for W orkgroups 3 .11 running in 386-enhanced mode 

• At least 8M bytes of RAM 

3 Getting Started 



Getting Started 

• At least 8M bytes of free memory after you have loaded your 
Windows interface and any other applications besides the SLD 
software. 

• At least 5M bytes of available disk space 

• A VGA or Super VGA graphics card and color monitor (a graphics 
accelerator card recommended to boost performance; a monitor 
capable of at least 800x600 operation recommended) 

• Amouse 

• A serial port for connection to the emulator (16550 UART 
recommended for operation at 57 .6K baud and above) 

• At least 4M bytes for a swap file (permanent swap file 
recommended, with a disk cache such as smartdrive for improved 
Windows performance) 

• Config.sys entries of at least Files=30 and Buffers=30 
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Defining the Debug Environment 
This chapter describes how to: 

• Create a loadfile for symbolic debugging and emulation. 

• Invoke and exit the SW software. 

• Configure the emulator for your target processor and your personal working style. 

• Create and run command scripts, including an automatic command script. 

Creating a Loadfile 

To debug at the source level (with source code and symbolic names), 
you must retain symbolic debugging information in your loadfile. Use 
compiler, assembler, and linker switches to suppress optimization and 
to add symbolic information. See your toolchain documentation. 

Be sure your loadfile is in OMF86 or OMF386. Most x86 toolchains 
can generate the appropriate format. Contact your toolchain vendor for 
specific information. 

The emulators and debuggers are not guaranteed to work correctly 
Toolchain with unsupported toolchains. 

;CiiAiUiiTiliOiNiiill For information on toolchain options, see the Hardware Reference and 
~ the readme.txt file. 

Starting and Ending an Emulator Session 

Power 
CAUTION 

Turn on the emulator before turning on your target system. Power 
must be applied and removed in the correct sequence. Failure to 
follow this sequence will severely damage your target system and the 

;iiiiiiiiiiill emulator. Turn power on in the following sequence: 

II 
PowerPack 

SLD 

SW User's Manual 

I. Apply power to the emulator. 

2. Apply power to the target system. 

Once the software is installed on your host computer, the firmware is 
loaded into your emulator, and your target system and the emulator are 
powered-on, start an emulation session from the PowerPack SLD icon 
(shown at left). The first time you invoke the SLD software after 
installation, a series of dialog boxes require initial information. 

5 Defining the Debug Environment 



Toolbar: the SLD 
software's main control 
panel 

Power 
CAUTION 

The Toolbar is the first SLD window to appear and must remain open. 
Closing the Toolbar exits the SLD software. Minimizing the Toolbar 
hides any other open (including minimized) SLD windows; restoring 
the Toolbar redisplays (with the same screen layout) those SLD 
windows. 

Toolbar buttons and menus provide quick access to the most frequently 
used commands and windows. Grayed-out buttons indicate features 
unavailable for a particular processor or emulator configuration. 

II PowerPack SLD Toolbar ~ 
Eile !;onfigure !,,ayout \{'iindows !:!_elp 

Misc 

Before starting emulation, initialize the emulator for the modules you 
are debugging and arrange the desktop for your own convenience. Such 
preliminary tasks can include: 

• Start a record of your Shell window activities. 

• Map memory and specify some loading options. 

• Enable display updates to occur during emulation. 

• Enable signals and specify initial CPU and peripheral register 
values. 

You can do many of these tasks with the SLD menus and buttons, from 
the Shell window command line, or from a script (an ASCII file of 
Shell commands) in the Shell window. You may also need to edit 
powerpak.ini with a text editor. 

To end an emulator session, do one of: 

• Choose the Exit command from the file menu on the Toolbar. 

• Double-click the system box in the upper left corner of the Toolbar. 

• With focus on the Toolbar, press <Alt><F4>. 

Turn off your target system before turning off the emulator. Power 
must be applied and removed in the correct sequence. Failure to 
follow this sequence will severely damage your target system and the 

'iiiiiiiiiiiiiil emulator. Tum power off in the following sequence: 

1. Remove power from the target system. 

2. Remove power from the emulator. 

Defining the Debug Environment 6 SW User's Manual 



Selecting a COM Port and Baud Rate 

Select COM Port 
dialog box for serial 
communication 
between your PC and 
emulator 

Select Baud Rate 
dialog box for 
communication 
between your PC and 
emulator 

If your emulator is connected to your host PC via RS-232C serial 
communications and you are starting the SLD software for the first time 
since installation, you must specify the COM port and baud rate used 
for communication between your host system and the emulator. Your 
choices are saved in powerpak.ini. In the Select COM Port dialog box, 
choose the appropriate serial port and choose Connect. 

Select COM Port 

Com Ports I fc~nneCii I 
0COM1 

@ COMl_ !;ancel 

OcoMJ 
0 COMA !::!elp 

In the Select Baud Rate dialog box, choose the appropriate baud rate. 
On some host systems, baud rates above 57600 can require a special 
Windows driver. 

Select Baud Rate 

f!_aud Rate 

0 ll!.200 

0 J.8400 !;ancel 

® li_7600 

0 115200 !::!elp 

Co-ordinating lntel386 Emulator and Target CPUs 

CPU Configuration 
dialog box for co­
ordinating the 
emulator's bondout 
processor with your 
target processor 

SW User's Manual 

For an Intel386 emulator, a CPU Configuration dialog box appears the 
first time you start the SLD software. (If you first see a message box 
asking you to remove a jumper, ensure there is no jumper on TPl.) 

CPU Configuration 

!;_mulo.tor CPU: Iarget CPU: 

jif;jHitt@Ml:I !Jossx l#J 

7 Defining the Debug Environment 



In the Target CPU field, select the processor in your target design. In 
the Emulator CPU field, select the stepping of the bondout processor in 
the emulator probe head. To discover the stepping, look for the part 
number (FPO) on the chip. Production FPOs are 8 digits followed by a 
change indicator. Pre-production and obsolete parts use a 5-digit code 
starting with Q. 

CPU 

386EX 

386CXorSX 

Step 

A 

B 

c 
A 

B 

Production FPO Pre-production FPO 

xAorxB Q8492 

xD Q7949 

Q8042 

xA Q8307 

xB Q8543 

Starting a Log File 

A logfile records all that appears in the Transcript pane of the Shell 
window. The following sample sequence sets up the Transcript pane 
and opens a log file to record Shell commands and results. 

Sequence of Shell Echo On; 
commands for logging 

II Commands you enter appear 
II in the Transcript pane. 

Results On; II Results of the commands appear 
II in the Transcript pane. 

DasmSym On; II Disassembly in the Transcript 
II pane uses symbol names. 

Log "emu1 .log"; II The log filename is emu1 .log. 

Overwrite; II Each time you start logging overwrites any prior 
II logging. The opposite command is Append 

Logging On; II Start writing to emu1 .log. The date and time 
II are recorded when you start and stop logging. 

Version; II Display and log version information for 
II the emulator, DOS, and Windows. 

II... II Your emulation session activities ... 

Logging Off; II Stop writing to emu1 .log. 

You can do some of the above commands in the Shell window menus 

• To echo commands, toggle the View menu Echo Command item. 

• For results display, toggle the View menu Show Results item. 

Defining the Debug Environment 8 SW User's Manual 



Shell window View 
menu with Echo 
Command and Show 
Results enabled 

Shell window Options 
menu with Log Results 
disabled (logging is 
stopped) and 
Overwrite Log File 
enabled 

-I Echo Command 
-I Show Results 

,Clear Transcript 

• To specify whether to overwrite or append new information to an 
existing log file, choose the Options menu Overwrite Log File item 
or Append To Log File item. 

• To specify the log filename, fill-in the Options menu Log File 
Name dialog box. 

• To start or stop logging, toggle the Options menu Log Results item. 

The next time you start logging, the new log overwrites any previously 
logged information, destroying the logfile's previous contents. 

.Log Results 
Log file Name ... 

~ppend To Log File 
-I Qverwrite Log File 

Set History Size ... 

Set Iranscript Size ... 

Mapping and Initializing Memory 

Map dialog box with 
128K bytes of overlay 
memory mapped for 
RAM (unrestricted 
read and write) access 

SLD User's Manual 

This section applies to emulator configurations with overlay memory. 

Before loading your code or symbols, you must map memory. You can 
use a memory map saved previously or specify a new configuration. 

Open the Map dialog box from the Toolbar either with the Map button 
or by choosing the Configure menu Map item. The following shows a 
Map dialog box with 8K bytes mapped. 

Start Addr End Addr Space 

r.,,.,.,., ..• •§H!Uliiii •.l= User 

8dd 11 Edit 11 D.elete I I .S.ave 11 Restore I I ,Close 11 t!elp 

The Map dialog box lists any already configured sections of memory. 
Use the buttons along the bottom of the Map dialog box to: 

Add Configure a new section of memory. 

9 Defining the Debug Environment 



Edit 

Delete 

Save 

Reconfigure the selected section. Use the mouse or arrow 
keys to select from the list in the dialog box. 

Revert the selected section to unconfigured memory. 

Save to a map file the memory configuration listed in the 
dialog box. 

Restore Configure memory from a previously saved map file. 

The Add and Edit buttons pop-up a dialog box to specify regions as: 

• for PP-386 and SW-386 emulators, any multiple of 4K bytes 
starting on any 4K address 

• for EA-486 emulators, any multiple of 128K bytes starting on any 
128K address 

• for EA-NS486 emulators, any multiple of 64K bytes starting on any 
64K address 

You can specify the size either as a hexadecimal number of bytes with 
the Length button selected or by a hexadecimal ending address with the 
End Addr button selected. 

The Add and Edit dialog boxes also provide mapping options, with 
inapplicable options greyed-out depending on the target processor: 

• overlay or target memory, as listed in the Map dialog box Type 
column 

• for 386 EX, 386 CX, and Intel486 SLE processors, User or SMM 
space, as listed in the Map dialog box Space column 

• how the emulator treats memory accesses, as listed in the Map 
dialog box Access column: 

RAM 

ROM 
break 

allows reads and writes without breaking. 

allows reads; disallows writes; an attempted write 
causes a break. For 386 and lntel486 emulators with 
memory mapped to Target, writes are allowed but break 
emulation. This option is unavailable for EA-NS486 
emulators. 

ROM allows reads; disallows writes; does not break on any 
nobreak access. For 386 and lntel486 emulators with memory 

mapped to Target, ROM nobreak is the same as RAM; 
that is, writes are allowed and do not break emulation. 

NONE disallows reads and writes; breaks on any access. For 
386 and lntel486 emulators with memory mapped to 
Target, accesses are allowed but break emulation. This 
option is unavailable for EA-NS486 emulators. 
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Edit dialog box, 
accessed from the 
Map dialog box Edit 
button; similar to the 
Add dialog box 
popped-up from the 
Map dialog box Add 
button 

Mapping: Shell 
command sequence 

Edit 

S.ta rt Add r: I DID ~ Iype: I overlay [!I 
Length/End Addr 

Access: [RAM l!I 
@ Length: [ Ox2000 
0 _End Addr: ~ [Space Mode 

IZl .\lser OS.MM 

QK .C.ancel !:!elp 

You can also use the Shell window to map memory. The following 
sample sequence of commands prepares a 386 emulator and memory for 
loading code or symbols: 

Map Clear; 

RestoreMap "emu1 .map"; 

II Maps all memory to target, removing 
II any existing map configuration. 

II Maps memory from a map saved 
II previously. emu1 .map contains 

II the line: map OxO Oxffff ram. 

Map Ox10000 RomBrk; II emu1 .map maps only part of memory, 
II not including the 4K-byte block starting 

II at address Ox10000. This Map command 
II configures memory from Ox10000 to Ox1 Offf 

II as ROM and specifies that any attempt to 
II access this space will break emulation. 

Loading a Loadfile 

Loading: Shell 
command sequence 

SW User's Manual 

Once memory is configured, you can load the file to be debugged. The 
PowerPack emulators support OMF86 and OMF386 loadfile formats. 

For loadfiles generated with the Borland C compiler, before loading 
enter MaxBitFieldSize 16 on the Shell command line. 

You can load a file during emulation. Be sure the file's load addresses 
do not overlap the memory occupied by the running program. Loading 
a file at a location in use stops the emulator in an unpredictable state. 

The following sample sequence of commands loads code and symbols: 

Loadsize Long; II (default) The loadfile is written to memory 
II in double-word accesses, which is the 

II fastest way to load code. 

Load "myfile.obx" code symbols nodemand nowarn status; 
II Load code and symbols from the myfile.obx loadfile. 

11 Defining the Debug Environment 



Source window File 
menu showing the two 
most recently used 
loadfiles 

Load dialog box, 
accessed from the 
T oolbar Load button 

You can do the above operations using various SLD window menus. 
To load code and symbols, open the Load dialog box with the Toolbar 
Load button or with the Source window File menu Load File item. To 
reload one of the last four files loaded, you can choose a Source window 
File menu loadfile pathname. The pathnames are added to the bottom 
of the File menu as you load files. 

.Load Code ... 
Load 1nformation ... 

Browse Modules ... 
Erevious Browsed Module 
Next Browsed Module 

E~it 

l ... ERPAKISAMP3B6\DEM0386.0MF 
.2 ... POWERPAK\SAMP3B6\DEMO.OMF 

In the Load dialog box, the name of the previous file that was loaded is 
automatically filled-in. Or, you can browse the directory and file lists to 
specify a different loadfile. 

Filetl_ame: 

I demo386.omf 

demo.om! t ,. w!l!Kf 

I--
+ 

--------
Load 

Qi rectories: 

c:\powerpak\samp386 

E7 c:\ 
127 powerpak 
~samp386 

List Files of Iype: Drill_es: 

~jo_M_F_x_B6_F_i_le_s(*_._o_M_F)_~I~:! I j IEl c: ms-dos_62 

QK 

kancel 

OQ.tions ... 

.!::!elp 

r;:-1 Network... 

Before choosing the OK button to load the file, you can choose the 
Options button in the Load dialog box to open the Load Options dialog 
box. The loadfile format (OMF86 or OMF386) and the target processor 
determine what options are available; some options may be missing or 
greyed-out on your emulator. If you have already loaded a file, the 
options you specified previously are preserved. 
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Load Options dialog 
box, with options for 
loading an OMF386 
loadfile into a 386 EX 
emulator, popped-up 
from the Load dialog 
box Options button 

SW User's Manual 

Load Options 

OsMM 

l8J Load Code 

l8J Load furmbols 

D On Qemand Symbol Loading 

D Demangle C++ Names 

D Update Symbol !;!.ases 

D Load lnitial Register Values 

l8J B.eport Status 

D Report Warnings 

Q_K ] ~o.ncel I !::!_elp 

Be sure the space option (User or SMM) you select is compatible with 
the address space you configured in the Map dialog box. This option is 
applied to where the code is loaded. 

You can load code, symbols, or both from any loadfile. For example, 
load only code if symbols are already loaded; load only symbols for 
debugging ROM code. To load code, check the Load Code box. To 
load symbols, check the Load Symbols box and any combination of 
boxes under Load Symbols: 

• On-demand symbol loading defers loading local symbol and line­
number information for each module until it is needed; i.e. until 
either the module is displayed in the Source window or a 
breakpoint is set in the module. Advantages of on-demand symbol 
loading include faster initial loading, faster lookup for the symbols 
that are demanded, and less memory occupied by the loaded file 
because only the fewest required symbols are loaded. 

• For C++ code containing virtual functions, overloaded functions, 
and some other symbol types, the emulator can demangle the first 
instance of each such symbol. Subsequent instances remain 
mangled in the emulator symbol table rather than duplicated, so 
you can access all symbols in your program. However, the names 
do not appear mangled in your source. The warning message C++ 
duplicate name detected alerts you to the presence of mangled 
names. 

• OMF386 symbol server base addresses can be updated in 
conjunction with register initialization. 

OMF386 startup code or linker directives can initialize the processor 
registers. 
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Load Complete dialog 
box, similar to the Load 
lnformaton dialog box, 
showing the results of 
loading an OMF86 
loadfile 

You can request or suppress information about the load process and 
results. For a dynamic report of the loading process, check Report 
Status. In the Load Complete dialog box, a bar graph fills to indicate 
the percent loading complete; loading statistics are updated 
continuously during the load process. To review the load information 
after closing the Load Complete dialog box, open the Source window 
File menu Load Information dialog box. 

Load Complete 

Loadfile: C:\PO\llERPAK\SAMP386\0EMO.OMF 

Module: 

Bytes: 886 Lines: 213 
Modules: 3 
Symbols: 96 PC: 0200:01AO 

Types: 333 Stack Base: 0026:1000 
Functions: 5 Stack Size: OxlOOO 

.!!K I I !:!.elp 

Suppress warning messages during loading by un-checking Report 
Warnings. 

Symbolic Addresses 

Any program symbol, interpreted as a symbolic <segment>:<offset>, 
is a virtual address. You can reference a symbol in a command, dialog 
box, or expression. Simplify such references by taking advantage of 
how the emulator resolves names. For example, for a symbol in the 
current module, you need not specify the module and function. 

The loader creates a symbol table with the names of all modules, 
functions, variables, and line numbers in the loadfile. The symbol 
information is hierarchical, with each symbol representing a range of 
addresses that can contain other symbols. At the top of the hierarchy 
are modules, public labels, and public variables. The subsequent levels 
are: 

Modules contain functions, static variables, and line and column 
numbers. 

Functions contain parameters, local variables, static variables, line 
numbers, and blocks. 

Blocks are handled as unnamed functions. Nested blocks can 
contain local and static variables defined in scope. 
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One-name symbols 

SW User's Manual 

Using this symbol hierarchy, you can uniquely specify any symbol. 
Fully qualified symbols have one, two, or three alphanumeric names 
beginning with#. Partly qualified symbols default to the current 
module and function, that is, the scope of the current program counter. 

1. Look up the symbol at the lowest level of the hierarchy. 

2. If no match is found, look up the symbol at the next level. 

3. If no match is found, look up the symbol at the global level. 

4. If no match is found, the symbol name does not exist. Return a 
symbol-not-found error. 

To find the address of a symbol with one name: 

• If the module and function are defined by the context, look up the 
name as a variable within the scope of the function. 

• If the module but not the function is defined by the current context 
(for example, you have stepped from the module into a called 
assembly routine), look up the name within the scope of the 
module. 

• If no module or function is defined by the current context, look up 
the name as a module, public variable, or label. 

• If the name is a number, look up the number as a module name or 
as a line number within the current module. 

#module1 Returns the beginning address of modulel. 

#function1 For a function in the current module, returns the address. 
Otherwise, returns the address of a function in the global 
table. (Only static functions are not in the global table.) 

#variable 1 Returns the address of a global or public variable or of a 
variable inside a nested block, function, or module. 

#55 Returns the address of line 55 in the current module. 

To find the address of a symbol with two names: 

• If a module is defined by the current context, look up the first name 
as a function contained within the module. Otherwise, look up the 
first name as a module, then as a global function. 

• If the module and function are defined by the context, look up the 
second name as a variable within the scope of the function. 

• If the module but not the function is defined by the current context 
(for example, you have stepped from the module into a called 
assembly routine), look up the second name as a variable within the 
scope of the module. 
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Two-name symbols 

Three-name symbols 

• If no module or function is defined by the current context, look up 
the second name as public variable or label. 

• If the first name is a number, look up the first name as a module 
name or as a line number within the current module. If the second 
name is a number, look up the second name as a line number if the 
first name is a module or function, otherwise as a column number. 

#55#15 Returns the address in the current module on line 
55, column 15. 

#module1#100 Returns the address of line 100 in module1. 

#module1#func1 Returns the address offunc1 in module1. 

#module1 #var1 Returns the address of var1 in module1. 

#func1 #var1 Returns the address of func1 in the current 
module. Or, if func1 is global, returns the 
address of var1 in the scope of func1. 

To find symbolic variables with three names: 

• The first name must be a module. The second and third names can 
be line and column numbers in the module; or, the second can be a 
function in the module while the third is a variable or line number 
in the second's scope. 

• If the third name is a variable it is first looked up within the 
module and function context. If not found, it is looked up as a 
global variable or label. A globle symbol's address is returned even 
if outside the scope of the module identified by the first name. 

#mod1#25#1 

#mod 1 #func1#100 

#mod1 #func1 #var1 

Returns the address of module mod 1, 
column 1, line 25. 

Returns the address of module mod 1, line 
100. 

Returns the address of module mod1, 
function func1, variable var1. 

To display line numbers in the Source window, open the View menu 
and check Line Number. In the Shell window, you can list all line­
number records for the current module with displaySymbols lines. 

Some line numbers are comment lines and have no compiled code. 

Enabling Memory Access 

You can access memory during emulation, to read or write the current 
values in target memory and on-chip peripheral registers (but not CPU 
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registers). Such reads and writes take a small, additional amount of 
processor time and can thus affect your program's performance. 
Memory access is initially disabled and must be enabled if, for example, 
you want to refresh the Memory or Peripheral window during 
emulation. To enable memory access, either: 

• On the Shell command line, enter RunAccess On. 

• Enable (check) the Toolbar Configure menu Run Access item. 

Run Access does not allow CPU register access. The CPU registers 
cannot be accessed during emulation; their display is updated only 
when emulation halts. 

Using a Script 

Shell window after the 
include.me sample 
initialization script has 
run, with an Include 
command to run 
custom.inc ready to be 
entered on the Shell 
window command line 

SW User's Manual 

A script is a text file of Shell commands. To run a script, use the 
Include Shell command or the Shell window File menu Include File 
dialog box. You can put an Include command in a script. 

In the powerpak.ini file [lnitScript] section, you can specify a script to 
run automatically at SLD initialization. Edit the script = line in 
powerpak.ini. For example, script = c:\sld\user\myscript. If you 
specify no pathname (for example, script = myscript), be sure your 
script is in the directory with the SLD software. 

include "include.111e"; 
II 
II Here is an exa111ple of a start up script: 
II 
II 
II 
II 
II 
II 
II 
II 
II 
II 
II 

uersion; 
alias "uer" ··uersion"; 
111ap o fffffp; 

II get uersion infor111ation abou 
II exa111ple of aliasing a co111111an 
II set up ouerlay 111e111ory 111ap 

This file, include.111e, is run each ti111e PowerUiews 
is brought up. Edit this file with co111111ands to set 
up your enuiron111ent. The [InitScript] section of 
the file pwruiews.ini (in your Windows directory) 
can be edited to eli111inate this feature or to 
change the na111e of the initial script file. 

17 Defining the Debug Environment 



Leveraging Previous Emulation Sessions 

You can shorten your setup time in subsequent emulation sessions by 
saving map, chip select, event, and log files. 

You can save the map information to a file. In the Shell window enter 
a MapSave command, specifying a path and filename; or, fill-in the 
Map dialog box Save button dialog box. Later, you can restore the 
saved map with a Shell window MapRestore command or the Map 
dialog box Restore button. 

You can save chip select information. In the Shell window enter the 
SaveCS command, specifying a path and filename; or, fill-in the 
Toolbar Configure menu Save Chip Selects dialog box. Later, you can 
restore the saved registers with the Shell window RestoreCS command 
or the Toolbar Configure menu Restore Chip Selects item. See the 
Hardware Reference for a list of the registers saved for each processor. 

You can save event definitions. In the Shell window enter an 
EventSave command, specifying a path and filename; or, fill-in the 
Event window File menu Events As dialog box. Later, you can restore 
the saved events with the Shell window EventRestore command or the 
Event window File menu Restore Events item. 

Instead of retyping command sequences, you can save the sequence to 
be made into a script that you can run with an Include command or 
automatically as the initialization script. During an early emulation 
session, even if you usually use the menus, open a log file and record 
lengthy or frequently repeated tasks by entering the commands in the 
Shell window. Edit the log file with a text editor, creating a script to be 
run in future emulation sessions. By logging an emulation session, you 
can test and record error-free command sequences. 

Keyboard Shortcuts 

You can use function keys instead of commands or menu items: 

Fl Open a window for SLD on-line help. 

F2 Halt emulation. 

F3 Start trace. 

F4 Stop trace. 

F5 Set focus to the Toolbar window. 

F6 Set focus to the next open SLD window. 

F7 Step Into. 
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F8 Step Over. 

F9 Start emulation (Go) 

FIO Activate the menu bar for keyboard use. 

Example: Enabling lntel386 EX Expanded Memory 

SW User's Manual 

You can read and write any peripheral register by editing the field 
values in the Peripheral window or by entering Dump, Fill, and Write 
commands on the Shell window command line. 

To access some of the peripheral registers with the Shell commands, 
you must first enable expanded I/O space. Once expanded I/O space is 
enabled, you can use both the Peripheral window and the Shell 
command line to access many peripheral registers. 

When expanded I/O space is disabled, the affected registers appear in 
the Peripheral window with question marks (?) in their address fields. 
A question mark indicates you can access the register via the Peripheral 
window but not from the Shell command line. 

To enable expanded I/O space, close (not minimize) the Peripheral 
window, then set the ESE bit in the REMAPCFG register by three 
sequential writes to I/O addresses Ox22 and Ox23. (The sequence must 
write twice to each address.) For example, enter the following Size 
and Fill commands on the Shell command line: 

Size Byte; 
Fill 23p 23p OxOO Byte 10; 
Fill 22p 22p Ox80 Byte 10; 
Size Word; 
Fill 22p 23p Ox0080 Word 10; 

The Size command specifies the physical size of the data access. The 
Byte and Word specifiers in the Fill commands inform SLD of the 
supplied data format. 
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Debugging in Source and Stack 
This chapter describes how to: 

• Set, view, and clear breakpoints. 

• Control program execution. 

• Examine and modify variables and the stack. 

Viewing Source 

Source window 
Options menu Source 
Path dialog box 

SW User's Manual 

After loading an executable file, you can view the source file associated 
with each module in the Source window. The Source window initially 
displays code at the current program counter (CS:EIP). The instruction 
or statement pointed to by the program counter is marked by>>. 

When you open the Source window after loading but before executing 
code, the program counter may be in the assembly startup code 
designed to execute before main(). If the startup code is from an 
available assembly source file, the Source window displays the assembly 
source. If the startup code was generated by the compiler, the Source 
window displays the disassembly from memory. 

To view a different module, choose the File menu Browse Modules 
item. All loaded modules are listed. If a module's source has been 
modified more recently than the loadfile, a warning message appears 
and an asterisk marks the source filename in the Source window title. 

If the emulator cannot find the source file corresponding to the module 
you are browsing, you may need to modify the source search path list. 
Modify the list in the Source window Options menu Source Path dialog 
box. 

--------
Source Path 

I B_dd... 11 ~diL I J .!!elete 11 Cl.!!.se 11 J;;.ancel 11 !:!_elp 

To add a pathname to the Source Path dialog box, choose the Add 
button and enter a directory or file pathname in the Open dialog box. 
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Edit Path dialog box, 
accessed from the 
Source window 
Options menu Source 
Path dialog box Edit 
button 

Source window 
Options menu Source 
Path dialog box listing 
multiple paths to be 
searched sequentially 
from top to bottom of 
the list 

To edit a path, use the mouse or the <Up Arrow> and <Down Arrow> 
keys to select a path in the Source Path dialog box; choose the Edit 
button; and edit the path string. 

Edit Path 

~ath: 

I !:!elp I 

The emulator searches the paths in the order they are listed in the 
Source Path dialog box, stopping at the first file that matches the source 
filename in the loadfile. If you have duplicate filenames in different 
directories, order the source path search list so the emulator finds the 
correct one first. For example, in the following, the emulator searches 
first samp386, then build-a, build-b, and finally build-c. 

-------

C: POWERPAK SAMPJB6 
c:\powerpak\samp3B6\build-a\ 
c:\powerpak\samp3B6\build-b\ 
c:\powerpak\samp3B6\build-c\ 

Source Path 

I Add... 11 J;.dit... 11 Qelete 11 Cl_qse 11 .C.ancel 11 !::!.elp I 

When symbolic information (including the source file pathname) is 
available for a module, you can view the module as source code with or 
without interleaved disassembly. Use the Source window View menu to 
toggle between Source Only and Mixed Source And Assembly. 
Modules with no associated source file can only appear as disassembly. 
To see symbols in the disassembly, check the Toolbar Configure menu 
Symbolic Disassembly item. 

You can split the Source window into two panes by clicking and 
dragging on the split box at the top of the vertical scroll bar. A split­
box cursor appears at the right of the split bar (see figure at left). To 
resize the panes, use the mouse to drag the split box. 

With two Source window panes, you can work in two different modules 
or two areas of the same module independently. To move between 
panes, click in the inactive pane to make it active. 

Debugging in Source and Stack 22 SW User's Manual 



Managing Breakpoints 

Breakpoint window 
listing the state 
(enabled or disabled), 
type (permanent or 
temporary), and source 
location of each 
currently defined 
breakpoint 

Shell window showing 
breakpoints listed in 
response to a Bkpt 
command 
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At a breakpoint, emulation halts before executing the instruction at the 
breakpoint address. A temporary breakpoint is then cleared; a 
permanent breakpoint remains. A breakpoint set on a non-executable 
statement automatically moves to the next executable instruction. 

In PP and EA emulators, you can set 256 software breakpoints; in SW 
emulators, you can set 128 software breakpoints. You can set up to four 
hardware breakpoints, which use the DR[0:3] debug registers. See the 
DR command description in the "Shell Window Reference" chapter. 

To display the currently set breakpoints, open the Breakpoint window. 

Eile Breakpoints Windows !::!elp 

Set Enable All Disable All 

State 

Enable Perm. 
Enable Perm. 

000020FCL dm_func,printall,line153,col0-1 
000020A4L dm func,remoue,line118,col0-1 

To list breakpoints in the Shell window, enter a Bkpt command with no 
arguments. 

file fdit )!'.iew Qptions Windows .tlelp 
bkpt 
II SRC bkpt: Ena Perm 2DOOL (@O) dm main,main,Line59 
II SRC bkpt: Ena Perm 20FCL (@1) dm=func,printall,Line153 
VI SRC bkpt: Ena Perm 2DA4L (@2) dm_func,remoue,Line118 

+ 

> 
+ 

You can set breakpoints from the: 

• Shell window Bkpt command 

• Breakpoint window Set button or Breakpoints menu Set Breakpoint 
item 

• Source window source display or various Breakpoints menu items 

To set a breakpoint from the Source window display, using the mouse: 

1. Move the mouse pointer to the left of the source line where you 
want to set a breakpoint. 

2. When the mouse pointer changes shape to a cross-hair cursor 
(shown at left), click on the primary mouse button to set a 
permanent breakpoint or on the secondary button to set a 
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Source window 
Breakpoints menu 

Set Breakpoint dialog 
box, accessed from 
either the Source 
window Breakpoints 
menu Set Breakpoint 
item, the Breakpoint 
window Breakpoints 
menu Set Breakpoint 
item, or the Breakpoint 
window Set button 

temporary breakpoint. (On a mouse configured for right-handed 
use, the primary is the left button and the secondary is the right 
button.) The line with the breakpoint is highlighted in red. 

Alternatively, using the Source window Breakpoints menu, either: 

• Position the Source cursor where the breakpoint is to be set and 
select Set Permanent Breakpoint or Set Temporary Breakpoint. 

• Regardless of the Source cursor position, choose Set Breakpoint 
and fill-in the Set Breakpoint dialog box. 

Emm..~ 

Set .E!ermanent Breakpoint 
Set Iemporary Breakpoint 
Set f!.reakpoint. .. 

.C.lear 
J;nable 
Qisable 

Clear All 
Enable All 
Disable All 

.Show All ... 

To set a breakpoint from the Breakpoint window, pop-up the Set 
Breakpoint dialog box from either the Set button or the Breakpoints 
menu Set Breakpoint item. 

The Set Breakpoint dialog box Breakpoint At field accepts both 
numeric and symbolic addresses. For symbolic addresses, you can 
browse the Modules and Functions drop-down lists. For C++ source, 
mangled names (which you can also list with a DisplaySymbols Shell 
command) appear in these drop-down lists. These names include 
member functions from all classes defined in a source module and its 
header files; global (non-class related) functions; and compiler­
provided default constructors and destructors. 

----------------~ 

Set Breakpoint 

Itreakpoint at: 

Modules f.unclions 

J,_d_m __ m_ai_n _______ _.J__,! J J main 
Stale---~ 

@-Enable 

0 l!_isable 

lfPe 
@ f.e1manenl 

0 I.empora1y 

_5.el CIQse 

Spac~: 

Juse1 

I !:!elp 

J!J 

J!J 
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Breakpoint window 
Breakpoints menu 

Set a breakpoint: 
multiple statements 
per line 

SW User's Manual 

You can co-ordinate the Source and Breakpoint window displays. To 
open the Breakpoint window from the Source window, choose the 
Source window Breakpoints menu Show All item. To display the 
source of a specific breakpoint, in the Breakpoint window highlight the 
breakpoint and choose either the Breakpoints menu Go To Source item 
or the Go To Source button. 

Set I!_reakpoint... 

~I ear 
Enable 
D_isable 

Clear 811 
Enable All 
Disable All 

!!_o To Source 

Avoid setting breakpoints on inline functions. The Set Breakpoint 
dialog box flags no inline functions. If you have set a breakpoint on a 
function and stepping does not advance the Source window cursor, it is 
an inline function. Stepping through instructions in your class 
definition advances the program counter but not the Source cursor. 
Remove the breakpoint on the function and restart emulation. 

In Mixed Source And Assembly view, the assembly instructions for all 
inline functions appear after the last source line of the module. 

If your program has more than one source statement per line number 
and the toolchain provides statement-level line number information, 
you can set a breakpoint on any statement in a line. For example: 

If ( errorNumber) errorHandler( errorNumber); 

To set a breakpoint on the errorHandler call, when errorNumber is 
nonzero: 

1. From the Source window Options menu, set the level of step 
granularity by toggling Step Execution Granularity to Statement. 

2. Click on errorHandler(errorNumber), open the Breakpoint menu, 
and choose Set Permanent Breakpoint. Or, double-click on 
errorHandler(errorNumber) and choose Permanent Breakpoint. 

3. The entire line is highlighted as a breakpoint, with the actual 
breakpoint set on the second statement. From the View menu, 
choose Mixed Source And Assembly to see the breakpoint on the 
second statement. 

To set a breakpoint at the statement level, you must know how many 
spaces your compiler uses for a tab character. For example: 
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How tab width affects 
setting breakpoints at 
statement level 

Using disabled and 
enabled breakpoints 

The following line of three statements is compiled with a tab width of 
eight: 

<tab><tab>for ( j = O; j < max_num; j++ } { 

The compiler tab width produces the following column ranges: 

j = O; columns 0 through 26 

j < max_num; columns 27 through 39 

j++ columns 40 through 45 

Setting the Source window tab width to four instead of eight puts j = O; 
at column 13 and j < max_num; at column 20. It is then difficult to 
set a breakpoint on the correct statement. 

Symbols must be loaded before you can set breakpoints on line numbers 
or functions. If you chose On Demand Symbol Loading when loading 
your program, the symbols needed for a breakpoint are loaded either 
when you set the breakpoint or when you display the source for the 
module containing them. 

You can enable and disable all or individual breakpoints, using either 
the Source or Breakpoint window Breakpoints menu Enable/Disable 
(All) items or the Breakpoint window Enable/Disable (All) buttons. An 
enabled breakpoint is defined and active; emulation breaks when the 
breakpoint is reached. A disabled breakpoint is defined but inactive; 
emulation does not break when the breakpoint is reached. 

For example, an interrupt handler named Mylntr (in a module named 
ModB) might be started at any time. To discover whether Mylntr is 
starting during execution of another function named Atomic (in a 
module named ModA), the designer does the following: 

1. Set a breakpoint, enabled, at the beginning of #ModA#Atomic. 

2. Set a breakpoint, enabled, at the end of #ModA#Atomic. 

3. Set a temporary breakpoint, disabled, at #ModB#Mylntr. 

4. Go. Mylntr can execute without causing a break. 

5. At the first Atomic breakpoint, enable the Mylntr breakpoint. 
Calling Mylntr during Atomic execution causes a break and clears 
the Mylntr breakpoint. If Mylntr is not called, at the second 
Atomic breakpoint disable the Mylntr breakpoint. 

You can remove all or individual breakpoints by any of: 

• Choose the Source or Breakpoint window Breakpoints menu Clear 
All item. 
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• In the Breakpoint window, select a breakpoint and choose Clear 
from either the buttons or the Breakpoints menu. 

• In the Source window, click in the left margin of the red­
highlighted line containing the breakpoint; or, move the cursor to 
the breakpoint and choose the Breakpoints menu Clear item. 

• On the Shell command line, enter a BkptClear command. 

Starting and Stopping Emulation 

Source window Run 
and Options menus 
and button bar 

SW User's Manual 

With the Source window buttons and menus and various Shell 
commands, you can emulate one or more instructions at a time or as a 
free-running program. 

§o 

!:!.alt 
.Step Into 
Step .Qver 

Go Until .Call 
Go Until Ret.!!.rn 
Go Into Call 
Go Into Return 

Goto Cursor 
Go .Erom Cursor 

Stej! Into Continuously 
Step Oyer Continuously 

R~set 

Reset And Go 

F9 
F2 
F7 
F8 

.... !l.IIlID'm 

Source J:ath ... 
Iab Width ... 

Source Step _!!ranularity 
Step .Count. .. 

ftrowser History Depth ... 

Source Line Qelimiter 

.Set Go Buttons 

Compiler J,!sed ... 

• 

• 
• 

Step breaks after executing one to 100 instructions or statements, 
according to how you set the Options menu Step Count and 
Source Step Granularity items. The Shell Step and 
StepSrc commands can do the same. 

Step Into and Step Over specify how transfer instructions 
(such as jumps or function calls) affect where emulation 
breaks after stepping: 

Into 

Over 

27 

breaks at the first instruction or statement 
at the transfer destination. 

breaks at the first instruction or statement 
following the transfer instruction. 
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Continuously repeatedly steps until you halt it. 

Go executes your program to the next enabled breakpoint or 
until you halt it. The Toolbar Go button and the Go Shell 
command do the same. The Golnto and GoUntil Shell 
commands provide the same functionality as the Go 
Until/Into Call/Return buttons and Run menu items. 

Reset 
And Go 

Halt 

From Cursor moves the program counter to the 
instruction at the Source cursor, then starts 
emulation. 

To Cursor 

Into Call 

Into Return 

Until Call 

emulates until the program counter reaches 
the Source cursor. 

breaks at the first instruction or statement 
at the next transfer destination. 

breaks at the first instruction or statement 
following the next transfer instruction. 

breaks at the last instruction or statement 
before the next transfer instruction. 

Until Return breaks at the last instruction or statement 
before a return from the next transfer 
instruction. 

To change the Into Call and Into Return buttons to Until 
Call and Until Return, select from the Options menu Set Go 
Buttons item Until Call/Return choices. 

Resets your target system, then operates as Go. The 
ResetAndGo Shell command does the same. 

Stops emulation. The Toolbar Halt button and the Halt 
Shell command do the same. 

To discover whether emulating or halted, look in the Status window or 
icon or enter EmuStatus on the Shell command line. When emulation 
has halted, to discover the cause of the break, look in the Status window 
or enter Cause on the Shell command line. 

How fast a Step operation executes depends on the number of SLD 
windows open. Each window must be updated after each step. You can 
close or minimize any open SLD window (except the Toolbar) to 
improve performance. Speeding up stepping can be useful when you 
use long or frequent Step Continuously operations. 

In C++, stepping into a declaration can call a constructor with any 
initialization parameters and its base class constructors. 
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Examining Source After Emulating 

SW User's Manual 

The Source window display shows the next statement or instruction: 

• When emulation halts at a breakpoint, the program counter stops at 
the instruction containing the breakpoint. 

• When emulation halts after a Step Into or Go Into Call, the 
program counter points to the first instruction in the function. 

• When emulation halts after a Step Over or Go Into Return, the 
program counter points to the first instruction after the return. 

• When emulation halts after a Go Until Call or Go Until Return, the 
program counter points to the call or return instruction. 

In Source Only view, a function with no associated source is not 
displayed after a Step Into when the program counter points to the first 
instruction in the function. To display the disassembly of such a 
function, toggle the view to Mixed Source And Assembly. 

You can also view disassembled instructions in the Memory window or 
by entering a Dasm command on the Shell command line. 

To modify loaded instructions, use the Memory or Shell window as 
described in the chapter on debugging in registers and memory. Such 
code patching is reflected in the disassembly shown in the Source 
window in Mixed Source and Assembly view. Note that the 
disassembly at the patched addresses no longer matches the source file 
contents. 

For C++, you can select the following mangled or demangled symbols 
in the Source window: 

• Function symbols 

• Global variables 

• Global class objects 

• Local variables and class objects 

You cannot select class.memberFunction type objects. 

The scope-resolution operator(::) is interpreted as a token separator, 
not recognized as part of a symbolic address. 

Scrolling Trace With Source 

When the Source and Trace windows are linked, you can scroll through 
the Trace window and view the corresponding code scrolling 
synchronously in the Source window. To link these displays: 
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Trace window View 
menu co-ordinating the 
Trace and Source 
window displays 

Variable menu, 
popped-up by double­
clicking on a variable 
named MsgTx in the 
Source window 

1. In the Trace window, open the View menu and choose Instruction 
to display the trace as disassembly. 

2. Re-open the View menu and choose Linked Cursor. 

.Clock 

.6_us 
J lnstruction 

J Linked Cursor 

J Iimestamp 

J Auto 
Usel6 
UseJ2 

Examining and Editing Variables 

You can examine and edit global, static, and local variables in the 
Variable window by either: 

• 

• 

In the Source window, double-click on the name of the variable you 
want to view. In the pop-up menu, choose Inspect Variable. 

II Variable: MsgTx 
Inspect Variable 
Set Eerm. Breakpoint 
Set Tern . Break oint 

In the Variable window, open the Variable menu, choose Add, and 
enter the name of the variable you want to view. Specify a fully 
qualified symbol. 

In the Variable window, you can: 

View 

Dereference 

variable types and values. Non-pointer variables 
appear in magenta. For enum type variables, the 
enumerated name follows the hexadecimal value. For 
example: 

enum color c = Ox2 = lavender 

a pointer variable by double clicking. Dereferenceable 
pointers appear in blue. For example, DS:OOOE is the 
address of the variable pointed to by cellPtr: 

CELL_ TYPE *printall#cellPtr = DS:OOOE 

To dereference a pointer, either double click on the 
pointer name, or select the pointer and choose the 
View menu Show item. A new line appears in the 
Variable window listing the location pointed to. The 
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Variable window 
showing cascaded 
dereferenced pointers 

Edit 

Select 

Remove 

Retrieve 

following shows a Variable window with next 
dereferenced from the first entry (cur) and stringPtr 
dereferenced from the second entry (the dereferenced 
next): 

LIHKS remoueD*CUr { 
struct LIHKS *next = DS:OOOO; 
signed char *StringPtr = DS:OOOO; 
signed short int length = OxO = O; 

LIHKS remouettcur->*next { 
struct LIHKS *next = DS:0053; 
signed char *StringPtr = DS:OOOO; 
signed short int length = OxO = O; 

} 
signed char remouettcur->next->*stringPtr = 
+ 

a value. Editable values appear in red. Integer 
variables can be edited in hexadecimal or decimal, 
floating point variables in floating point format, and 
characters in their hexadecimal ASCII equivalent. To 
edit a value, either double-click on the value; or single­
click on the value and choose the Edit menu Edit item. 
Press <Enter> to end editing or <Esc> to cancel 
editing. Outside of the current stack context, local 
variable values are unknown. 

a variable or its value by clicking on it. Yellow 
indicates a selected symbol or value. 

a selected variable from the display. Either choose the 
Variable menu Delete item or press the <Delete> key. 
This does not delete the variable from your program, 
only from the current variable inspection list. 

removed variables with the Variable menu Undelete 
item. 

You can also examine program symbolic information using the Shell 
AddressOf, NameOf, ConfigSymbols, DisplaySymbols, GetBase, 
SetBase, and RemoveSymbols commands. 

Monitoring the Stack 

SW User's Manual 

The Stack window contains a stack list pane, a variables list pane, and a 
stack meter. (You can also list the stack information in the Shell 
window using Stacklnfo and DisplayStack commands.) 
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Stack window with 
emulation halted in 
remove, called from 
main, showing stack 
usage down to 50.0% 
from the high-water 
mark (arrow on the 
right of the stack 
meter) of about 58% 

111~~~~~-St-ac-k~~~~~-llllJ 

file .Qptions Windows .l::!elp 

stack Return 50.0% 
ss,eeeeescc CS:FFFFE40C remove( ... ) 
ss:0eeeesos cs:FFFFE315 main( ... ) 

Parameters & Local Uariables 
signed long removeMplace = 0x3 = 3; + 
signed long removeMi = 0x0 = 0; 
struct LINKS KremoveMptr DS:000001DA; 
struct LINKS *removeMcur = DS:00000158; 

.. 

Configuring the Stack Window 

Once a program has executed into one or more functions, the stack list 
contains frames representing the nested calls. Frame information can 
include the stack and return addresses of the functions, names of 
functions with symbolic information available, and the parameters and 
local variables associated with the function calls. The top frame 
represents the function currently in scope. 

When symbolic information is available for a function, you can display 
the parameters and local variables in the variables list pane by selecting 
the frame in the stack list pane. Variables appear in the same format as 
in the Variable window. 

Stack usage is described by the stack meter. The percent of stack area 
currently in use appears in blue. 

To configure the stack and return address display, toggle the Options 
menu Include Stack Address and Include Return Code Address items. 
The stack address is the address of the frame in the stack area. The 
return address is the load address of the next instruction in the calling 
function. 
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Stack window Options 
menu with all stack 
statistical displays 
enabled 
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m:• lllI!Ill'm 
.S.tack Area ... 
Alarm Limit ... 

.,/Include Stack Address 

.,/Include Return .Code Address 

.,/Enable tligh-Water Mark 

.,/Enable Alarm Limit 

Inspect Source 

To view the source or disassembly of a function, select the frame and 
choose the Options menu Inspect Source item. The Source window 
displays the function. 

You can configure the stack meter to show the highest level the stack 
has reached since initialization. This high-water mark is an arrow on 
the right of the stack meter. Enable (check) the Options menu Enable 
High-Water Mark item; or enter an EnableHighWaterMark Shell 
command. 

You can set an alarm on the stack meter to notify you when stack usage 
exceeds a specified percentage of the stack area. If the alarm limit is 
exceeded when emulation halts, a warning message appears. Choose 
the Options menu Alarm Limit item and specify a percent value from 1 
to 100. Then, enable (check) the Options menu Enable Alarm Limit 
item. Alternatively, in the Shell window you can set an alarm limit and 
enable the alarm message with SetStackAlarm and 
EnableAlarmLimit commands. The alarm limit appears as a red line 
across the stack meter. 

No alarm message appears until emulation halts. During emulation, 
the stack can exceed the alarm limit without displaying the warning 
message. To monitor the amount of memory used by the stack while 
emulation continues, emulate by stepping continuously. Choose the 
Source window Run menu Step Over Continuously or Step Into 
Continuously item. 

Halting emulation updates the stack information with the: 

• current function and variable information 

• percentage of the stack in use 

• High-Water Mark, if enabled 

• alarm, if enabled 

If, after emulation halts, the monitored stack area is discovered to be 
mismatched with the program's stack area, some Stack window features 
are invalidated and grayed-out in the menus. For example, the alarm, 
high-water mark, and stack meter become unavailable. 
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Monitoring multiple 
stacks 

Stack Area dialog box, 
accessed from the 
Stack window Options 
menu 

Determining how large 
a stack area to allocate 

For multiple stacks, you can track the stack currently in use. Create 
Shell aliases to define the base and size of each stack. For example: 

alias "s1" "SetStackArea 4000 100"; 
· alias "s2" "SetStackArea 3000 100''; 

When emulation halts, switch to monitoring the current stack by 
entering one of the aliases on the Shell command line. 

Setting the Stack Base Address and Size 

The stack base address and the stack size are typically put into the 
loadfile by your compiler. Otherwise, the emulator looks for a default 
stack base address in the powerpak.ini file. If powerpak.ini also 
specifies no base address, the current stack pointer (SS:ESP) value is 
used. An undefined stack size defaults to 4K bytes. 

To discover the current stack base and size, either enter Stacklnfo on 
the Shell command line, or in the Stack window open the Options menu 
and choose Stack Area. The values in the dialog box describe the 
current stack allocation. The following shows a Stack Area dialog box. 

Stack Area 

Base Address: 

fg11mmu~11u 

Number of Bytes: 

QK .Qancel [ I !:!elp 

If you edit these values, ensure the Base Address matches your 
program's stack base and the Number of Bytes accommodates as much 
of your program's allocated stack area as you want to watch. When the 
SS:ESP is outside the stack area recognized by the emulator, the stack 
statistical information is invalid. 

Changing the stack size recognized by the emulator does not affect the 
amount of memory available to your program for stack activity. 
Changing the stack base recognized by the emulator does not affect the 
SS:ESP. The stack base and size are used only by the emulator to 
maintain the stack usage statistics. 

You can also change the stack area by a SetStackArea Shell command 
or by SetStackBase and SetStackSize Shell commands. 

The Stack window can help you determine the minimum amount of 
memory to allocate for the stack: 

1. Open the Options menu and choose Enable High-Water Mark. 
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2. Execute your program for maximum code coverage. 

3. Halt execution. 

4. Note the high-water mark (maximum stack usage as a percentage 
of the allocated stack area) on the stack meter. 

5. Remake your loadfile, increasing or decreasing the allocated stack 
for efficient usage. 
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Debugging in Registers and Memory 
This chapter describes how to access the CPU registers, the peripheral registers, and 
memory. 

Viewing and Modifying the CPU Registers 

CPU window showing 
the execution point 
(CS:EIP) at 
18:FFFFE3E4 and the 
stack top and base 
(SS:ESP and 
SS:EBP) at 20:5EO 

SW User's Manual 

You can view and change CPU registers and control signals from the 
CPU window, Toolbar, Source window, and Shell command line. 

Qptions 
EFLRGS 00000002 j.!. 

urn Oodi tszapc 
EIP FFFFE3E4 
ERlC 00000000 
EBX 00000000 
ECX 00000000 
EDX 00000000 
EDP 000005EO 
ESP 000005EO 
EDI 00000000 
ESI 00000000 
cs 0018 
DS 0020 
ES 0020 
FS 0020 
cs 0020 
SS 0020 

GDTBRSE FFFFEOOO 
GDTLIMIT 003F 

GDTRR FFFFEOOO 
IDTBRSE OOOOOSE 0 

IDTLIMIT DOFF 
I DTRR FFFFFFFF 

LDTR 0000 
LDTBRSE 00000000 

LDTLIMIT FFFF 
LDTRR FFFF7FFF + 

The CPU window is updated when emulation halts. A highlight 
indicates a register value has changed. 

Editing the CPU Registers 
To edit a CPU register, either: 

• Enter a Register command on the Shell command line. 

• In the CPU window, double-click on the register, or select the 
register and press <Enter>. Enter the new value in the dialog box. 
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CPU Register dialog 
box for editing the EIP, 
popped-up from the 
EIP line in the CPU 
window 

Register: EIP 

Hex: OOOOOlAO. Decimal: 416 

lu!mmmn+in 

QK .!;;.an eel 1 ttelp 

Resetting the CPU Registers 
When you reset and reinitialize the processor: 

• The processor RESET pin is asserted. 

• The program counter (CS;EIP) is set to O:FFFFFFFO for the EA­
NS486 and to FOOO:FFFO for all other emulators. 

• All SLD windows are updated. The Stack window display is 
invalid because the stack is reset. The Source window displays the 
beginning of your startup code, at the program counter. 

You can reset the processor from the Toolbar Configure menu, from the 
Source window Run menu, from the CPU window Options menu, or by 
entering Reset on the Shell command line. 

If the reset fails: 

1. From the Toolbar Configure menu or the CPU window Options 
menu, choose Reset CPU Only; or enter Reset CPUonly on the 
Shell command line. This resets the processor without updating 
the SLD windows. 

2. Reset your target. 

3. Reset the processor again, without specifying CPU only, to update 
the SLD windows. 

Resetting the Target Board 
You can reset your target board independently of resetting the SW or 
EA emulator. To use this feature, connect your target reset input to the 
Reset Out pin on the back panel of the emulator before turning-on the 
emulator; and edit powerpak.ini before starting the SLD software. See 
the Reset command description in the "Shell Window Reference" 
chapter and the [Systemlnfo] section description in the "powerpak.ini 
File Reference" chapter. 

Enabling the Target Signals 

Enabling a signal uses that signal from your target system rather than 
from the emulator. To enable or disable the target signals, check or 
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CPU Options menu 
Signals configurable 
for the EA-486 

uncheck each signal in the CPU window Options menu Signals item. 
(For a list of configurable signals, see the Hardware Reference.) 

Windows 

Help Index 
!::!elp With Help 
Help With !;PU 

E;i5;it 

RQY# Enable 
BESET Enable 
!!OLD Enable 
!'!Ml Enable 
lNTR Enable 
A20M# Enable 
ELUSH# Enable 
KEN# Enable 
.S.LE Enable 

Disabling a signal disconnects it from the target and controls it from 
the emulator. For example, the emulator drives the 386 signals as: 

READY# asserted 

RESET negated 

HOLD negated 

NMI negated 

INTO-INT3 (lntel386 EX) negated 

INT4-INT7 (lntel386 EX) negated 

NA# negated 

SMI# (lntel386 CX and EX) negated 

INTR negated 

A20M# (Intel386 CX) negated 

ERROR#, PEREQ, BUSY# (coprocessor) negated 

You can also enable and disable signals with the Shell Signal 
command. 

Viewing and Modifying Memory 

SW User's Manual 

You can view and edit memory from the Memory window and by 
entering Dump, Write, Fill, Copy, and Search Shell commands. 

Because reading and writing memory takes a small amount of processor 
time, which can degrade your program execution, memory access is 
initially disabled during emulation. Memory access is used in 
managing the Memory and Peripheral window displays and in 
changing memory contents with Memory, Peripheral, and Shell window 
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First-opened Memory 
window showing 
disassembly 

First-opened Memory 
window showing 
hexadecimal words 

commands. To enable memory to be accessible during emulation, do 
one of the following before starting emulation: 

• Open the Toolbar Configure menu and enable Run Access. 

• Enter RunAccess On on the Shell command line. 

Changing the Memory Window Display 

You can view memory as disassembly or numeric values in up to 20 
independent Memory windows. Choose the desired format from each 
Memory window View menu. Multiple Memory windows are 
distinguished by a number from 0 through 19 in the title bar. 

In the disassembly view, you can specify whether program symbols or 
their numeric addresses appear. Check (enable) or uncheck the Toolbar 
Configure menu Symbolic Disassembly item. 

file .Edit Yiew 

CS:01A0 FA 
CS:01A1 FC 
CS:01A2 882000 
CS:01A5 SEC0 
CS:01A7 BF0000 
CS:01AA 883202 

Qptions :Windows 

CLI 
CLO 
MOU 
MOU 
MOU 
MOU 

tlelp 

AX.0020 
ES.AX 
DI.0000 
AX,0232 

In a numeric view, memory appears as hexadecimal or decimal bytes, 
words, or double words followed by the ASCII equivalent, with dots 
representing non-printable characters. 

file .Edit ';'iew Qptions :Windows tlelp 

DS:0000 lEfF FFFE F7FF FD8E FDFF F411 FSFF FEES y.pyy+~yyy.oysep ~ 
DS:0010 0008 8000 0019 0100 0460 0300 4096 0808 .. . I ........ I@ .. 
DS:0020 0000 2000 0015 1400 8010 6000 E081 8140 ....... . I. '1a@I 
DS:0030 FD3F F7C0 FE87 F74A 73DF FF30 FEFF FA9C ?yA+•pJ+Bs0yyplu 
DS:0040 EFFF FF48 FFFF FFE4 FF8F FF19 F7FF FFFA y1Kyyyayly.yy+uy ~ 

.. 
To view another area of memory, double-click in the address column of 
the Memory window; or enter a numeric or symbolic address in the Edit 
menu Go To Address dialog box. A symbol must have a fixed address; 
that is, it cannot be a local variable or stack-resident parameter. Space 
and address mode options are greyed-out when unavailable. 
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Go To Address dialog 
box, accessed from 
the Memory window 
Edit menu Go To 
Address item, for 
displaying the current 
execution point in the 
Memory window 
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~-Q_K_~I I ~ancel I I !!elp 

If you are unsure of a symbol name or an address, you can research it 
from the Shell command line: 

DisplaySymbols lists module, variable, and function names with 
line number and address information. 

AddressOf lists the address of a specified symbol. 

NameOf lists the symbol closest to a specified address. 

To speed-up scrolling in the Memory window, choose the Options menu 
Read Ahead item. Using read-ahead near a non-existent memory 
region can cause a memory access failure. 

Changing the Memory Contents 

To change the memory contents, you can: 

• Edit the hexadecimal, decimal, or ASCII values in the Memory 
window. Position the Memory cursor and overtype the display. 

• Assemble code and data into memory using the Memory window 
Single-line Assemblerdialog box as described below. 

• On the Shell command line, enter AsmAddr and Asm commands 
or Write, Fill, or Copy commands 

To assemble lines of code into memory via the Memory window: 

1. Check (enable) the Memory window View menu Disassembly item. 

2. On the line to be changed, double-click anywhere except in the 
address column. The Single-line Assembler dialog box Source 
Line field shows the address and value of the line to be changed. 
(To close the dialog box without assembling, choose Cancel. Once 
a line is assembled, the Cancel button changes to a Close button.) 

3. Type a line of assembly code in the dialog box. 

4. Select the space and the operand/address size, as needed. 

5. Choose Assem to write the code to memory and update the Memory 
window. The single-line assembler checks the syntax and reports 
any error without writing the erroneous line. 
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Single-Line Assembly 
dialog box, accessed 
by double-clicking on a 
line of disassembly in 
a Memory window 

Memory window 
Options menu 

6. 

7. 

Repeat steps 3 through 5 to assemble subsequent lines. Choose 
Skip to leave a line unchanged. 

Choose Close to close the dialog box. 

Single-Line Assembly 

.S.ource Line: CS:OOOO 

p1nE111 np 
SpacJl_: 

When the Memory window shows any view other than disassembly, you 
can edit the numeric and ASCII values. Position the cursor on the first 
value you want to change and type the new value. A value must fall 
within the range of the displayed radix. For example, in decimal byte 
radix the maximum value in a field is 255; if you try to replace 199 
with 299, it is truncated to 200. An illegal (non-decimal or non­
hexadecimal) entry causes a beep: 

When you refresh the SLD window displays, changes to memory are 
reflected in all Memory windows, in the Source window disassembly, 
and in the Variable window values. 

The numeric format displayed in the Memory window does not affect 
how memory is accessed. Memory access is set by the Size command 
or the Options menu, not by the View menu. For example, if 
Size=byte, memory accesses are byte-sized even when the Memory 
window display is Hex Words. 

• 
-I .B_yte Access 

.Word Access 

.!)_Word Access 

-I Write Yerify 

Bead Ahead 

R~read On Write 

Viewing and Modifying the Internal Peripheral Registers 

This section applies to the PP-386EX, EA-386EX, SW-386EX, and 
EA-NS486 emulators. 

Because reading and writing memory takes a small amount of processor 
time, memory access is initially disabled during emulation. Such access 

Debugging in Registers and Memory 42 SW User's Manual 



Peripheral window for 
the SW-386 EX, 
showing the peripheral 
mnemonics fully 
compressed 

SW User's Manual 

includes scrolling and refreshing the Memory and Peripheral windows 
and reading and writing memory from the Memory, Peripheral, and 
Shell windows. You can enable memory to be accessible during 
emulation; however, any such access can degrade your program 
execution. Before starting emulation, either: 

• Open the Toolbar Configure menu and enable Run Access. 

• On the Shell command line, enter RunAccess ON. 

Changing the Peripheral Window Display 

Registers are displayed hierarchically. At the top level are the 
peripheral mnemonics; then the registers for each peripheral; then the 
bit fields for each register. You can expand or compress each level. 
When the display is fully compressed, only the peripheral mnemonics 
appear. 

"£!I.ti !lilil.filJ 

.Eile .E_dit Yiew ~indows !:felp 
H•.IIU! 

(+) MST 
(+) TMR 
(+) SLV 
(+) COMl 
(+) COM2 
(+) PORT92 
(+) CSU 
(+) SSIO 
(+) RFSH 
(+) WDT 
(+) CLK 
(+) CCR 
(+) PIO 

Expand a peripheral by clicking on the ( + ). The ( +) changes to a (-) 
indicating the peripheral is expanded; a list of the peripheral' s registers 
appears. Registers marked with ( +) can be further expanded; click on 
the ( +) to show the bit fields. Click on the (-) to recompress a line. 

The register and bit field display columns are: 

• The ( +) or (-) expansion/compression indicator 

• The register address; or, for a bit field, the bit number 

• The field value 

• The register or field mnemonic 

• A description of the register or field 
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Peripheral window for 
the SW-386 EX 
showing the DMA 
peripheral expanded to 
registers and the 
DMACMD1 register 
expanded to bit fields 

Register Edit dialog 
box, accessed from 
the SW-386 EX 
Peripheral window 
display or Edit menu 
Register item. 

To display all peripherals and registers in expanded format, open the 
View menu and choose Expand All. 

= .. 
' ~ . 

file fdit l/iew Windows !:!elp 
(-) OMA i-!-1 .J~:l. OOOOOOOP 0000 OMAOTAR0-1 Channel 0 Targ_et Address Bits 0:15 

111111 1111 I •I; I JI; ' I .1111·-
(+) 0000002P 0000 OMAlTAR0-1 Channel 1 Target Address Bits 0:15 
(+) 0000003P 0000 OMAlBYC0-1 Channel 1 Byte Count Bits 0:15 
(-) 0000008P 00 OMACMOl Command 1 Register 

7: 0 reserve reserved bits 7:5 
4: 0 PRE fixed priority 
3: 0 reserve reserved bit 3 
2: 0 CE enable channel 0 and 1 
1: 0 reserve reserved bits 1 :O 

(+) 0000008P 00 OMASTS Status Register 
(+) 0000009P 00 OMASRR Software Request Register (write) 
(+) 0000009P 00 OMASRR Software Request Register (read) 
(+) OOOOOOAP 00 OMAMSK Individual Channel Mask Register 
(+) OOOOOOBP 00 OMAMOOl Mode 1 Register 

OOOOOOCP 00 OMACLRBP OMA Clear BP SW command 

•II I• 

To navigate in the Peripheral window, enter a peripheral or register 
name or address in an Edit menu Go To ... dialog box. 

1-+1 

You can view the internal registers for each peripheral from the Shell 
command line with a Dump command. (For some 386EX and NS486 
registers, use the 10 argument.) Your processor may require setup 
before some peripheral registers are accessible. See your processor 
documentation. 

Changing the Peripheral Register Values 

Double-click anywhere on a register line; or select the register, open the 
Edit menu, and choose Register. You can edit the register and 
individual field values in the Register Edit dialog box. 

----------------
0 MA OMACMOl - Command 1 Register 

Register Value: ._I o_x_o ____ __, WRITE ONLY 

fields: 

reserve reserved bits 7:5 
PRE fixed priority 
reserve reserved bit 3 
CE enable channel 0 and 1 
eserve reserved bits 1 :0 

Field Value: 1: Reserved bits, write zeros to these bits 

l._o_x_o __ __.~__,: reserved bits 1:0 

Write 11 !;.lose I I « Erev 11 Next» I I !:!elp 
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You can modify the internal registers for each peripheral from the 
Peripheral window or from the Shell command line with a Fill, Copy, 
or Write command. (For some 386EX and NS486 registers, use the 10 
argument with these commands.) Your processor may require setup 
before some peripheral registers are accessible. See your processor 
documentation. 

45 Debugging in Registers and Memory 



Debugging in Registers and Memory 46 SW User's Manual 



Debugging With Triggers and Trace 
The PowerPack PP, EA, and SW emulators all collect trace during emulation. They differ in 
the amount of information collected and in the level of control you have over the trace 
collection. Triggers are available in the PP and EA emulators for complex control of 
emulation and trace collection. Events, also available in the PP and EA emulators, describe 
patterns of signal, data, and address bus activity for trigger conditions and trace search 
parameters. 

Controlling Trace Collection 

Toolbar showing the 
Trace Start, Stop, and 
Show buttons 

Trace Capture dialog 
box specifying trace 
collection to start when 
emulation starts 
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The SW and PP emulators start collecting trace when you start 
emulation. You can tum trace off and on during emulation with the 
Toolbar Trace Stop and Start buttons. 

II! PowerPack SLD Toolbar g 
[ile ~onfigure J,,ayout \O'indows !::!elp 

In the EA emulator, you can specify whether trace collection starts with 
emulation. From the Trigger window Options menu or the Trace 
window Trace menu, choose Trace Capture and enable (check) or 
disable (uncheck) Collect Trace When Emulation Starts. 

Trigger Position 

®tei~l 
0 Cerrter 

0Po.l!_I 

Capture Mode 

® Clock Cycles 

0 f!_us Cycles 

1:8] !nstruction Mode Assist 

1:8] Collectirace When Emulation Starts 

QK I I kancel I I tlelp 

Automating Trace Capture 

You can program the EA and PP emulators to automatically start and 
stop trace collection during emulation according to specified patterns of 
bus activity (called events) and other conditions. Such conditions with 
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PP emulator Trigger 
window, showing Toft 
and Next actions 

EA emulator Trigger 
window, showing Ton, 
Tott, Trac, and Trig 
actions 

their resulting actions are called triggers and are defined in the Trigger 
window. 

=I Trigger - Level 0 I'" 
file _Edit .Qptions .Level ~indows Help 

Condition Actions 
event name enable ext Sfill rst brk \off neKt incO ntO incl rstl eKt lo eKt hi 

D 
!C---- D 
If-- D 

D 
D 

!C----
D 
D 

'C---- D .'--r=== 
cntoBD 
cnu 1 D 
eict D 

=l Trigger - Level 0 l'" 
file _Edit .Qptions .Level ~indows Help 

Condition Actiom 

~e enable ext Sfill \S\ brk ton toff trac trjgJ strtO stQ0 rstO strtl stQJ!_l rstl eKt out rstts 

1------1 D 
D 
D 

r----1 D 
1------1 D 
r----1 D 
1------1 D 
!1------1 D 
tmroBD 
1trm11 D 
eict D 

Trigger actions affecting trace include: 

• stopping trace permanently a specified number of frames after the 
condition occurs (Toff in the PP; Trig in the EA) 

• in the PP, with multiple trace buffers selected, closing the current 
buffer a specified number of frames after the condition occurs and 
starting subsequent trace in the next buffer (Next) 

• in the EA, suspending trace immediately (Toff) 

• in the EA, starting trace when the condition occurs (Ton) 

• in the EA, collecting a single trace frame when the condition 
occurs (Trac) 

Each trace frame is a snapshot of the processor bus activity and other 
signals occurring during a single clock or bus cycle. 
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PP Trace Control 
dialog box, accessed 
from the Trigger 
window Options menu 
or the Trace window 
Trace menu 

EA Trace Capture 
dialog box, accessed 
from the Trigger 
window Options menu 
or the Trace window 
Trace menu 
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To specify the PP multiple buffers and the number of frames for delayed 
triggering in either emulator, use the PP Trace Control dialog box or 
the EA Trace Capture dialog box. 

Trace Control 

D H.!!11 When Last Trace Buffer Full 

ririgger Position 

L ®ere 0 Center 0 Polit 

rNymber of Trace Buffers (x Size1----~ 

® 1 (x256K) 0 8 (x32K] 

0 2 (x128K) 0 16 (x16K) 

0 4 [x64K] 0 32 (x8K) 

0 64 (x4K] 

0 128 (x2K] 

0 256 (xlK) 

QISJ I .Cancel I I t!elp 

Trigger Position 

®[g~;;j 
Ocenter 

OPoJ>.t 

Capture Mode 

@ Clock Cycles 

0 I!_us Cycles 

[2J Instruction Mode Assist 

[2J Collect Irace When Emulation Starts 

QK I I .Qancel I I !::lelp 

In the PP, you can divide 256K frames of trace information among 
several buffers. Trace captured into each buffer is contiguous; trace in 
different buffers can come from separate parts of your program. For 
example, you can capture 256 separate blocks of lK frames of trace , a 
single block of 256K trace frames, or various intermediate 
combinations. Each buffer is identified by a number, starting with 0, 
displayed in the Trace window title bar. 

PP tracing starts in Buffer 0 when emulation starts and wraps around to 
overwrite the current buffer each time it fills up. The Next trigger 
action finishes filling the current buffer then starts filling the next 
buffer. If you enable (check) the Halt When Last Buffer Full box, 
tracing stops when all buffers have been filled. This operation 
overwrites the first buffer with several cycles after the end of the last 
buffer. 

In the EA, you can delay the start of tracing until a trigger condition is 
met during emulation. To start emulation without tracing, disable 
(uncheck) the Trace Capture dialog box Collect Trace When Emulation 
Starts. Trigger actions to start tracing include: 
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Ton starts tracing with the frame in which the trigger occurs. 

Trac captures only the frame in which the trigger occurs. 

In the PP, the Toff action fills the current buffer then stops recording 
trace. In the EA, only one buffer is available. The Toff action stops 
recording trace immediately after the trigger frame. The Trig action 
fills the buffer then stops recording trace. 

If multiple conditions are satisfied simultaneously, the emulator 
attempts to perform all the associated actions. For PP tracing, a Toff 
triggered by one condition can override a Next triggered by another 
condition. For EA tracing, simultaneous Ton, Toff, and Trac actions 
have no effect if tracing is previously on; or simulate a single Trac 
action if tracing is previously off. 

For the EA Trig and the PP Toff and Next actions, you can specify 
approximately how many trace frames are saved after the frame in 
which the trigger occurs. In the Trace Control or Trace Capture dialog 
box Trigger Position field, enable: 

Pre to collect no frames after the trigger. The trigger frame 
appears at or near the end of the buffer. In the PP, a few, 
frames can appear in the buffer after the trigger frame. In 
the EA, no frames are collected after the trigger frame. 

Center 

Post 

to fill the buffer with an approximately equal number of 
frames before and after the trigger. The trigger frame 
appears in the middle of the buffer. In the EA, frames are 
collected for 125000 clock cycles following the trigger. 

to fill the buffer with frames mostly after the trigger. The 
trigger frame appears at or near the beginning of the buffer. 
In the EA, frames are collected for 250000 clock cycles 
following the trigger. 

After a Trig or PP Toff, trace is suspended until emulation halts and is 
restarted or until you manually start trace with the Toolbar Trace Start 
button or the Trace window Trace menu Start item. Both restarting 
emulation and manually starting trace clear previously collected trace. 

You can collect all or a subset of the frames occurring after a Center or 
Post Trig action. To collect a block of frames within the Trig timer 
125K or 250K clock cycle limit, define Toff and Ton triggers. To 
collect selected frames, define Trac triggers. The zero frame is the 
trigger frame; if trace is off when the Trig occurs, the zero frame is the 
next frame collected. 
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Formatting Trace Capture 

The trace information varies between emulators, including the 
following for each bus cycle (SW emulators) or for each bus or clock 
cycle (PP and EA emulators): 

• the frame number relative to either the triggering event or the 
instruction where tracing was stopped 

• a timestamp for EA and PP emulators 

• address bus values 

• data bus values 

• signal values, as listed in the Hardware Reference 

• disassembled instructions 

In the EA, you can capture more bus cycles or more detailed 
information by specifying trace frames to be bus-cycle or clock-cycle 
captures, respectively. In the Trace Capture dialog box Capture Mode 
field, enable: 

Clock Cycles to capture bus activity and other signals every clock 
cycle. Trace captured in this mode includes program 
activity and other processor messages and can be 
displayed as clock cycles, bus cycles, or disassembled 
instructions. The frame numbers are continuous. 

Bus Cycles to capture bus activity every bus cycle. The full set of 
bus pins is recorded as a unit, spanning multiple clock 
cycles if necessary, and can be displayed only as bus 
cycles. This capture mode covers more of your 
program execution but includes only the signals 
corresponding to program activity. For example, the 
branch messages required for disassembling trace are 
not captured. 

The PP captures only clock cycles, which can be displayed as clock or 
bus cycles or disassembled. 

To be able to disassemble the trace, use clock-cycle capture and include 
information about branches taken. Include such information by 
enabling the PP Trace window View menu BTM Cycles item or the EA 
Trace Capture dialog box Instruction Mode Assist. 

In both the PP and EA (regardless of the EA capture mode), you can 
specify the trigger to match conditions for either bus or clock cycles. 
For example, to match a condition that occurs during a single bus cycle 
but not within a single clock cycle, enable (check) the Trigger window 
Options menu Bus item. 
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PP System Clock 
Frequency Setup 
dialog box, accessed 
from the Trace window 
Timestamp menu 

The PP and EA timestamps count differently. The PP timestamp is 
computed from the target processor clock. Specify the clock speed in 
the System Clock Frequency Setup dialog box. 

Setup 

System Clock .Erequency: !!nits 

®MHz 

Imm o KHz 

OH-"'. 

QK I !;ancel !!elp 

The EA timestamp increments at 25 MHz, regardless of the target clock 
speed, with a range of approximately 733 minutes. For faster target 
systems, sequential frames can have identical timestamps. 

To show elapsed time in trace, you can format the PP or EA timestamp 
relative to specific trace frames and reset the EA timestamp to 0 in 
various ways: 

• Reset the EA timestamp any time, regardless of concurrent 
emulation or trace activity, by choosing the Trace window 
Timestamp menu Reset Timestamp Now item. 

• Start the EA timestamp at 0 each time you start emulation, by 
initially enabling the Trace window Timestamp menu Reset 
Timestamp When Halted item. 

• Reset the EA timestamp according to trigger conditions with the 
Rst Ts action. 

• Show the time before and after a zero frame with the Trace window 
Timestamp menu Relative To Frame item. 

• Show the incremental time between each frame with the Trace 
window Timestamp menu Delta item. 

• Show the time since the EA timestamp was last reset with the 
Trace window Timestamp menu Absolute item. 

To specify a zero frame for the relative timestamp, enter a frame 
number in the Trace window Timestamp menu Zero At Frame dialog 
box. The default zero frame is one of: 

• the trigger frame of an EA Trig or PP Toff or Next action 

• the last frame collected when trace stops for any other reason 
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PP emulator Trigger 
window with the 
counter option selected 

EA emulator Trigger 
window with one of the 
timer options selected 
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Specifying Trigger Conditions 

Trigger conditions are combinations of the following: 

• A set of address bus, data bus, and signal values, called an event. 
The available signals differ between the EA and PP emulators and 
between the different processors supported for each emulator. See 
the Hardware Reference. 

• The Trigger In pin on the front panel of the emulator. (See the 
Hardware Reference for an illustration of the Trigger In pin.) 

• Counter and timer values based on clock cycles and event 
detection. The counter and timer options differ between the EA 
and PP. 
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To use an event as a trigger condition, define one or more events; then, 
select an event name from an Event Name drop-down box in the 
Trigger window. Make the event an active condition by checking the 
Enable box next to the Event Name box. 

53 Debugging With Triggers and Trace 



PP emulator Trigger 
window condition 
ANDing Evnt1 with the 
Trigger In (ext) signal 

To use the Trigger In signal as a separate event, check the enable box 
next to the Ext event below the event name boxes and counter or timer 
fields. To AND the Trigger In signal with an event, enable the event 
then check the Ext box in the same row as the event. In the PP, Trigger 
In is active-low. In the EA, you can specify Trigger In as active-high or 
active-low by selecting the appropriate Trigger window Options menu 
Trigger In Active item. 
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file fdit Qptions !,eve I '.)tiindows Help 

Condition Actions 
event name enable ext se_g_ rsUbrk}toff next:1tart stQJL resetlextlo exthi ] 
Evntl l!J 0 0 0 01~10 010 0 010 0 l _o_ 

Conditions can be enabled simultaneously (on a single trigger level) or 
sequentially (on different trigger levels). The current trigger level, 0 
through 3, appears in the Trigger window title bar. Display each level 
from the Trigger window Level menu. 

To trigger on any of two or more conditions regardless of the order in 
which they occur, enable the conditions simultaneously. Each time one 
of the conditions occurs, the associated trigger actions are taken. If two 
or more conditions occur together, the emulator does all the associated 
actions. Some actions override others when done simultaneously: 

• Toff (PP) overrides Next, turning trace off without starting another 
trace buffer. 

• Ext Lo (PP) overrides Ext Hi, generating a low PP Trigger Out 
signal and no high Trigger Out signal. 

• Rst0/1 overrides IncO/l, resetting and not incrementing a counter. 

• Stop (or EA Stop0/1) overrides Start (or EA StrtO/l), stopping a 
timer. 

• Rst overrides Seq, activating the Level 0 trigger and not 
incrementing the trigger level. 

Chaining Trigger Conditions 

To avoid triggering on one condition until a prior condition has been 
met, enable the conditions on sequential levels. On the first level, 
enable the first condition and specify a Seq action. Seq suspends the 
current-level trigger and activates the next-level trigger. Disable the 
second condition on the first level and enable it on the next level. 

All levels must list the same set of up to eight events in the Event Name 
column and must specify the same counter or timer values; but the 
events and counters or timers can be enabled differently, can have 
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PP emulator Trigger 
sequential windows 
with: 

• the in_insert event 
and the timer 
enabled at level O 

• the in_printall event 
and the timer 
enabled at level 1 
(activated when 
in_insert occurs) 

• the in_remove event 
enabled at level 2 
(activated when 
in_printall occurs 
after in_insert has 
occurred) 
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different external-trigger co-conditions, and can cause different actions 
at each level. 
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PP emulator Trigger 
window timer set to 
count 1000 clock 
cycles 

You can also schedule conditions by counting events or clock cycles. 
Select the paired counters, the single timer, or the EA paired timers 
from: 

• the PP Trigger window Options menu Counter or Timer items 

• the EA Trigger window Options menu 2 Counters, 2 Timers, or 
Cascaded Timer items 

Enable an event to start the timer or counter and, optionally, events to 
stop and reset the timer or counter. Enable and fill-in the box beside 
the timer or counter as follows: 

• A timer starts at 0 to count clock cycles when a start (for the tmr 

timer), strtO (for the EA tmrO timer), or strtl (for the EA tmrl) 
action occurs. The timer increments at the clock rate of the 
emulation processor and wraps to 0 after reaching its maximum 
value. When the number of clock cycles specified in a timer box 
has elapsed, the timer action occurs. To stop a timer without 
resetting it, enable an event to do a stop, stopO, or stopl action. 
Another event can restart the timer to continue. To reset a timer to 
0 without stopping it, enable an event to do a reset, rstO, or rstl 
action. In PP emulators, reset and stop a timer on a single 
condition by specifying both actions. In EA emulators, define two 
identical conditions, one with a reset action and the other with a 
stop action. 
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• A counter starts at 0 and increments each time an incO (for cntO) or 
incl (for cntl) action occurs. When a counter reaches the number 
specified in its box, the counter action occurs. To reset a counter to 
0, enable an event to do a rstO or rstl action. 
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PP emulator Trigger 
window counters set to 
count 50 instances of 
Evnt5 or Evnt6 
between instances of 
Evnt1 or Evnt2 and to 
count 100 instances of 
Evnt7 or Evnt8 
between instances of 
Evnt3 or Evnt4 
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Chaining Emulators 
You can signal an external device with the PP ext lo and ext hi trigger 
actions or the EA ext trigger action. For example, when using multiple 
emulators in a multiprocessing target, an ext action from one emulator 
can appear as an ext condition in another emulator. The ext output 
signal appears on the Trigger Out pin on the emulator chassis, as 
described in the Hardware Reference. 

In the PP, specify a low or high output by enabling the ext lo or ext hi 
action, respectively. In the EA, enable the ext action and choose the 
Trigger window Options menu Trigger Out Active High, Low, or Open 
Collector configuration. 

Defining Events 

An event is a combination of bus values: 

Address Reading or writing to a specific address, set of addresses, 
inside an address range, or "not" the described addresses. 
You can specify symbolic or numeric addresses. 

Data Reading or writing a specific value, set of values, range of 
values, or "not" the described values. You can specify 
symbolic or numeric data. 

Signal High or low logic levels on various processor signals. You 
can also specify don't-care for signals. For a list of 
supported signals, see the Hardware Reference. 

Define an event in the Event window. Editing the Event window 
differs from editing a dialog box. The <Enter> key has no effect on the 
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Event window, 
accessed from the 
Trigger or Trace 
window Edit menu 

Add Event dialog box, 
accessed from the 
Event window Edit 
menu, for creating a 
new event name 

Symbolic and numeric 
address-translation Shell 

field that you are editing. To ensure a field accepts an entry, move the 
cursor by clicking on another field or button. Pressing the <Delete> 
key to delete a highlighted value has no effect; press the space-bar 
instead. 

You can open the Event window from the Trigger or Trace window, by 
opening the Edit menu and choosing Events. = Event: in_remove a 
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If no events are defined, the Add Event dialog box appears. Otherwise, 
to add a new event, in the Event window open the Edit menu, choose 
Add Event, and enter the new Event name. 

-------
Add Event 

Name: 

evl 
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To define the address of an event: (If you don't care what addresses are 
accessed, leave all the Addr fields blank.) 

1. Enter a symbolic or hexadecimal numeric address in the Addr Start 
field. This is the first address in the region where the event can 
occur. 

2. Select End Addr or Length. Enter either the last address in the 
memory region where the event can occur, or the length in bytes of 
the region. If you specify no end address or length, the event is 
defined for the start address only. 

If you are unsure of an address or address range, you can use the 
Shell window AddressOf and NameOf commands or the Source 
window Function pop-up menu. 

For example, use Shell commands as shown in the following to 
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commands 

Function menu 
popped-up by double­
clicking on the printall 
symbol in the Source 
window 

Load address of the 
printall function 
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find address information for defining an event relative to the 
dm_main module's main function or cell variable: 

narneof cs:37 II Identify the function at this address. 
II Ddrn_rnainD80U1 (function rnain+Ox37 [55]) 
addressof Urnain II Show the address range of the function. 
II 0200:0000 •• 003F 
narneof 20:10 II Identify the symbol closest to this address. 
II Ddrn_rnainncell+Ox2 [2] 
addressof Ucell // Show the address range of the uariable. 
II 002 0: DODE. • 0049 [ 6 OJ 

+ 

+ 

Another way to find the memory region of a function is via the 
Function pop-up menu. In the Source window, double-click on the 
function name and choose Show Load Address. 

0 

1111 Function: printall 
.Go To Source 
.S.how Load Address 
Set Eerm. Breakpoint 
Set Iemp. Breakpoint 
.(;;lear Breakpoint 

PowerPack SLO 

Function printall: Address starts at: 
001 B:FFFFE4CO .. FFFFE547. 

3. Optionally, you can enter a hexadecimal-AND mask value. The 
mask dictates which bits of the address are don't-care's (0) and 
which must match (1 ). 

4. To match only addresses outside of the range or set you specified, 
check the Not box. 

To define the data of an event: (If you don't care what data is read or 
written, leave all the Data fields blank.) 

1. Enter numeric values in the Data Start and Data End fields. The 
emulator interprets the numbers as decimal unless you use the Ox 
prefix. For example, 10 is translated to OxOOOA, and Ox10 is 
accepted as Ox0010. 

2. Enter a hexadecimal-AND mask, using F's to match corresponding 
positions in the data pattern. 
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3. To match data outside of the specified range or set, check Not. 

Specify signal states for the event by toggling the low (0), high (1) or 
don't care (X) buttons next to each signal mnemonic. Active-low 
signals are shown with a hash mark (#). 

The signals available depend on the target processor, as described in the 
Hardware Reference. The mnemonic identifying each signal 
corresponds to the signal's primary function, regardless of whether you 
reconfigure the signal for other use. 

You can define events in one emulator session and save them for reuse 
in another session. To save events to a file, in the Event window open 
the File menu and choose Save Events As. To retrieve saved events, 
choose Restore Events. Or, enter EventSave and EventRestore 
commands on the Shell command line. 

Viewing the Collected Trace 

Trace window with no 
trace collected 

To display a trace buffer, open the Trace window. Only PP emulators 
support multiple trace buffers, navigable with the Goto menu Previous 
Buffer, Next Buffer, and Buffer items. 

The Status window or icon message shows whether the emulator is 
tracing. You need not halt emulation to examine a snapshot of the 
collected trace. Each time trace stops, the Trace window is updated. 

Read the abbreviated signal mnemonics vertically. For a list of 
supported signals, see the Hardware Reference. 

fll Trace 1111 
file fdit Yiew Irace llmestamp !!oto ,Windows Help 

g bbbb mdw rb bbsk hh rsni pp ae f p b f xxxxxxxx 
times tamp data eeee icr dr slme 11 srmn cw ha e c o l . 

-44 -1 .3290 us 
-43 -1 . 3290 us 

a address 
p 

00002130 
00002130 
00002130 
00002130 

3210 o yy 86an da tsit dt ld r k f u 01234567 

=~=~===~ !!!: ~~~ :: :::: :: :::: :: :: : : : : ::::::::~ 
-42 -1 .2890 us 
-41 -1.2400 us 

e1 F64683 0000 MCR e1 111 e aa e000 10 01 1 1 1 1 00000000 H 
01 F64683 aeee MCR e1 1110 ea eaee 10 01 1 1 1 1 eeaeaea0 71 

__L+ll 

From the View menu, you can display trace as: 

Clock mode address, data, and signal values at each clock cycle (PP 
and EA emulators) 

Bus mode 

Instruction 
mode 

address, data, and signal values at each bus cycle 

disassembly of executed instructions and the memory 
accesses associated with the executed instructions 

For the emulator to disassemble the trace information, you must have 
captured the clock-cycle branch-taken messages. 

.. 
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Break Emulation 

Stop Trace Without 
Breaking Emulation 
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When viewing trace as disassembly (Instruction mode), you can link the 
Source and Trace window displays. When the windows are linked, 
scrolling the disassembled trace scrolls the corresponding source code 
synchronously. To link the Source and Trace cursors, do the following 
sequence 

1. Choose the Trace window View menu Instruction item. 

2. Enable the Trace window View menu Linked Cursor item. 

Examples of Triggering 

The illustrations in this section show PP 386CX emulator displays. The 
displays and options vary for different emulators and processors. This 
section demonstrates various trigger window configurations and 
describes their effects on emulation control. 

If Evntl occurs, emulation breaks. 

1:1 Trigger - Level 0 a 
Eile fdit Qptions Level ~indows !::!elp 

Condition Actions 
event name ena.ble ext se rst brk toff next incO rstO incl rstl ext lo ext hi 
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1. Enable Evntl and choose the brk action. 

2. Start emulation. 

3. Tracing starts. 

4. Emulation stops when the trigger occurs. (Tracing stops when 
emulation stops.) 

If Evntl occurs, trace collection stops. 
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1. Enable Evntl and choose the toff action. 

2. Start emulation. 

3. When the trigger occurs, the trace buffer fills according to Trace 
Control; tracing stops; emulation continues. 
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Act On Multiple Events Enable up to eight global events. Enabled events are processed in 
parallel. For this example, multiple trace buffers must be defined in 
the Options menu Trace Control dialog box and Counters must be 
selected in the Options menu. 
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1. Enable the Event names in the eight drop-down list boxes. 

2. Specify the actions to be taken when each event occurs: 

• Evntl, Evnt2, Evnt3, and Evnt4 break emulation, reset one of 
the counters, and write 0 to the external trigger-out signal. 

• Evnt5 and Evnt7 fill the current trace buffer according to 
Trace Control and start collecting trace into the next trace 
buffer; increment one of the counters; and write 1 to the 
external trigger-out signal. 

• Evnt6 and Evnt8 stop tracing, increment one of the counters, 
and write 1 to the external trigger-out signal. 

• If Evnt5 and Evnt6 together occur 50 times without Evntl or 
Evnt2 occurring, cntO reaches 50, breaks emulation, and 
writes 0 to the external trigger-out signal. 

• If Evnt7 and Evnt8 together occur 100 times without Evnt3 or 
Evnt4 occurring, cntl reaches 100, breaks emulation, and 
writes 0 to the external trigger-out signal. 

If multiple events occur simultaneously, all associated actions are 
taken. Some actions preclude others; for example, only ext lo or ext hi 
can occur when a brk also occurs. 

Debugging With Triggers and Trace 62 SW User's Manual 



AND an Event With an 
External Input 

Trigger on External 
Input Alone 

Define Sequential 
Triggers For Capturing 
Trace 

SW User's Manual 

Logically AND the condition with an external trigger input low signal 
by checking the ext box (ext is to the right of enable). 

= , , . I . 
.Eile J;dit Qptions !,,eve I Windows J:!elp 

Condition Actions 
event name enable ext se_g_ rstlbrkltoff next_Ltart stQll_ reset_l_extlo exthi J 
Evntl J!J [2] [2] 0 01010 010 0 010 0 l Lo_ 

The trigger condition is true when Evntl occurs during a low value on 
the emulator's external trigger input. 

Enable ext on the last line of the Condition pane to set a trigger on an 
external signal alone (ext is located at the bottom of the left column). 

= UJ.111" I . 
.Eile fdit Qptions !,,eve I Windows J:!elp 

Condition Actions 
event name en ab le ext Sfill.. rst btk toff next start stQJ2. reset ext lo ext hi 

!O 

!O 

!O 

!O 

!O 

!O 

!O 

!O 

jtmr~O 

ext [2] 0 0 [2] 0 0 0 0 0 0 0 

This condition is true when the emulator's external trigger input is 
low. 

Capture trace following each of three events in three separate trace 
buffers. This example uses a PP lntel386 CX emulator running the 
demo386.omf sample program installed with SLD. 

Define buffers SK bytes long. Position the trigger so the event appears 
near the beginning of the buffer (Post). 

63 Debugging With Triggers and Trace 



Trace Control dialog 
box specifying 32 
buffers of BK bytes 
each, with the trigger 
frames near the 
beginning of each 
buffer 

Event window defining 
a Memory Code Read 
event in the insert 
function 

Event window defining 
a Memory Code Read 
event in the printall 
function 

Trace Control 

D H.!!lt When Last Trace Buffer Full 

ririgger Position 

L Oere 0 Center @Po!!t 

Nymber of Trace Buffers (x Sizei-----

0 1 [x256Kl 0 8 (x32Kl 
0 2 (xl 28Kl 0 16 (xl 6K) 

0 4 (x64K) @i~f~~jcj1 

0 64 [x4K) 
0 128 (x2K) 
0 256 (xlKI 

OK I !;ancel I I !:!elp I 

Define an event at the first code location inside each of three function 
calls: insert, printall, and remove. To find the addresses, use Xlt: 

Xlt #insert; 
II 0018:FFFFE41C = FFFFE41CL = 3FFE41CP 

The following figure shows the three event definitions. 

al Event: in_insert a 
.Eile Edit ~indows !:!elp 

Active Event: ~lin ___ in_s_ert ______ ~liJ_ 
not start @ End Addr 0 Length ~m_a_s_k __ 

addr: D j Jffe41cP I I 3ffe41 cP 11 Ox3FFFFFF I 

start end mask 

data: 0 ['----____ __,] [.___ ____ ___,] c=J 

OlX OlX OlX OlX OlX 

0 0 @ BHE# 0 0 @ LOCK# 0 0 @ HOLD 0 0 @ INTR 0 0 @ ERROR# 
0 @ 0 M/10# @ 0 0 ADS# 0 0 @ HLDA 0 0 @ SMI# 0 0 @ PEREO 
@ 0 0 DIC# 0 0 @ READY# 0 0 @ RESET 0 0 @ SMIACT# 0 0 @ A20M# 
@ 0 0 W/R# 0 0 @ NA# 0 0 @ NMI 0 0 @ BUSY# 

= Event: in_printall a 
.Eile fdit ~indows !:!elp 

Active Event: ~jin ___ p_rin_t_al_l _____ ~ji)_ 
not start ® End Addr 0 Length ~m_a_s_k __ 

addr: D j Jffe4cOP I I 3ffe4cOPj 11 Ox3FFFFFF I 

start end mask 

data: D [....______ ___ ___,] [~---~] c=J 

OlX OlX OlX OlX OlX 

0 0 @ BHE# 0 0 @ LOCK# 0 0 @ HOLD 0 0 @ INTR 0 0 @ ERROR# 
0 @ 0 M/10# @ 0 0 ADS# 0 0 @ HLDA 0 0 @ SMI# 0 0 @ PEREQ 
@ 0 0 D/C# 0 0 @ READY# 0 0 @ RESET 0 0 @ SMIACT# 0 0 @ A20M# 
® 0 0 W/R# 0 0 @ NA# 0 0 @ NMI 0 0 @ BUSY# 
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Event window defining 
a Memory Code Read 
event in the remove 
function 

PP emulator Trigger 
sequential windows 
with: 

• the in_insert event 
and the timer 
enabled at level O 

• the in_printall event 
and the timer 
enabled at level 1 
(activated when 
in_insert occurs) 

• the in_remove event 
enabled at level 2 
(activated when 
in_printall occurs 
after in_insert has 
occurred) 
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Event: in_remove a 
file f_dit '.Y'lindows ]:!elp 

Active Event: ~I in ___ re_m_o_v_e _____ ~liJ_ 
not start ® End Addr 0 Length mask 

addr: D I 3ffe470P I I 3ffe470P 11 Ox3FFFFFF I 
start end mask 

data: D [,____ ___ _____,][~---~] c=:J 

OlX OlX OlX OlX OlX 

0 0 @ BHE# 0 0 @ LOCK# 0 0 @ HOLD 0 0 (!> INTR 0 0 <i1 ERROR# 
0 @ 0 M/10# @ 0 0 ADS# 0 0 ~! HLDA 0 0 @ SMI# 0 0 @ PEREQ 
@ 0 0 DIC# 0 0 (!> READY# 0 0 @ RESET 0 0 @ SMIACT# 0 0 @ A20M# 
@ 0 0 W/R# 0 0 ~l NA# 0 0 @ NMI 0 0 @ BUSY# 

Enable the Options menu Clock, setting the event trigger to respond to 
clock cycles. 

Enable the Options menu Timer, displaying a tmr line at the bottom of 
the Condition pane. Check the tmr enable box. Type 8200 in the tmr 
value field, specifying 8200 clock cycles to elapse between timer 
triggers. This demo program is so small that the events defined for the 
triggers occur multiple times in the trace captured to post-fill an 8K­
byte trace buffer. Since only one trace-control action (toff, next) can 
occur in each buffer, the timer ensures that tracing moves to the next 
buffer before sequencing to the next trigger. 

~ I ~l!iJ I . 
file f.dit Qptions _Level Windows !:felp 

Condition Actions 
event name en ab le ext SiN_ rst brk toff next start stQll_ res et ext lo exthi 
injnsert ! IZJ D D D D D IZJ IZJ D D D D 
in __printall ! D 
in_removE ! D 

! D 
! D 
! D 
! D 
! D 

jtmr [iiQLJ IZI D IZJ D D D D D IZJ IZJ D D 

ext D 
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= Trigger - Level 1 a 
file J;_dit Qptions Level Windows !!elp 

Condition Actions 
event name enable ext S!l.Jl. rst brk toff next start stQll.. res et ext lo ext hi 
in_insert ! D 
in Jirintall ! IZI D D D D D IZI IZI D D D D 
in_removE ! D 

! D 
! D 
! D 
! D 
! D 

1tmr ~IZI D IZI D D D D D IZI IZI D D 

eKl D 

"" ,, - . 
file fdit _Q_ptions _Level lf'lindows !:!elp 

Condition Actions 
event name enable ext se_q_ rst brk toff next start stop reset ext lo ext hi 
in_insert :tD 

in __printall :tD 

in_remove f [8J D D D D [8J D D D D D D 
:tD 

:tD 

:tD 

:tD 

:tD 

jtmr~D 

ext D 

Each of the first two triggers captures trace following its event and 
starts a timer to run while the buffer fills. When the buffer is full, 
tracing begins in the next buffer. When the timer finishes, it stops, 
resets itself, and arms (sequences to) the next trigger. 

The final trigger turns trace off, filling the current buffer. Emulation 
continues but trace does not. 
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powerpak.ini File Ref ere nee 
This chapter describes the contents of the powerpak.ini file. 

Backup 
CAUTION 

SW User's Manual 

The SLD software installation creates the powerpak.ini file in your 
Windows directory. 

Always back up powerpak.ini. Once you have modified powerpak.ini, 
you may need to restore the default contents by reinstalling the SLD 
software. 

The following sections can appear in powerpak.ini: 

Section Purpose 

[Comm] 

[CPUinfo] 

[DefaultLayout] 

[InitScript] 

[LoadOptions] 

[Network] 

[Serial] 

[Sourcelnfo] 

[Stacklnfo] 

[Statuslnfo] 

[Systemlnfo] 

[ToolBarlnfo] 

[Tool Chain] 

[Tracelnfo] 

[Triglnfo] 

Host-to-emulator communication 

Intel debug register allocation 

Window screen locations 

Script file to run on invocation 

Load options 

Network information 

Host system COM port number 

Source window Go, Step, and View options 

Stack window options 

Status window options 

Target support 

Toolbar configuration options 

Section names and bitfield information 

Trace Control and Trigger window options 

Trigger window options 

[Variablelnfo] Toolchain Variable window options 

Many entries are toggle settings with possible values of 1 or 0. For 
such entries, 1 is enable and 0 is disable. 

Whenever possible, change entries using menus or Shell commands 
rather than modifying powerpak.ini in a text editor. 

Avoid modifying any entry not documented in this chapter. 
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[Comm] 

describes 
host/emulator 
communication 

Select Baud Rate 
dialog box, popped-up 
automatically the first 
time you start the SLD 
software 

powerpak.ini lines 
specifying serial 
communication at 
57600baud 

[CPUlnfo] 

allocates debug 
register use 

type=(serial I pcnfs I lanserver] describes how the emulator 
communicates with your host system. This entry is set to serial by the 
SLD installation and changed by the PP emulator network installation. 
If your network configuration changes, affecting communication 
between the host system and the PP emulator, edit powerpak.ini. 

serial specifies serial communication. 

pcnfs defines the emulator as a node on a PC-NFS network. 

lanserver defines the emulator as a node on an OS/2 LAN server. 

BaudRate=(19200 I 38400 I 57600 I 115200] specifies the baud 
rate for communication between the emulator and your host system. 
The first time you start the SLD software, you must specify a baud rate. 
For some host systems, baud rates above 57600 require a special 
Windows driver. 

[Comm] 

Select Baud Rate 

J;!aud Rate 

01]!.200 

018400 

® Ji7600 

0115200 

raid 

~an eel 

Help 

II This is the installed default communication type. 
II Network installation changes this entry. 
type=serial 
II The BaudRate and com port (in the [Serial] section) are 
II unspecified until you fill-in the appropriate dialog boxes. 
BaudRate=57600 

dr [<num>]=(user I system] specifies whether each debug register 
is reserved for use by your program or by the emulator for hardware 
breakpoints. 

<num> 

user 

system 

specifies the debug register as 0, 1, 2, or 3. 

enables your program's access to the debug register. 

reserves the debug register for use by the emulator, 
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powerpak.ini lines 
added bya 
DR 1 USER 
Shell command 

blocking your program's access to the register. 

II The emulator adds this section when you use a DR command, 
II as described in the "Shell Window Reference" chapter. 
[CPUlnfo] 
dr O=system 
dr 1=user 
dr 2=system 
dr 3=system 

[Defaultlayout] 

specifies Window 
screen dimensions 

[lnitScript] 

defines which Shell 
script file executes 
when you invoke SLD 

powerpak.ini lines 
specifying sample 
initialization script 

The<SLDWindow>Presenter=[ <Dimensions>] specifies the 
screen locations and sizes for the initially displayed SLD windows. 

Move and resize the SLD windows using the Windows mouse or 
cursor. To save the layout without exiting the SLD software, choose 
the Toolbar Layout menu Save Layout Now item. If you are likely to 
change the layout again before exiting but want the same initial layout 
the next time you start, disable the Layout menu Save Layout On Exit 
item. 

The emulator fills-in this section when you save the layout. 

script=[<scriptFile>] sets <ScriptFile> as the initialization script 
(the file of Shell commands run each time you start the SLD software). 
Either specify a full pathname or put the script in the SLD directory 
(e.g., c:lpowerpak). When no <ScriptFile> is specified, none runs. 

To change this entry, edit powerpak.ini. 

[lnitScript] 
II The sample script include.me is installed with the SLD 
software. 
script=include. me 

[LoadOptions] 

specifies load options 

SLD User's Manual 

[LoadOptions] entries can be changed in the Load Options dialog box. 
To open the Load Options dialog box, choose the Toolbar Load button; 
or choose the Source window File menu Load Code item. In the Load 
dialog box, after browsing the filename to be loaded, choose the 
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Options button. Load command arguments override the 
[LoadOptions] entries. 

AddressSpace=[user I smmJ specifies Intel x86 SMM or User 
address space when the file is loaded. Choose the Load Options dialog 
box User or SMM button. 

LoadSymbol=[1 I OJ specifies whether symbols are loaded. For 
example, when symbols are already loaded, tum off symbol loading 
and load only code. Toggle the Load Options dialog box Load Symbols 
item. 

LoadCode=[1 I OJ specifies whether to load code. For example, 
when debugging in ROM, tum off code loading and load only symbols. 
Toggle the Load Options dialog box Load Code item. 

LoadReportStatus=[1 I OJ specifies whether the load progress 
indicator appears during loading. Toggle the Load Options dialog box 
Report Status item. 

LoadReportWarning=[1 I OJ specifies whether load warnings 
appear. Toggle the Load Options dialog box Report Warnings item. 

LoadOnDemand=[1 I OJ specifies whether symbolic information is 
loaded for all modules immediately or loaded only when needed. 
Symbolic information includes local symbol and line-number 
information for a module. Such information is needed when either the 
module is displayed in the Source window or a breakpoint is set in the 
module. Advantages of on-demand symbol loading include faster 
initial loading, faster lookup for the symbols that are demanded, and 
less memory occupied by the loaded file since only the required 
symbols are loaded. Toggle the Load Options dialog box On Demand 
Symbol Loading item. 

LoadDemangle=[1 I OJ specifies whether symbols are demangled for 
the first instance of each overloaded function in a C++ program. 
Toggle the Load Options dialog box Demangle C++ Names item. 

LoadUpdateBase=[1 I OJ specifies whether x86 symbol base 
addresses are updated. For example, if your descriptor table bases are 
nonzero, you can save time by having the load process update your 
symbol base addresses from the descriptor table information. Toggle 
the Load Options dialog box Update Symbol Bases item. This option 
must be used in conjunction with LoadRegister (toggle the Load 
Options dialog box Load Initial Registers item). 

LoadRegister=[1 I OJ specifies whether x86 initial register values are 
loaded. For example, if your initialization code does nothing but 
initialize the registers, you can save time by having the load process 
extract the register information from your initialization code. Then, 
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powerpak.ini lines to 
load all code and 
symbols immediately 
(into User space, if 
there is a choice) and 
to report progress while 
loading 

[Network] 

lists available PP 
emulators 

[Serial] 

defines the COM port 
attached to the 
emulator or debugger 
hardware 

Select COM Port 
dialog box, popped-up 
automatically the first 
time you start the 
SLD software 

powerpak.ini lines to 
use COM port 2 

SW User's Manual 

you need not execute the initialization code. Toggle the Load Options 
dialog box Load Initial Register Values item. 

[Load Options] 
II 1 =enable, 0 =disable 
II The following are the installed default values. 
LoadSymbol=1 
LoadCode=1 
LoadReportStatus=1 
LoadReportWarning=O 
LoadOnDemand=O 
LoadDemangle=O 
LoadUpdateBase=O 
LoadRegister=O 
II The following is installed for some processors. 
AddressSpace=User 

emulators=<name>[,<name> ... ] specifies one or more PP 
emulators installed on the network. When multiple <names> appear 
in the list, a dialog box appears so you can choose one. This section is 
added by the network installation. Change this entry by editing 
powerpak.ini directly. 

comport=com[1 I 2 I 3 I 4] sets the COM port connecting your host 
system with the emulator. The first time you start the SLD software, 
this dialog box adds the [Serial] section and comport entry. To change 
the COM port later, edit powerpak.ini. 

[Serial] 
comport=com2 

Select COM Port 

Com Ports 

0COM1 

®COMl_ 

0COMJ_ 

0 COM.1 

71 

I _Qancel 

!!elp 
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[Sourcelnfo] 

controls the Source 
window display and 
options 

DisplayLineNum=[O 11] specifies whether source line numbers are 
displayed in the Source window. Toggle the Source window View menu 
Line Number item. 

StepCount=<num> specifies how many steps (1 to Ox7FFFFFFF) 
are executed per Step colilliland. Choose the Source window Options 
menu Step Count item and fill-in the dialog box. Or, enter a Step or 
StepSrc Shell colilliland. 

ViewSource=[1 I O] specifies the Source window display either as 
source from the source file (1) or as a combination of source and 
disassembly (0). Choose the Source window View menu Source Only 
item or Mixed Source And Assembly item. 

UseGolnto=[1 I O] specifies whether the Source window Call and 
Return buttons perform Go Into (1) or Go Until (0) emulation. Open 
the Source window Options menu Set Go Buttons item; choose Until 
Call/Return or Into Call/Return. 

UseLineExecGranularity=[1 I O] specifies whether a step executes 
an entire source line (1) or a single source statement (0). Open the 
Source window Options menu Set Step Granularity item and choose 
Source Line or Source Statement. Or, enter a StepSrc Line or StepSrc 
Statement Shell colilliland. 

HistoryDepth=<num> specifies how many source browsing locations 
(1 to 50) are saved. Fill-in the Source window Options menu Browser 
History Depth dialog box. 

TabWidth=<num> specifies the number of spaces (1 to 32) that 
replace a tab character in the Source display. The installed default is 
TabWidth=8. Fill-in the Source window Options menu Tab Width 
dialog box. 

SourceDelimiterUseCRLF=[1 I O] specifies the source delimiter (the 
ASCII character string used by the debugger to delimit a source line) as 
carriage return/linefeed (1 ), the DOS newline string or as linefeed only 
(0), the UNIX newline string. When SLD is installed, the delimiter is 
carriage return/linefeed. Open the Source window Options menu Source 
Line Delimiter item; choose Carriage Return/Linefeed or Linefeed Only. 

OperandAddressSize=[O I 1 I 2] specifies the x86 address mode for 
viewing disassembly in the Source window as: 

0 derives the address mode based on the pmode. 

1 uses 16-bit address mode. 

2 uses 32-bit address mode. 
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powerpak.ini lines 
specifying Source 
window options for 
associating source 
files with modules, 
displaying source or 
disassembly, and 
stepping 
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Open the Source window View menu Operand/ Address Size item; 
choose Auto, Use16, or Use32. 

DefaultModuleExtensions=[C, ASM, CPP, CXX, S] specifies the 
default source file extensions. To change this entry, edit powerpak.ini. 
When the source filename is stripped of its extension, the emulator 
searches for the filename with the default module extension. 

LoadFile[O I 1 I 2 I 3]=<pathname> specifies the pathnames of the 
last four source files you have loaded. This entry is updated 
automatically when you load a module with associated source. 

NumAliasPath=<number> specifies how many directories are listed 
as source paths. This entry is updated automatically when you add or 
delete a source path. 

SourcePathAlias<num>=<path> specifies a source path. There are 
as many of these entries as are counted in NumAliasPath. A 
SourcePathAlias entry is added, changed, or deleted each time you 
add, change, or delete a source path. Choose the Source window 
Options menu Source Path item. In the Source Path dialog box, to add a 
new path, choose Add and fill-in the Add dialog box; to change a path, 
select the path, choose Edit, and fill-in the Edit dialog box; to delete an 
existing path, select the path and choose Delete. 

[Sourcelnfo] 
II The following are the installed default values. 
II 1 = enable, O = disable 
DisplayLineNum=1 
StepCount=1 
ViewSource=1 
UseGolnto=1 
UseLineExecGranularity=1 
HistoryDepth=1 O 
TabWidth=8 
SourceDelimiterUseCRLF=1 
II O=auto, 1 = use16, 2 = use32 
OperandAddressSize=O 
II default source module extensions 
DefaultModuleExtensions=C,ASM,CPP ,CXX,S 
LoadFileO= 
LoadFile1= 
LoadFile2= 
LoadFile3= 
II The following entries are not installed, but 
II are added when you display source. 
NumAliasPath= 
SourcePathAliasO= 
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[Stacklnfo] 

controls the display 
and other options in 
the Stack window. 

powerpak.ini lines 
specifying options for 
stack usage statistics 

StackSize=<num> specifies the stack size and must match the target's 
allocated stack size. Unless specified in the load file, the stack size 
defaults to 4K bytes. Fill-in the Stack window Options menu Stack Area 
dialog box; or in the Shell window enter a SetStackArea or 
SetStackSize command. 

StackBaseAddr=<hex_addr> specifies the stack base address, as 
defined in the load file. Fill-in the Stack window Options menu Stack 
Area dialog box; or in the Shell window enter a SetStackArea or 
SetStackBase command. 

PercentAlarmLimit=<num> specifies the alarm limit as a percentage 
of the stack size, from 1to100. Fill-in the Stack window Options menu 
Alarm Limit dialog box; or in the Shell window enter a SetStackAlarm 
command. 

EnableAlarmLimit=[1 I O] specifies whether the emulator displays a 
warning message when stack usage reaches the percentage of the stack 
area specified by PercentAlarmlimit. Toggle the Stack window 
Options menu Enable Alarm Limit item; or in the Shell window enter 
EnableAlarmLimit or DisableAlarmLimit. 

EnableHWM=[1 I O] enables or disables the high water mark. Toggle 
the Stack window Options menu Enable High-Water Mark item; or in 
the Shell window enter EnableHighWaterMark or 
DisableHighWaterMark. 

ViewStackAddr=[1 I O] enables or disables displaying the Stack 
window stack address (the location of the frame on the stack). Toggle 
the Stack window Options menu Include Stack Address item. 

ViewCodeAddr=[1 I O] enables or disables displaying the Stack 
window code address (the called function's return destination). Toggle 
the Stack window Options menu Include Code Address item. 

[Stacklnfo] 
II The following are the installed default values. 
StackSize=1024 
StackBaseAddr=Ox800 
PercentAlarmLimit=95 
II 1 = enable, O = disable 
EnableAlarmLimit=O 
EnableHWM=O 
ViewStackAddr=1 
ViewCodeAddr=1 

powerpak.ini File Reference 74 SID User's Manual 



[Statuslnfo] 

specifies whether the 
Status window 
appears on top of 
other windows 

powerpak.ini lines 
positioning the Stack 
window 

[System Info] 

co-ordinates lnte/386 
emulation and target 
processors 

SW User's Manual 

Topmost=[1 I O] specifies whether the Status window (or icon, when 
minimized) appears on top of other SLD windows. With Topmost= 1, 
the Status window or icon remains in the foreground relative to any 
other overlapping SLD window, regardless of which window is in focus. 
Toggle the Status window Control menu Always on Top item. 

[Status Info] 
II The following is the installed default value. 
Topmost=1 

386EmulatorCPU=[386CX A-step I 386CX 8-step I none] 
describes the ex or sx bondout processor in the emulator probe. 

386EXEmulatorCPU=[386EX A/B-step I 386EX C-step] describes 
the EX bondout processor in the emulator probe. 

386TargetCPU=[386SX I 386CXSA I 386CXSA - SV I 386CXS8 I 
386CXS8 - 3V] describes the CX or SX processor in your target 
design. 

386EXTargetCPU=[386EXTA I 386EXT8 I 386EXT8 - 3V I 
386EXTC I 386EXTC - SV] describes the EX processor in your target 
design. 

386EmulatorCPUs=386CX A-step,386CX 8-step lists the Intel386 
CX/SX bondout processors recognized as emulator processors. 

386EXEmulatorCPUs=386EX A/B-step,386EX C-step lists the 
Intel386 EX bondout processors recognized as emulator processors. 

386TargetCPUs=386SX,386CXSA,386CXSA - SV ,386CXS8, 
386CXS8 - 3V lists the lntel386 CX/SX processors recognized as 
target processors. 

386EXTargetCPUs=386EXTA,386EXT8,386EXT8 - 3V, 
386EXTC,386EXTC - SV lists the lntel386 EX processors recognized 
as target processors. 

The first time you start the SLD software for Intel386 emulation, a 
dialog box appears for the 386[EX]EmulatorCPU and 
386[EX]TargetCPU entries. To change these entries later, edit or 
reinstall powerpak.ini. 
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CPU Configuration 
dialog box for co­
ordinating the 
emulator's bondout 
processor with your 
target processor 

EA and SW emulator 
front panel, showing 
the Reset Out pins 

powerpak.ini lines for 
co-ordinating the 
emulator and target 
processors 

----
CPU Configuration 

.E_mulator CPU: Iargel CPU: 

IUld+:l.WMIW! l386SX j;jij 

To discover the stepping, look for the part number (FPO) on the chip. 
Production FPOs are 8 digits followed by a change indicator. Pre­
production and obsolete parts use a 5-digit code starting with Q. 

CPU Step Production FPO Pre-production FPO 

386EX A xA or xB 08492 
B xD 07949 
c 08042 

386CXorSX A 
B 

xA 
xB 

08307 
08543 

To discover the current settings, use the Version Shell command. 

targResConfig=<Configuration> specifies the asserted and negated 
states of the SW and EA emulator Reset Out signal (Reset Target Shell 
command): 

Configuration Asserted Negated 

OpenCollector 

Active Low 

Active High 

low 

low 

high 

high-Z 

high 

low 

To change entries in this section, edit powerpak.ini. 

SJ1 ,---, Reset 
Out Sync 

~ 
SAST SJ2 ,---, Extemil Trace 

I 

[Systemlnfo] 
II The emulator fills-in the following entries 
II when you fill-in the appropriate dialog box. 
386EmulatorCPU= 
386TargetCPU= 
386EXEmulatorCPU= 
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386EXTargetCPU= 
II Avoid changing the following entries. 
386EmulatorCPUs=386CX A-step,386CX B-step 
386TargetCPUs=386SX,386CXSA,386CXSB 
386EXEmulatorCPUs=386EX A/B-step, 386EX C-step 
386EXT argetCPUs=386EXT A,386EXTB,386EXTB - 3V ,386EXTC -
5V 
II The emulator adds this entry the first time 
II you enter a Reset Target command. 
targResConfig=OpenCollector 

[ToolBarlnfo] 

saves the window 
layout and masks 
interrupts during 
single stepping. 

powerpak.ini lines to 
retain the prior layout 
when exiting 

[ToolChain] 

describes OMFB6 
section names and 
bitfield information 

powerpak.ini lines 
resolving OMF86 
toolchain specifics 

[Tracelnfo] 

sets the Trace 
window options 
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SaveLayout0nExit=[1 I O] specifies whether the SLD window layout 
(the SLD windows as you have opened, positioned, and sized them) is 
saved when you exit. If the layout is not saved, the previously saved or 
default layout appears next time you start. Toggle the Toolbar Layout 
menu Save Layout On Exit item. 

[ToolBarlnfo] 
II The following is the installed default value. 
SaveLayoutOn Exit=O 

OMFBaseTypeNames=CODE,DATA specifies your OMF86 code 
and data section names. Edit powerpak.ini to change this entry. 

maxBitFieldSize=[16 I 32] specifies your OMF86 bitfield size. Use 
the MaxBitFieldSize Shell command to specify 16 for loadfiles 
generated with the Borland C compiler and 32 for other toolchains. 

[ToolChain] 
II The following are the installed default values. 
II OMF86 Base type names 
OMFBaseTypeNames=CODE,DAT A 
II OMF386 - maxBitFieldSize [<16132>] 
maxBitFieldSize=32 

linkedCursor=[on I off] turns on or off the code address link between 
the Trace and Source windows. The link is valid only when the Trace 
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window displays instructions (see viewType in this section) and the 
Source window displays mixed source and disassembly (see 
viewSource in the [Sourcelnfo] section). 

When cursors are linked, the Source window scrolls automatically to 
match the Trace display. 

To enable linkedCursor: 

1. Enable the Source window View menu Mixed Source And 
Assembly item. 

2. Enable the Trace window View menu Instruction Cycles item. 

3. Enable the Trace window View menu Linked Cursor item. 

To disable linkedCursor, disable the Trace window View menu Linked 
Cursor item. 

viewType=[bus I clock I instruction] sets the trace view as: 

bus 

clock 

displays the processor signals at each bus cycle. 

displays the processor signals at each clock cycle (PP and 
EA emulators only). 

instruction displays the instructions executed by the processor and the 
resulting reads and writes. 

Choose the Trace window View menu Clock, Bus, or Instruction Cycles 
item. 

timestamp=[on I off] turns on or off the PP and EA trace timestamp 
display. Toggle the Trace window View menu Timestamp item. 

systemFrequency=<frequency> specifies the PP emulator target 
system clock frequency; 0.01 Hz ::;; <frequency> ::;; 40 MHz. Fill-in the 
Trace window Timestamp menu Setup dialog box. 

tsmode=[relative I delta I absolute] specifies the PP or EA 
timestamp mode as: 

relative shows timestamps as elapsed time from a zero frame. 

delta shows each timestamp as incremental time from the 
previous frame. 

absolute shows EA timestamps as elapsed time from the last 
timestamp reset. 

Choose the Trace window Timestamp menu Relative To Frame, Delta, 
or Absolute item. 

tsReset=[on I off] specifies whether the EA timestamp is set to 0 each 
time emulation halts. 

captureMode=[clock I bus] specifies whether the EA captures trace 
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powerpak.ini lines 
specifying Trace 
options 

[Trig Info] 

sets the Trace 
Control and Trigger 
window options 

SW User's Manual 

as clock or bus cycles. 

traceStartState=[enabled I disabled] specifies whether the EA 
starts capturing trace when emulation starts. 

btmCycles=[enabled I disabled] specifies whether BTM (branch­
taken message) cycles are collected and shown. A BTM cycle indicates 
a change in execution flow, such as a jump. The emulator must collect 
BTM cycles to display trace as instructions. Toggle the PP Trace 
window View menu BTM Cycles item or the EA Trace Capture dialog 
box Instruction Mode Assist item. 

[Tracelnfo] 
II The following are the installed default values. 
linkedCursor=off 
viewType=bus 
timestamp=on 
systemFrequency=25MHz 
tsMode=relative 
tsReset=on 
captureMode=clock 
traceStartState=enabled 
btmCycles=enabled 

This section is used by the EA and PP emulators only. 

numTraceBuffers=[1 I 2 I 4 I 16 I 32 I 64 I 128 I 256] specifies the 
number of PP trace buffers. Specifying the number of trace buffers also 
specifies the size of each trace buffer. The buffer size options depend on 
the amount of trace memory (128K or 256K bytes) in your emulator. 

Fill-in the PP Trace window Trace menu or Trigger window Options 
menu Trace Control dialog box Number Of Trace Buffers (X Size) item. 

traceAlignment=[center I pre I post] specifies the position of the 
triggering event in the trace buffer: 

center Trace buffers fill before and after the trigger. The trigger 
appears in the center of the trace display. 

pre Trace buffers fill up to the trigger. The trigger appears 
near the end of the display. 

post Trace buffers fill up after the trigger. The trigger appears 
near the beginning of the display. 

Fill-in the Trace or Trigger window Options menu PP Trace Control or 
EA Trace Capture dialog box. 

79 powerpak.ini File Reference 



powerpak.ini lines 
specifying Trigger 
options 

breakOnFull=[on I off] specifies whether the emulator breaks when 
all PP trace buffers become full. Toggle the Trace window Trace menu 
or the Trigger window Options menu Trace Control dialog box Halt 
When Last Trace Buffer Full item. 

counterTimer=[counter I timer I timerx2] configures the Trigger 
window counter and timer conditions: 

counter enables the PP single counter or the EA paired counters. 
Choose the Trigger window Options menu PP Counter or 
EA 2 Counters item. 

timer enables the paired timers. Choose the Trigger window 
Options menu PP Timer or EA 2 Timers item. 

timerx2 enables the EA single timer. Choose the EA Trigger 
window Options menu Cascaded Timer item. 

trigMode=[bus I clock] specifies the type of cycle used for triggering: 

bus automatically samples processor pins at the proper time in 
a bus cycle. The trigger is based on aligned samples. 

clock triggers on any cycle coming from the processor, regardless 
of whether it is a valid bus cycle. Use clock triggering to 
trigger on an I/O signal or on an interrupt input that can 
occur on any clock cycle. 

Choose the Trigger window Options menu Bus or Clock item. 

triglnputMode=[activeHigh I activelow] specifies whether the EA 
Trigger window Ext condition matches a high or low Trigger In signal. 
Choose the Trigger window Options menu Trigger In High or Low item. 

trigOutputMode=[activeHigh I activelow I openCollector] 
specifies the EA Trigger window Ext action Trigger Out signal value. 
Choose the Trigger window Options menu Trigger Out Active High, 
Low, or Open Collector item. 

[Triglnfo] 
II The following are the installed default values. 
numTraceBuffers=1 
traceAlignment=pre 
breakOnFull=off 
counterTimer=counter 
trigMode=bus 
trigger! nActive=low 
triggerOut=activeLow 
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[Variablelnfo] 

supports bitfield types 

powerpak.ini lines 
resolving toolchain 
specifics 

SW User's Manual 

AutoCalcBitfieldOffsets=[1 I O] specifies whether to calculate the 
SLD software bitfield offsets automatically. Set this entry to 1 when the 
toolchain does not generate bitfield member offsets. 

[Variablelnfo] 
II The following is the installed default value. 
AutoCalcBitfieldOffsets=O 
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Toolbar Ref ere nee 
= PowerPack SLO Toolbar a 

Eile !;.onfigure 
Setup 

Layout Windows .!:!_elp 
Target E111ulation Trace Misc 

The Toolbar opens when you start the SLD software and is always 
available. Options unavailable for your emulator configuration are 
greyed-out. Closing the Toolbar ends your emulator session. 
Minimizing the Toolbar hides all other SLD windows and icons. 

Toolbar Menus 

Exit dialog box, 
popped-up from the 
Toolbar File menu, to 
exit from the SLD 
software 

SW User's Manual 

Menu 

File 

Configure 

Layout 

Windows 

Help 

File Menu 

Use To: 

Exit the SLD software. 

Configure and initialize the debugging environment. 

Save your screen layout of SLD windows. 

Select a closed or iconized SLD window to open. 

Open a window for help with the SLD software. 

You can exit the SLD software as you would exit any Windows 
application; or you can open the File menu and choose Exit. The 
emulator asks you to confirm exiting. 

Powe rPa ck S LD 

@ Exit PowerPack SLD? 

In any SLD window other than the Toolbar, choosing Exit closes only 
that window. Exit is on every SLD window File menu except in the 
CPU window, where Exit is on the Options menu. 
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Toolbar Configure 
menu 

Toolbar Reference 

Configure Menu 

Configure menu items vary between processors. 

Map ... 
Run8ccess 

./ S~mbolic Disassembly 

Configure Symbols 

R~set 

Reset CPU Qnly 

Map .•. opens the Map dialog box for examining and modifying your 
memory map. Choosing this menu item has the same effect as choosing 
the Map button. The Map dialog box is described in the "Map Dialog 
Boxes" section later in this chapter. You can also configure memory 
with Map and RestoreMap Shell commands. 

Run Access, when checked, enables memory access during emulation. 
Memory access is used to update the Peripheral and Memory windows 
and to read or write peripheral registers and memory. (Run access does 
not affect CPU register access, which is always unavailable during 
emulation.) Because memory access takes a small amount of processor 
time, doing such operations during emulation can degrade your 
program performance. Initially, run access is disabled (unchecked) and 
memory access is available only when emulation is halted. 

You can also enable and disable run access with the RunAccess Shell 
command. 

Symbolic Disassembly, when checked, uses symbolic addresses in the 
disassembly displayed in the Source and Memory windows. 

Save Chip Selects ••• records the chip-select register values in an ASCII 
file. For a list of saved registers, see the Hardware Reference. The 
values can be restored with the Restore Chip Selects item. 

You can also save the chip select registers with the SaveCS Shell 
command. 

Restore Chip Selects ••• restores the chip-select register values from an 
ASCII file. You can create this file with the Save Chip Selects item, 
with a SaveCS Shell command, or with a text editor. 

Configure Symbols updates the loaded symbols with the base address 
from the descriptor table (GDT or LDT). Your program must provide 
the GDTR and LDTR values and the GDT and LDT contents. 

ICECFGO Register ••• opens the ICE Peripheral Disable Register dialog 
box for setting bits in the Intel386 EX processor ICECFGO register. To 
enable or disable specific peripherals on ICE break, check or uncheck 
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ICE Peripheral Disable 
Register dialog box, 
accessed from the 
Toolbar Configure 
menu ICECFGO item, 
with all peripherals 
enabled on ICE break 

each option. The following shows an ICE Peripheral Disable Register 
dialog box with all peripherals enabled on ICE break. 

ICE Peri11heral Disable Register 

D [~i§··~·~j~·~·~le·~···~P~·~ iC.~.··~;~~~] 
D SIO 1 disabled UJIOn ICE break 

D J;iSIO disabled u11on ICE break 

D !!_MA disabled u11on ICE break 

D .!!.254 Timer disabled u11on ICE break 

D WOT disabled UJIOn ICE break 

QK I I !;ancel I I tlelJI 

Reset resets and reinitializes the target processor: 

• The processor RESET pin is asserted. 

• The program counter is read from memory; the Source window is 
scrolled to the beginning of code. 

• The stack pointer is read from memory, resetting the stack; the 
Stack window display becomes invalid. 

• All SLD windows are updated. 

You can also reset the processor with the Source window Run menu 
Reset item, the CPU window Options menu Reset item, or the Reset 
Shell command. 

Reset CPU Only resets only the processor and does not update the 
windows. Use Reset CPU Only if Reset fails to reset the processor. 

You can also reset only the the processor with the CPU window Options 
menu Reset CPU Only item or the Reset Shell command. 

Layout Menu 

Save Settings Now saves the SLD screen layout immediately. 

Save Settings On Exit saves SLD screen layout when you exit. 

Toolbar Buttons 

SW User's Manual 

Button Use To: 

Map Open the Map dialog box (described later in this chapter) to 
examine or change the memory configuration. This button 
has the same effect as the Configure menu Map item. You 
can also configure memory with the Map and RestoreMap 
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Memory window 
selection dialog box, 
accessed from the 
Toolbar Mem button 
when multiple memory 
windows are open 

Toolbar Reference 

Shell commands. 

Load Open the Load dialog box (described later in this chapter) to 
load code and/or symbols. You can also load code and 
symbols with the Load Shell command or the Source 
window File menu Load Code item. 

Trigger Open the Trigger window to define triggers and events for 
controlling emulation and trace collection. This button has 
the same effect as the Windows menu Trigger item. (PP 
and EA only) 

Source Open the Source window to examine source and 
disassembly, manage breakpoints and stepping, and find 
source corresponding to displayed trace. This button has 
the same effect as the Windows menu Source item. 

Stack Open the Stack window to view the current nested calls, 
associated parameters and variables, and stack usage 
statistics. This button has the same effect as the Windows 
menu Stack item. You can also examine the stack with the 
Stacklnfo and StackArea Shell commands, or modify the 
stack with the StackArea, StackBase, and StackSize 
Shell commands. 

CPU Open the CPU window to view and change processor 
registers. This button has the same effect as the Windows 
menu CPU item. You can also display and edit the CPU 
registers with the Register Shell command. 

Mem Open or change focus to one of up to 20 Memory windows 
to view and change memory. This button has the same 
effect as the Windows menu Memory item. You can also 
view and change memory with the Dump, Write, Fill, 
Search, and Copy Shell commands. If more than one 
Memory window (including minimized windows) is open, a 
dialog box appears for choosing an existing Memory 
window or open a new one. 

Memory 

Jielect Memory Window 

0 : Hex Words OxO 
(1): Disassembly OxO QK 

!;ancel 

.!::!.elp 
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Periph 

Go 

Halt 

Start 

Stop 

Show 

Shell 

Open the Peripheral window to view and change peripheral 
register values. This button has the same effect as the 
Windows menu Peripheral item. Peripheral registers are 
unavailable on some processors. 

Start emulation from the current program counter, 
controlled by previously defined breakpoints and triggers. 
This button has the same effect as the <F9> key, the Source 
window Go button and Run menu Go item, and the Shell 
Go command. 

Stop emulation. This button has the same effect as the 
<F2> key, the Source window Halt button and Run menu 
Halt item, and the Shell Halt command. 

Begin collecting trace. Tracing starts automatically when 
emulation starts. You can start and stop trace collection 
during emulation without affecting emulation. You can also 
start trace with the Trace window Trace menu Start item. 

Stop collecting trace. You can also stop trace with the 
Trace window Trace menu Stop item. 

Open the Trace window to display collected trace. You can 
examine trace during emulation. This button has the same 
effect as the Windows menu Trace item. 

Open the Shell window for command-line entry. This 
button has the same effect as the Windows menu Shell item. 

Map Dialog Boxes 

Map dialog box with 
128K bytes of overlay 
memory mapped for 
RAM access 

SW User's Manual 

The Map dialog box lists the configuration of each mapped region. To 
select a region, click on it or use the <Up Arrow> and <Down Arrow> 
keys to move the highlight. 

Start Addr End Addr Size (KB) Type Access Space 

1§.UUiliii t.11 t@HIDIMI User 

Md 11 _Edit 11 .Qelete I I ~ave 11 Restore I I .Close 11 Help 
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Map Edit dialog box, 
similar to the Map Add 
dialog box, accessed 
from the Map dialog 
box Edit button 

Toolbar Reference 

Map Dialog Box Buttons 
Button Use To: 

Add Open a dialog box to configure unmapped memory. Valid 
Start Addr and Length/End Addr values depend on how 
much memory is available. 

~~~~~~~~ 

Edit 

.:;;tartAddr: Im r!I Iype: I overlay 
I!! 

Length/End Addr 
Access: IRAM 

I!! 

® Length: I Ox2000 
0 J;ndAddr: fit [Space Mode 

[ZJ !,Iser OS.MM I 
QK J;;ancel !::!elp 

For more information on the Start Addr, Length/End Addr, 
and Access field values, see the list of Map dialog box field 
contents below. 

Edit Open a dialog box (see the Add button description above) to 
reconfigure a mapped region. This button is available when 
a listed region is selected. 

Delete Revert a mapped region to unmapped memory. This button 
is available when a listed region is selected. 

Save Open a dialog box to save the listed configuration to a map 
(*.map) file. You can also use the SaveMap Shell 
command to save the map configuration. 

Restore Open a dialog box (see the Save button description above) to 
configure regions from a previously saved map (*.map) file. 
You can also use the RestoreMap Shell command to 
restore a previously saved map configuration. 

Close Close the Map dialog box. 

Help Open a window for help on mapping. 

You can also use the Map Shell command to examine and modify 
memory mapping. 

Map Dialog Box Fields 
Field Value 

Start Addr must start on a 4K boundary. 

End Addr can end on any address. 

Size varies between processors: 
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Type 

Access 
Rights 

Space 

• for PP-386 and SW-386 emulators, any multiple of 
4K bytes starting on any 4K address 

• for EA-486 emulators, any multiple of 128K bytes 
starting on any 128K address 

• for EA-NS486 emulators, any multiple of 4K bytes 
starting on any 128K address 

Specify a region size instead of an end address by 
choosing the Length rather than the End Addr button in 
the Map Add/Edit dialog box, then filling-in an 
appropriate value in the Length/End Addr field. 

is Overlay or Target. You can install IM or 4M bytes of 
overlay memory on the emulator to substitute for target 
memory. To use the overlay memory, you must map a 
region as Overlay. Unmapped regions are mapped as 
Target and use your target board memory. 

is one of the following ways to control and alert you to 
memory access by your program: 

RAM allows read and write access. 

ROM BREAK (Intel processors only) allows read access; 
prevents write access; and breaks on attempted write 
access. For Target memory, write access is allowed but 
causes emulation to break. 

ROM NOBREAK allows read access; prevents write 
access; does not break on attempted write access. For 
Target memory, write access is allowed. 

NONE (Intel processors only) prevents any access; breaks 
on attempted access. For Target memory, read and write 
accesses are allowed but cause emulation to break. 

(Intel processors only) is User or SMM (system 
management mode). 

Load Dialog Boxes 

SW User's Manual 

Open a dialog box for loading code and symbols with the Toolbar Load 
button. 
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Load dialog box, 
accessed from the 
Toolbar Load button 

OMF386 Load Options 
dialog box, accessed 
from the Load dialog 
box Options button 

Toolbar Reference 

File Name: 

lni 
demo_omf 
demo386_omf 

t 
t--

Load 

Q_irectories: 

c:::\powerpak\samp386 

E7 c:::\ 
127 powerpak 
~samp386 

List Files of Iype: Drilt_es: 

~lo_M_F_x_os_F_i_le_s_(* __ o_M_F) __ ~I !~I I e c::: ms-dos_62 

t 
1--1 

-----

QK 

.Qanc::el 

OJl_tions __ _ 

!ielp 

Network __ _ 

When you select a loadfile, the Options button in the Load dialog box 
becomes available. Choosing this button opens the Load Options dialog 
box for specifying how to load code and/or symbols from the loadfile. 
Available options depend on your processor and loadfile format. 

When you are ready to load, choose the OK button. To exit the Load 
dialog box without loading, choose the Cancel button. To open a 
window with help on loading, choose the Help button. 

Load Options 

Os.MM 

l:EJ !.oad Code 

l:EJ Load fu<mbols 

0 On Q_emand Symbol Loading 

0 Demangle C++ Names 

0 Update Symbol !lases 

0 Load !nitial Register Values 

l:EJ Report Status 

0 Report 'l!'l!_arnings 

Q_K I ~ncel I tlelp 

Be sure the space you select is compatible with the address space 
configured in the Map dialog box. (Intel processors only) 

To enable an option, check the box beside the option. To disable an 
option, uncheck the box. 

Option 

Load Code 

Load Symbols 

Effect 

loads executable code sections from your loadfile. 

loads data sections and relevant symbolic 
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On Demand 
Symbol 
Loading 

Demangle C++ 
Names 

Update Symbol 
Bases 

Load Initial 
Register Values 

Report Status 

Report 
Warnings 

information from your loadfile. When this option is 
enabled, several sub-options are available. 

waits to load symbolic information for each module 
until it is needed, for example when you display the 
module in the Source window. 

uses an MRI algorithm to demangle some C++ 
symbols, for example overloaded function names. 

reads base addresses for symbol tables, once the 
registers are initialized with Load Initial Registers. 

initializes the processor registers from information 
put into the loadfile during compilation and linking. 

displays an information box showing the load 
operation progress. 

displays information boxes with non-fatal anomalies 
encountered during loading. 

You can load a file during emulation. Be sure the file's load addresses 
do not overlap the memory occupied by the running program. Loading 
a file at a location in use stops the emulator in an unpredictable state. 

You can specify equivalent load options with the Load Shell command. 
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Shell Window Ref ere nee 

.Eile J;_dit :i{iew Qptions Windows !:!elp 
include "include.111e"; 
II 
II Here is an example of a start up script: 
II 
II 
II 
II 
II 
II 
II 
II 
II 
II 
II 

uersion; 
alias "uer" "uersion"; 
rnap O fffffp; 

II get uersion information abou 
II example of aliasing a co111111an 
II set up ouerlay 111e111ory rnap 

This file, include.me, is run each tirne PowerPack SLD 
is brought up. Edit this file with co111111ands to set 
up your enuironrnent. The [InitScript] section of 
the file pov1erpak.ini (in your Windows directory) 
can be edited to eliminate this feature or to 
change the narne of the initial script file. 

+ 

Shell Window Contents 

The Shell window contains two panes: 

Transcript in the top part of the window, echoes commands and 
command output. 

Command Entry in the bottom part of the window, is where you enter 
commands. 

You can change the relative sizes of the Shell window panes. A split 
box between the vertical scroll bars defines the edge between the 
Transcript and Command Entry panes. When the mouse is pointing to 
the split box, a split-box cursor appears (see figure at left). Drag the 
split box to resize the panes. 

To change focus from one pane to the other, click in the inactive pane 
or press the <Tab> key. 

Shell Window Menus 

SW User's Manual 

Some items are on/off toggles, on when a check mark ( ,/) appears. 
Others take immediate action. Items with ellipses pop-up dialog boxes. 
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Open dialog box to run 
a Shell script, with the 
include.me script 
selected 

Use To: 

Run a script; close the Shell window. 

Menu 

File 

Edit Manage text in the Command Entry and Transcript pane 
using Windows Clipboard. 

Manage the Transcript pane display. View 

Options Manage log files, command history, and the Transcript 
size. 

Help Open a window for help with the SLD software. 

File Menu 

Include File ••• opens a dialog box wherein you can select a script (a text 
file of Shell commands) to be run immediately. 

FileN,ame: 

I include. me 

eY386sxl.cfg 
eY486ea.cfg 
eY4861.cfg 
eYent.dll 
eYtlmpltdll 

llml· 
ldr80386.clg 
ldr80486.c!g_ 

.. 
t-

t-

t-

c+ 

Open 

!lirectories: 

c: \powerpak 

ICl' c:\ 
~ powerpak 
LJ samp386 
LJ sampn486 

List Files of 1.l'pe: D riyes: 

'~A_ll_Fi_le_s(_"-_"l ___ ~I !~j I ia c: ms-dos_6 

---

OK 

Cancel 

!:!.elp 

D f!.ead Only 

Exit closes the Shell window without exiting the SLD software. 

Edit Menu 

Cut 
!;opy 
.E'aste 

Cut moves highlighted strings to the Windows Clipboard. 

Copy copies highlighted strings to the Windows Clipboard. 

Paste copies strings from the Clipboard to the Command Entry pane. 
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View menu with Echo 
Command and Show 
Results enabled 

Options menu with 
Overwrite Log File 
enabled 

History Size dialog 
box, specifying that a 
running history of the 
20 most recent Shell 
commands be kept 

SW User's Manual 

View Menu 

,/ _Echo Command 
,/ Show Results 

.Qlear Transcript 

Echo Command displays in the Transcript pane all commands you 
enter in the Command Entry pane. 

Show Results displays in the Transcript pane the results of commands 
you enter in the Command Entry pane. 

Clear Transcript blanks the Transcript pane. 

Options Menu 

• 
.Log Results 
Log file Name ... 

Append To Log File 
,/ Qverwrite Log File 

Set History Size ... 

Set Iranscript Size ... 

Log Results starts recording into a text file all that appears in the 
Transcript pane. If you have not previously specified a log filename, 
the emulator uses shell.log in your SLD directory 
(c:\powerpak\shell.log if you installed to the default directory). 

Log File Name ••• opens a dialog box to specify the logfile pathname. 

Append To Log File ensures that text recorded into an existing file is 
added to the end of the file without destroying any prior file contents. 

Overwrite Log File ensures that text recorded into an existing file 
overwrites the file, destroying any prior file contents. 

Set History Size ••• opens a dialog box to specify the maximum number 
of commands retained in the history buffer. Recall past commands with 
<Ctrl><Up Arrow> and <Ctrl><Down Arrow> key combinations. 

History Size 

.S.aved Commands (0-50): 

20 

OK !;_ancel .!::!elp 
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Transcript Size dialog 
box, specifying that the 
275 most recent lines 
of Shell command 
activity be kept 

Set Transcript Size ••• opens a dialog box to specify the maximum 
number of lines retained in the scrollable Transcript pane. 

-----
Transcript Size 

Iranscript Size (0-1000): 

OK Cancel tlelp 

Entering Commands in the Shell Window 

Enter commands in the Shell window by one of: 

• Type a command. Press <Enter> to execute it. 

• Type a sequence of commands. Follow each command with a 
semicolon (;). Press <Ctrl><Enter> to start a new line without 
executing the already typed commands. Press <Enter> to execute 
the sequence of commands. 

• Execute a script (a text file of commands delimited by semicolons). 
You can create or change a script in a text editor. To execute a 
script, use the Shell window File menu Include item or the Include 
command (described later in this chapter). In the powerpak.ini 
file, you can specify a script to execute automatically when the SLD 
software starts. The default initialization script is include.me. 

• Recall previously entered commands from the history buffer by 
scrolling with <Ctrl><Up Arrow> or <Ctrl><Down Arrow>. Edit 
the command line as needed, then press <Enter> to execute. To 
specify the history buffer size, fill-in the Options menu Set History 
Size dialog box. 

To cancel a command line without executing it, press <Esc> instead of 
<Enter>. To interrupt command execution, press <Esc>. 

The emulator interprets addresses as hexadecimal and data as decimal 
values. Prefix hexadecimal data with Ox, as shown in the following: 
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Shell commands with 
hexadecimal 
addresses, decimal 
data, and hexadecimal 
data 

Eile fdit lliew Qptions Windows !::!elp 
reg cs 55 // Set CS register to 55 decimal. 
reg cs / / Sho1~ CS register ualue in hexadecimal. 
II CS ~ Ox0037 
1~rite 10:50 OK33 // Write 33 hexadecimal to segment 10, offset 50. 
II Write successful. 
dump 10:50 II Show heKadecimal ualues at heKadecimal address 10:50. 
II 0010:0050 33 00 oo oo 00 00 00 00 00 00 00 00 00 00 00 00 

Shell Window Commands 

SW User's Manual 

Notational Conventions 

The following notational conventions are used in the following pages: 

Notation Meaning 

COMMANDNAME 
command name 
Command Name 

<placeholder> 

[item] 

(item) 

{item} 

item1 I item2 

"<string>" 

I* comment *I 
II comment 

II response 

Case is not significant in command names, 
keywords, and aliases. Case is significant in 
Shell variables. 

Indicates an symbol or expression argument. 

Brackets delimit an argument that can be 
entered no more than once. 

Parentheses delimit an argument that must be 
entered at least once. 

Braces delimit an argument that can be entered 
zero or more times. 

A vertical bar separates mutually exclusive 
arguments. 

Delimit string constants with double quotes. 

Delimit comments C-style or C++-style. 

Forward slashes precede command output. 
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Commands and System Variables Grouped by 
Function 

To Do Use 
Address Xlt 
translation 

Assembly; Asm 
disassembly 

AsmAddr 

Dasm 

DasmSym 

Breakpoints Bkpt 

BkptClear 

DR 

Bus error BusRetry 
management 

Chip select Restore CS 
setup 

SaveCS 

Compiler MaxBitFieldSize 
setup 

CPU data DT 
structures 

GDT 

GetBase 

IDT 

LDT 
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For 

translating numeric and 
symbolic address formats 

assembling lines of code 
directly into memory 

determining the location 
and address mode for 
assembling into memory 

showing memory contents 
as disassembly 

showing symbolics in 
disassembled memory 

setting and showing 
breakpoints 

removing breakpoints 

managing debug registers 

managing bus contention 
and timeout 

setting 386EX and NS486 
chip select values from a 
file 

saving 386EX and NS486 
chip select values to a file 

setting the bit field limit 
for OMF386 loadfiles 

displaying the descriptor 
table 

displaying the global 
descriptor table 

displaying the symbol base 

displaying the interrupt 
descriptor table 

displaying the local 
descriptor table 
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Commands and System Variables Grouped by 
Function (continued) 
To Do Use For 

PD displaying the page 
directory 

PM ode displaying the address 
mode 

TSS displaying the task state 
segment 

Emulation Go emulating 

Gointo emulating until a function 
call or return has occurred 

Go Until emulating until just before 
a function call or return 

Halt halting emulation 

ResetAndGo resetting the processor, 
then emulating 

Step emulating one or more 
instructions 

StepSrc emulating one or more 
source statements 

Event EventRestore setting event definitions 
definition from a file 

EventSave saving event definitions to 
a file 

Help Help invoking SLD on-line help 

Loading Load loading code and symbols 

LoadSize determining the memory 
access size for loading 

ResetLoaders correcting an internal 
loader error on request 

Memory Copy copying contents between 
management memory locations 

Dump disassembling memory to 
the Transcript pane 
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Commands and System Variables Grouped by 
Function (continued) 

To Do 

Register 
access 

Resetting 
processor 

Shell 
commands 

Shell Window Reference 

Use 

Fill 

Map 

Restore Map 

RunAccess 

SaveMap 

Search 

Size 

Verify 

Write 

Config 

Register 

Reset 

ResetAndGo 

Alias 

Append 

Clear 

Delete 

Echo 

100 

For 

writing a repeating pattern 
to memory 

setting and showing 
memory access options 

setting map information 
from a file 

allowing memory access 
during emulation 

saving the map to a file 

finding a value or pattern 
in memory 

determining the memory 
access size 

checking memory writes 

writing a value to memory 

configuring the 386EX 
HLDA signal 

reading or writing CPU 
register values 

resetting the processor and 
SLD windows or the target 

resetting the processor, 
then emulating 

defining one string to be 
substituted for another 

adding new log 
information to existing log 

erasing the Transcript 
pane 

removing a Shell variable, 
alias, or link 

toggling command display 
in the Transcript pane 
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Commands and System Variables Grouped by 
Function (continued) 
To Do Use For 

Exit exiting the Shell window 

History sizing the history buffer 

If executing Shell commands 
conditionally 

Include executing a script 

Integer finding whether a Shell 
variable is an integer 

Link managing source 
filenames 

List showing Shell variables 

Log opening a log file 

Logging starting or stopping the 
log 

Overwrite replacing previous log 
with new log information 

Print showing Shell variables 
with specified text 

Results toggling response display 
in the Transcript pane 

String discovering whether a 
Shell variable is a string 

Transcript setting or showing the 
Transcript pane size 

Time showing the current date 
and time 

While repeatedly executing Shell 
commands conditionally 

Stack DisableAlarmLirnit disabling the stack usage 
management alarm 

DisableHigh W aterMark disabling the stack 
maximum-usage indicator 

Display Stack showing the stack contents 
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Commands and System Variables Grouped by 
Function (continued) 
To Do 

Status 
reporting 

Shell Window Reference 

Use 
EnableAlarmLimit 

EnableHigh WaterMark 

FillStackPattem 

SetStackAlarm 

SetStackArea 

SetStackBase 

SetStackSize 

Stacklnfo 

$BREAKCAUSE 

$EMULATING 

$PROCESSOR 

$PROCFAMIL Y 

$PROCTYPE 

$SHELL_STATUS 

$SYSTEMTYPE 

BusRetry 

Cause 

Emu Status 

102 

For 

enabling the stack usage 
alarm 

enabling the stack 
maximum-usage indicator 

writing a repeating value 
to the stack area 

specifying the stack usage 
alarm 

determining the stack base 
and size 

determining the stack base 

determining the stack size 

showing the stack 
definition and statistics 

showing why emulation 
halted 

showing whether 
emulation is halted 

identirying target CPU 

identifying target CPU 
family 

identifying target CPU 
type 

showing the last Shell 
command status 

identifying emulator and 
probe CPU 

managing bus contention 
and timeout 

showing why emulation 
halted 

showing current emulator 
activity 
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Commands and System Variables Grouped by 
Function (continued) 
To Do Use For 

IsEmuHalted showing whether 
emulation is halted 

Time displaying the current 
time 

Version displaying host and 
emulator version 
information 

Symbol Address Of displaying a symbol's load 
management address 

ConfigSymbols updating the symbol base 
from registers 

DisplaySyrnbols displaying program 
symbolic information 

NameOf displaying the symbol 
associated with an address 

RemoveSymbols removing loaded symbolic 
information 

SetBase setting the symbol base 

SymbolCloseFile closing the file of recorded 
symbolic information 

SymbolOpenFile recording symbolic 
information to a file 

Target Reset resetting the processor or 
control the target system 

Signal determining whether 
signals are driven by the 
emulator or the target 

Testing RAMtst running the memory 
hardware confidence tests 

Test running the hardware 
confidence tests 

Timing Lap Timer displaying the timer 

StartTimer starting the timer 
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Commands and System Variables Grouped by 
Function (continued) 

To Do 

Tracing 

Shell Window Reference 

Use 
Stop Timer 

Flush 

104 

For 

stopping the timer 

flushing the cache 
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Command Dictionary 

$BREAKCAUSE ................................................................................. 108 
$EMULATING .................................................................................... 108 
$PROCESSOR ..................................................................................... 109 
$PROCFAMILY .................................................................................. 109 
$PROCTYPE ....................................................................................... 109 
$SHELL_STATUS ............................................................................... 110 
$SYSTEMTYPE .................................................................................. 110 
Address Of ............................................................................................ 111 
Alias .................................................................................................... 111 
Append ................................................................................................ 112 
Asm ..................................................................................................... 112 
AsmAddr ............................................................................................. 113 
Bkpt ..................................................................................................... 113 
BkptClear ............................................................................................. 114 
BusRetry .............................................................................................. 114 
Cause ................................................................................................... 115 
Clear .................................................................................................... 115 
Config .................................................................................................. 115 
ConfigSymbols ..................................................................................... 116 
Copy .................................................................................................... 116 
Dasm ................................................................................................... 117 
DasmSym ............................................................................................. 117 
Delete ................................................................................................... 118 
DisableAlarmLirnit .............................................................................. 118 
DisableHigh W aterMark ....................................................................... 119 
Display Stack ........................................................................................ 119 
DisplaySymbols .................................................................................... 120 
DR ....................................................................................................... 121 
DT ....................................................................................................... 122 
Dump ................................................................................................... 123 
Echo ..................................................................................................... 124 
EmuStatus ............................................................................................ 124 
EnableAlarmLirnit ............................................................................... 124 
EnableHigh Water Mark ........................................................................ 125 
EventRestore ........................................................................................ 125 
EventSave ............................................................................................ 125 
Exit ...................................................................................................... 125 
Fill ....................................................................................................... 126 
FillStackPattern .................................................................................... 126 
Flush .................................................................................................... 127 
GDT ..................................................................................................... 127 
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GetBase ................................................................................................ 128 
Go ........................................................................................................ 128 
Golnto .................................................................................................. 128 
GoUntil ................................................................................................ 129 
Halt ...................................................................................................... 129 
Help ..................................................................................................... 129 
History ................................................................................................. 130 
IDT ...................................................................................................... 130, 
If..Else ................................................................................................. 131 
Include ................................................................................................. 131 
Integer ................................................................................................. 131 
IsEmuHalted ........................................................................................ 132 
LapTimer ............................................................................................. 132 
LDT ..................................................................................................... 132 
Link ..................................................................................................... 133 
List ...................................................................................................... 133 
Load ..................................................................................................... 134 
LoadSize .............................................................................................. 135 
Log ...................................................................................................... 135 
Logging ............................................................................................... 136 
Map ..................................................................................................... 136 
MaxBitFieldSize .................................................................................. 137 
NameOf ............................................................................................... 137 
Overwrite ............................................................................................. 138 
PD ........................................................................................................ 138 
Pmode .................................................................................................. 138 
Print. .................................................................................................... 139 
RAMtst ................................................................................................ 139 
Register ................................................................................................ 139 
RemoveSymbols ................................................................................... 140 
Reset .................................................................................................... 140 
ResetAndGo ......................................................................................... 141 
ResetLoaders ........................................................................................ 141 
RestoreCS ............................................................................................ 141 
RestoreMap .......................................................................................... 142 
Results ................................................................................................. 142 
RunAccess ........................................................................................... 142 
SaveCS ................................................................................................ 143 
SaveMap .............................................................................................. 143 
Search .................................................................................................. 143 
SetBase ................................................................................................ 144 
SetStackAlarm ..................................................................................... 145 
SetStackArea ........................................................................................ 145 
SetStackBase ........................................................................................ 146 
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SetStackSize ......................................................................................... 146 
Signal .................................................................................................. 146 
Size ...................................................................................................... 147 
Stacklnfo .............................................................................................. 147 
StartTimer. ........................................................................................... 148 
Step ...................................................................................................... 148 
StepSrc ................................................................................................. 148 
Stop Timer ............................................................................................ 149 
String ................................................................................................... 149 
SymbolCloseFile .................................................................................. 150 
SyrnbolOpenFile ................................................................................... 150 
Test ...................................................................................................... 150 
Time .................................................................................................... 151 
Transcript ............................................................................................ 151 
TSS ...................................................................................................... 151 
Verify ................................................................................................... 151 
Version ................................................................................................ 152 
While ................................................................................................... 152 
Write .................................................................................................... 152 
Xlt ....................................................................................................... 153 
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$BREAKCAUSE 
System variable; 
shows what caused 
emulation to break. 

Related topics: 
$EMULATING, 
Cause, Go, Golnto, 
GoUntil, Halt, 
ResetAndGo, Step, 
StepSrc 

$EMULATING 
System variable; 
shows whether the 
emulator is running. 

Related topics: 
$BREAKCAUSE, 
Cause, Go, Golnto, 
GoUntil, Halt, 
ResetAndGo, Step, 
StepSrc 

$BREAKCAUSE 

Case is significant. Enter this variable in upper case. 

Knowing what caused emulation to break can be useful; for example, a 
script can single-step repeatedly until the target processor is reset. 

$BREAKCAUSE is updated when emulation breaks. Its value 
indicates the cause of the break: 

0 No cause (for example, emulation not yet started) 

1 Target processor was reset 

2 Emulator was halted 

4 Processor single step 

5 Execution breakpoint reached 

8 External break request 

9 Unknown cause 

/* Following is part of a script that stops after any execution 
breakpoint. $Z is an undeclared Shell variable that stops the 
script. */ 

go; 
while ($EMULATING){;}; /*loop until emulator halts*/ 
if ($BREAKCAUSE==5) {$Z;}; /*test for execution breakpoint*/ 

$EMULATING 

Case is significant. Enter this variable in upper case. 

Knowing whether the emulator is running can be useful, for example, 
to control script execution flow based on emulation status. 

$EMULATING has the value: 

1 The emulator is running. 

0 The emulator is halted. 

bkpt #main; 
ResetAndGo; 
while ($EMULATING){;}; 

/*stop after registers initialized */ 
/*start from the power-on level */ 

/* loop until emulator halts */ 
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$PROCESSOR 

System variable; 
identifies target 
processor. 

Related topics: 
$PROCFAMIL Y, 
$PROCTYPE, 
$SYSTEMTYPE, 
Version 

$PROCESSOR 

Case is significant. Enter this variable in upper case. 

$PROCESSOR identifies the processor in your target design as: 
V aloe Processor 

386cx Intel386 ex 
386dx Intel386 DX 

386ex Intel386 EX 

386sx Intel386 SX 

3exc Intel386 EX C-step 

486 Intel386 CX 

486dx Intel386 EX 

486sx Intel386 SX 

ns486 National Semiconductor NS486SXF 

none No processor specified 

$PROCFAMIL Y 

System variable; 
identifies target 
processor family. 

Related topics: 
$PROCESSOR, 
$PROCTYPE, 
$SYSTEMTYPE, 
Version 

$PROCTYPE 

System variable; 
identifies target 
processor type. 

Related topics: 
$PROCESSOR, 
$PROCFAMIL Y, 
$SYSTEMTYPE, 
Version 
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$PROCFAMIL Y 

Case is significant. Enter this variable in upper case. 

$PROCFAMIL Y has the value: 
Value Processors in Family 

FAMILY _X86 Intel386, Intel486, or NS486SXF 

$PROCTYPE 

Case is significant. Enter this variable in upper case. 

$PROCTYPE identifies the processor type in your target design as: 
V aloe Processors Categorized as This Type 

80386 Intel386 EX, CX, or SX 

80486 Intel486 SX or NS486SXF 
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$SHELL_STATUS 

System variable; 
shows whether the last 
shell command 
completed 
successfully. 

$SHELL_ STATUS 

Case is significant. Enter this variable in upper case. 

Knowing whether a Shell command completed successfully can be 
useful, for example, to control script execution flow based on whether 
prior commands executed correctly. 

$SHELL_STATUS has the value: 

0 The command completed normally. 

nonzero An error occurred. The $SHELL_STATUS value is the 
SLD software error code. 

bkpt #main; I* stop after registers initialized */ 
Reset; /*try to reset processor and update SLD windows*/ 
If ($SHELL_STATUS) { 

Print "Didn't Reset"; 
Reset CPUonly}; /*Reset without updating SLD windows*/ 

$SYSTEMTYPE 

System variable; 
identifies emulator and 
probe processor. 

Related topics: 
$PROCESSOR, 
$PROCFAMIL Y, 
$PROCTYPE, Version 

$SYSTEMTYPE 

Case is significant. Enter this variable in upper case. 

$SYSTEMTYPE identifies your emulator as: 
Value Emulator 

PP386cx 

PP386dx 

PP386sx 

LC386ex 

LC3exc 

LC486 

LC486dx 

LC486sx 

LCns486 

PP emulator for the Intel386 CX processor 

PP emulator for the lntel386 DX processor 

PP emulator for the Inte1386 SX processor 

SW emulator for the lntel386 EX processor 

SW emulator for the lntel386 EX C-step processor 

EA emulator for the Intel486 processor 

EA emulator for the Intel486 DX processor 

EA emulator for the Intel486 SX processor 

EA emulator for the NS486SXF processor 
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AddressOf 

Returns the numeric 
address of a module, 
function, line, or 
variable. 

Related topics: 
DisplaySymbols, 
GetBase, NameOf, 
RemoveSymbols, 
Set Base 

Alias 

Define or list an alias. 

Related Topics: 
Delete 

SW User's Manual 

AddressOf <address> 

<address> is a partly or fully qualified symbol name. 

AddressOf returns the numeric address where the symbol is loaded. 

For local variable addresses (stack offsets), use DisplaySymbols. You 
cannot use AddressOf to obtain the address of a local variable, because 
a local variable has no fixed location. 

addressof #Blank_ TxBuf; 
II 6A6 .. 6BF 

II address range of a function 

addressof #MsgRx; II address range of an array variable 
II E68 .. E87 [32] 

For function names, you can obtain the same information in the Source 
window by double-clicking on the function name to display the 
Function pop-up menu, then choosing Show Load Address. 

Alias ["<name>" ["<value>"]] 

<name> is the alias. The quotation marks are required. 

<Value> assigns a value to the specified name. The quotation 
marks are required. Inside <value>, replace double 
quotation marks with single quotation marks. 

With no arguments, Alias lists all currently defined aliases. Alias 
''<name>" displays the value of <name>. 

Use alias to shorten or change commonly used command strings. 

alias "s1" "include 's1 .inc"'; 

Alias "increment" "$a =$a+ 1; $a;" 
$a=O; 
increment; 
II Ox1 1 
increment; 
II Ox2 2 
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Append 

Appends to log file. 

Related topics: 
Log, Logging, 
Overwrite, Echo, 
Results 

Asm 
Write assembly to 
memory. 

Related topics: 
AsmAddr, Dasm, 
DasmSym 

Append 

When Append has been specified, logging adds text to the end of the 
current log, preserving the log's prior contents. 

You can also configure logging to append to a file with the Shell 
window Options menu Append To Log File item. 

Echo On; 

Results On; 

Append; 

II Commands you enter appear 
II in the Transcript pane. 

II Results of the commands appear 
II in the Transcript pane. 

II Subsequent logging will add 
II to any prior log contents. 

II Open the log file emu1 .log. Log "emu1 .log"; 

Logging On; II Start writing log information. The emulator 
II immediately puts the time and date in the log file. 

II... II Your emulation activities ... 

Logging Off; II Stop writing log information. The emulator 
II immediately puts the time and date in the log file. 

Asm <string> 

<String> is an assembly language statement. 

Asm checks the syntax of <String> and writes the instruction bytes to 
memory at the current assembly address. (Determine the current 
assembly address with AsmAddr.) 

Symbolic assembly is not supported. 

Asm nop; 
N 000000 4E71 nop 
II Number of bytes: 2 

You can also assemble new instructions and data into memory with the 
Single-Line Assembler dialog box. 
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AsmAddr 

Set the address where AsmAddr [<mode>) [<address>) [<space>] 
the Asm command will 
write. 

Related topics: 
Asm, Dasm, 
DasmSym, Pmode 

Bkpt 

Display, set, or modify 
breakpoints. 

Related topics: 
BkptClear, DR 

SID User's Manual 

<mode> specifies the addressing mode: 

Auto derives the addressing mode based on Pmode. 

Use16 

Use32 

uses 16-bit operands and addresses. 

uses 32-bit operands and addresses. 

<address> is a numeric or symbolic address of the location where the 
next Asm command will write. 

<Space> specifies the emulator address space as: 

• user, smm, or io for 386 EX emulators 

• user or smm for 386 ex and Intel486 SLE 
emulators 

• user or io for NS486 emulators 

• user for 386 SX and Intel486 non-SLE emulators 

With no arguments, AsmAddr displays the current assembly address in 
the current addressing mode. 

AsmAddr 2000; 
II Asm address offset: 2000 

Bkpt [enable I disable] [temporary I permanent] [<address>] 
[@<ID>] [<space>] 

enable 

disable 

with @<ID> specified, enables the breakpoint; otherwise 
enables all breakpoints. 

with @<ID> specified, disables the breakpoint; otherwise 
disables all breakpoints. 

temporary removes the breakpoint when the breakpoint halts 
emulation. 

permanent retains the breakpoint when the breakpoint halts 
emulation. To remove the breakpoint, explicitly delete it. 

<address> a numeric or symbolic address. When this address is 
accessed, the breakpoint (if enabled) halts execution. 

<ID> is an integer from 0 to 65534 uniquely identifying the 
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BkptClear 

breakpoint. Either you or the emulator assigns an ID 
when a breakpoint is defined. Specifying an existing ID 
modifies the identified breakpoint. The at (@) is 
required. 

<Space> for 386 EX, 386 CX, or Intel486 SLE emulators specifies 
smm or user (the default) address space. 

With no arguments, Bkpt displays all current breakpoints. Source 
information is also displayed when a match exists with the symbol 
table. 

bkpt disable @ 12 /*disable the breakpoint with ID 12 */ 

You can also set breakpoints using the Source window mouse or 
Breakpoints menu, or the Breakpoint window Set button or 
Breakpoints menu. 

Removebreakpoints. BkptClear @<ID> I <address> [<space>] I all 

Related topics: 
Bkpt, DR 

BusRetry 

Assert bus error after 
timeout. 

<ID> removes the breakpoint with the specified ID number. The 
at (@) is required. 

<address> removes the breakpoint at the specified code address. 

<space> for 386 EX, 386 CX, or Intel486 SLE emulators specifies 
smm or user (the default) address space. 

all removes all temporary and permanent breakpoints. 

Use BkptClear to remove a specified breakpoint or all temporary and 
permanent breakpoints. 

BkptClear @ 1 ; 

BkptClear all; 

/*remove breakpoint with id 1 */ 

/*remove all breakpoints*/ 

You can also clear breakpoints with the Source window mouse or 
Breakpoints menu, or the Breakpoint window Clear button or 
Breakpoints menu. 

BusRetry [on I off] 

on tum retry on. 

off tum retry off. 

With no arguments, BusRetry displays its current setting. 
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Cause 

Display the cause of 
the last break in 
emulation. 

Related topics: 
$BREAKCAUSE 

Clear 

Clear the Shell 
window Transcript 
pane. 

Config 

Define lnte/386 EX 
HLDA pin function. 

SLD User's Manual 

Disable retry when contention exists with another driver or when a slow 
device takes longer than the timeout. 

Cause 

Use this command when emulation is halted to discover the reason for the 
most recent halt. Possible Cause responses are: 

• No cause is recorded. 

• The target processor was reset. 

• You entered a Halt command. 

• The emulator completed a Step. 

• Emulation encountered an execution breakpoint. 

• The emulator received an external break request. 

• The cause is unknown. 

The break cause also appears in the Status window. 

Clear 

Use Clear to remove all text from the Shell window Transcript pane. 
The Shell window View menu Clear Transcript item does the same. 

Config ignoreHLDA [on I off] 

on causes the emulator to ignore the HLDA pin state. Set config 
ignoreHlda on when HLDA is programmed as an 1/0 bit. 

off (default) causes the emulator to examine the HLDA pin state before 
generating overlay RAM or trace/trigger strobe. 

With no arguments, Config displays its current setting. 

On the 386 EX, you can program the HLDA pin to function either as 
HLDA function or as an 1/0 bit. The emulator hardware must know 
when the bus has been granted to an external master so that overlay RAM 
cycles are disabled to prevent corruption. If the HLDA pin is visible, the 
emulator disables overlay RAM cycles. Otherwise, the emulator assumes 
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no external masters exist. 

When using the Intel Evaluation Board, which programs the HLDA pin 
to be an 1/0 bit, set config ignoreHlda on. 

ConfigSymbols 

Update symbol 
base address from 
the x86 descriptor 
table. 

Copy 

Copy one region of 
target or overlay 
memory to another. 

Related topics: 
Dump, Fill, 
RunAccess, 
Search, Size, 
Verify, Write 

ConfigSymbols [<base>] 

<base> is the base name for the group of symbols to be updated. 

With no arguments, ConfigSymbols reconfigures all symbols in your 
program. 

This command updates the specified symbols with the base address 
obtained from the descriptor table (either GDT or LDT). To get the 
correct symbol base, the target program must set up the correct values of 
GDTR and LDTR and the contents of those tables. 

You can also update the symbol base address with the Toolbar Configure 
menu Configure Symbols item. 

Copy <start> (<end> I Length <len>) [<space>] [Target] 
To (<dest> I Target I <dest> Target) [<space>] 

<Start> specifies the starting address of the region to be copied. 

<end> specifies the ending address of the region to be copied. 

<len> specifies the number of bytes to be copied. The Length 
keyword is required. 

<Space> specifies user (the default) or: 

Target 

<dest> 

smm for 386 EX, 386 CX, or Intel486 SLE emulators 

io for NS486 emulators 

overrides any overlay mapping to use target memory as the 
source or destination. 

Specifies the starting address that will be copied into. The 
To keyword is required. 

Because reading and writing memory takes a small amount of processor 
time, memory access is initially disabled during emulation. Use 
RunAccess to enable Copy during emulation; however, such access can 
degrade your program execution. 

/*Copy 64 KB from address OxO to overlay at the same address:*/ 
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Dasm 

Disassemble 
memory. 

Related Topics: 
AsmAddr 
DasmSym 

DasmSym 

Control symbolic 
disassembly in the 
Shell window. 

Related topics: 
AsmAddr, Dasm 

SID User's Manual 

map O 10000; 
copy O length 1000 target to O; 

/* Copy from overlay to target: *I 
copy O length 1000 to O target; 

/* Copy from overlay to overlay: *I 
copy 1 000 length 1000 to 4000; 

/*Use symbolic addresses:*/ 
copy #func1 #func2 to #ram_area target; 

You can also copy memory with the Memory window Edit menu Copy 
Memory item. 

Dasm [<mode>] [<start> [<end>] [<space>]] 

<mode> Specifies the addressing mode: 

Auto derives the addressing mode based on the pmode. 

Use16 uses 16-bit operands and addresses. 

Use32 uses 32-bit operands and addresses. 

<Start> is the first address of the region to disassemble. 

<end> is the last address of the region to disassemble. 

<space> for 386 EX, 386 CX, or lntel486 SLE emulators specifies 
smm or user (the default) address space. 

With no arguments, 10 instructions are disassembled beginning at the 
current assembly address. (To find the current assembly address, use 
AsmAddr.) When only <Start> is specified, 10 instructions starting at 
<Start> are disassembled. 

You can also view disassembled memory with the Memory window View 
menu Disassembly item, or interleaved in your source text with the 
Source window View menu Mixed Source And Asm item. 

DasmSym [ on I off ] 

on (default) turns on symbolic disassembly. 

off turns off symbolic disassembly. 

With no arguments, DasmSym displays the current setting. 

Symbolic disassembly displays symbols in the disassembly shown in the 
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Delete 

Delete a Shell 
variable or alias 

Related Topics: 
Alias 

Memory window in Disassembly view, the Source window Mixed Source 
And Asm view, and the Trace window Instruction view. 

You can also toggle symbolic disassembly with the Toolbar Configure 
menu Symbolic Disassembly item. 

Delete (Alias "<name>" I <variable> I Link "<filename>") 

<name> is the alias to be deleted. The Alias keyword and the 
quotation marks are required. 

<filename> identifies a file link to be deleted. The Link keyword and 
the quotation marks are required. 

<Variable> is the Shell variable to be deleted. 

$a= $b = O; 

list; 
II $a= O 
II $b = 0 

Delete $a 

list 
II $b = 0 

Alias "a" "$a;" ; 

Alias; 
II a: "$a;" 

Delete Alias "a"; 

Alias; 

DisableAlarmlimit 

Disable the warning 
message for 
excessive stack 
usage. 

Related topics: 
DisableHighWater-

Mark, 
DisplayStack, 
EnableAlarmLimit, 
EnableHighWater-

Mark, 
FillStackPattern, 

DisableAlarmlimit 

You can set an alarm (using EnableAlarmLimit) to notify you when 
stack usage exceeds a specified percentage of the stack. 
DisableAlarmlimit turns off this alarm. 

You can also disable the alarm by un-checking the Stack window 
Options menu Enable Alarm Limit item. 
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Se!StackAlarm,, 
Se!StackArea, 
SetStackBase, 
SetStackSize, 
Stack Info 

DisableHighWaterMark 

Disable keeping 
track of the stack 
maximum usage. 

Related topics: 
DisableAlarmLimit, 
DisplayStack, 
EnableAlarmLimit, 
EnableHighWater-

Mark, 
FillStackPattern, 
Se!StackAlarm, 
SetStackArea, 
SetStackBase, 
SetStackSize, 
Stacklnfo 

DisableHighWaterMark 

You can set an indicator in the Stack window to keep track of the stack 
high-water mark (the maximum stack usage). DisableHighWaterMark 
turns off this indicator. 

You can also disable the high-water mark by on-checking the Stack 
window Options menu Enable High-Water Mark item. 

DisplayStack 

Display the stack 
frames. 

Related topics: 
DisableAlarmLimit, 
DisableHighWater-

Mark, 
EnableAlarmLimit, 
EnableHighWater-

Mark, 
FillStackPattern, 
SetStackAlarm, 
SetStackBase, 
Se!StackSize, 
Stacklnfo, 
Se!StackArea 
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DisplayStack [locals I hex] 

locals 

hex 

includes symbols for automatic variables. 

displays the stack in hexadecimal radix, 16 bytes per line. 

When you specify no arguments, the display defaults to: 

• addresses when no symbolic information is available 

• addresses and function names when symbolic information is 
available 

You can also view the stack frames, with stack and return addresses, 
arguments, and local variables, in the Stack window. 
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DisplaySymbols 

Display all symbols 
or display one of the 
following: modules, 
functions, public 
symbols, or lines. 

Related topics: 
AddressOf, 
GetBase, NameOf, 
RemoveSymbols, 
Set Base 

DisplaySymbols [modules I functions I publics I lines I sorted I 
#<module>] 

modules lists module names only. 

functions lists modules, global variables, functions, and blocks. 

publics lists all printable symbols including publics (code labels 
and variables defined publicly across modules). For 
example, libraries normally contain no local symbols but 
accessible global variables in libraries appear as public 
symbols. 

lines follows each module by the line numbers loaded for that 
module. With each line number is listed the line's ending 
column and start address. 

sorted sorts the module list alphanumerically. 

<module> lists all symbols for the specified module. The hash mark 
(#) is required. 

With no arguments, DisplaySymbols displays modules, global 
variables, functions, and local variables, but not publics nor individual 
line numbers. 

If you have previously issued a SymbolOpenFile command, the 
DisplaySymbols output is directed to the symbol file. 

The output is displayed in four columns: 

• The symbol scope (MODULE, VARIABLE, FUNCTION, BLOCK, 
PUBLIC VAR, PUBLIC LABEL) appears in the first column. 
Each line is indented to show the level or scope of the symbol in the 
symbol hierarchy. Modules and publics are at the root level. 
Functions defined in a module are indented one level. Variables 
local to a function are indented under that function. Blocks are 
treated as unnamed functions and indented for each nesting level. 

• The symbol name appears in the second column. 

• The symbol type appears in the third column: the variable type; the 
function return type; the module source line number range; or the 
register description for a local register variable or argument. 

• The symbol address appears in the fourth column. For static (fixed 
address) symbols, the address range in bytes appears followed by the 
decimal size of the range in square brackets ([<size>]). Local stack 
variable addresses are signed offsets from the stack frame pointer. 
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DR 

Control debug 
register use. 

SW User's Manual 

DR [<num> Bkpt I User I [Data <mode> <address> <size> 
[Exact]]] 

<num> identifies the debug register as 0, 1, 2, or 3. 

Bkpt makes the register available for execution breakpoints. 

User reserves the register for use by your program. The 
emulator avoids using this register for execution 
breakpoints and modifies DR7, allowing user access to any 
debug register. 

Data configures the register as a data read/write breakpoint. 

<mode> is one of: 

x sets the register to instruction execution mode. 
Emulation breaks on execution of the instruction 
starting at <address>. 

w sets the register to data write mode. Emulation breaks 
on a write to <address> in user space. 

rw sets the register to data read/write mode. Emulation 
breaks on a read or write to <address> in user space. 

<address> specifies the virtual or linear base address of the 
breakpoint. 

<size> 

Exact 

specifies 1, 2, or 4 bytes starting with <address> as the 
address range of the data breakpoint. Emulation breaks on 
any data access completely or partly overlapping this range. 

ensures the processor waits after each instruction for all 
data cycles to complete. (Such waiting can degrade your 
program's performance.) A data breakpoint occurs 
immediately after the instruction that caused the breakpoint 
data cycle. (Execution breakpoints always occur exactly.) 
With exact not specified, several instructions can execute 
beyond the one that caused the breakpoint data cycle. 

With no arguments, DR lists the debug register configurations. 

When you set a breakpoint in the Source or Breakpoint window or with 
the Bkpt command, the emulator implements the breakpoint as either a 
DR or a software interrupt and as an execution or a data breakpoint. 
SLD installation configures DR[0 .. 3] for execution breakpoints selected 
by the emulator and disables program access to DR7. To change this 
configuration, use DR to: 

• Assign a specific execution or data breakpoint to each DR. A total 
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DT 
Display descriptor 
tables. 

Related topics: 
GOT, IDT, LDT, 
PD,TSS 

of four DR breakpoints can be concurrently defined, whether 
specified by you or by the emulator. 

• Reserve each DR for program use, preventing the emulator from 
implementing a breakpoint in that register. Such reservation also 
enables undetected program access to system registers and DR7. 
Program changes to DR7 can cause unpredictable emulator 
behavior. 

dr O user; /* Reserve drO for the target system. */ 

dr 1 bkpt; /*Allow dr1 to be used as an execution breakpoint.*/ 

dr 2; I* Show the current configuration of dr2. */ 

dr 3 data w 400L dword; I* Define a double-word data write*/ 
I* breakpoint at linear address 400. */ 

DT ( <selector> I <range> I <register> I Base <address> (<range> 
I Limit <bytes>) ) [All] 

<selector> specifies a selector. 

<range> specifies the first and last of a range of selectors. 

<register> is any CPU mnemonic specifying a register containing a 
selector in the first 16 bits. 

<address> specifies the descriptor table base address. The Base 
keyword is required. 

<bytes> 

All 

specifies a range of selectors as a number of bytes. The 
Limit keyword is required. 

displays all entries, including invalid or reserved. 

The descriptor table displayed for each selector is specified by the 
selector's bit 2 (Tl). 

dt Ox08 Ox48 all; 

dt ds; 

I* displays all entries*/ 
/* from selector Ox08 to Ox48 *I 

I* displays the current ds descriptor entry*/ 
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Dump 

Dump memory 
contents to the 
screen, formatted. 

Related topics: 
Copy, Fill, 
RunAccess, 
Search, Size, 
Verify, Write 
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Dump [Loop] <addr1> [<addr2>] [Byte I Word I Long I Dword] 
[<space>) 

<addr1 > specifies the first address to be displayed. The address can 
be symbolic or numeric. 

<addr2> specifies the last address to be displayed. Omitting 
<addr2> displays 16 bytes. The address can be symbolic 
or numeric. 

Byte displays byte values. 

Word displays word values. 

Long displays double word values. 

Dword is the same as Long. 

<Space> specifies the address space as: 

• user, smm, or io for 386 EX emulators 

• user or smm for 386 CX and Intel486 SLE emulators 

• user or io for NS486 emulators 

• user for 386 SX and Intel486 non-SLE emulators 

Loop repeatedly preforms the operation but prints no output to 
the screen, even if errors occur. 

The physical read uses the Size command settings rather than the 
format size set by Dump. For example, if Size=Byte when a Dump 
command specifies Word, the emulator reads a set of byte-sized values 
and reformats them to display as word-sized values. 

Because reading and writing memory takes a small amount of processor 
time, memory access is initially disabled during emulation. Use 
RunAccess to enable Dump during emulation; however, such access 
can degrade your program execution. 

You can also view memory contents in up to 20 simultaneously active 
Memory windows as hexadecimal or decimal bytes, words, or dwords 
with equivalent ASCII characters; or as disassembled instructions. 
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Echo 

Display or toggle 
command echo. 

Echo [on I off] 

on starts displaying entered Shell commands in the Transcript pane. 
Related topics: 
Append, Echo, Log, off stops displaying entered Shell commands in the Transcript pane. 

Logging, Overwrite, With no argument, Echo displays its current setting. 
Results 

EmuStatus 

Report the current 
emulation status. 

Related topics: 
$EMULATING, 
lsEmuHalted 

You can also toggle echoing with the View menu Echo item. 

EmuStatus 

Use EmuStatus after lsEmuHalted returns no result. 

isemuhalted; 

emustatus; 
II Processor is running. 

halt; 
II 961 C60 0000 0000 ORl.B 

isemuhalted; 
II The emulator is halted. 

#00,DO 

The emulation status (halted or running) is also reported by the Status 
window or icon title and by the $EMULATING system variable. 

EnableAlarmlimit 

Enable a stack 
alarm limit. 

Related topics: 
DisableAlarmlimit, 
DisableHighWater-

Mark, 
DisplayStack, 
EnableHighWater-

Mark, 
FillStackPattern, 
SetStackAlarm, 
SetStackArea, 
SetStackBase, 
SetStackSize, 
Stacklnfo 

EnableAlarmLimit 

If, when emulation halts, the stack usage is exceeding the alarm limit set 
by SetStackAlarm, you are notified. 

You can also enable the alarm limit by checking the Stack window 
Options menu Enable Alarm Limit item. 
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EnableHighWaterMark 

Track maximum 
stack usage. 

Related topics: 
DisableAlarmLimit, 
DisableHighWater-

Mark, 
DisplayStack, 
EnableAlarmLimit, 
FillStackPattern, 
SetStackAlarm, 
SetStackArea, 
SetStackBase, 
SetStackSize, 
Stacklnfo 

EnableHighWaterMark 

This command enables an arrow on the Stack window stack meter to 
show the maximum stack area usage. The arrow moves when the stack 
grows to an address beyond any previously used. The arrow position is 
the stack high-water mark. 

You can also enable the high-water mark by checking the Stack window 
Options menu Enable High-Water Mark item. 

Event Restore 

Retrieve saved 
event definitions. 

Related topics: 
EventSave 

EventSave 

Save Events to a 
file. 

Related topics: 
EventRestore 

Exit 

EventRestore "<filename>" 

<filename> specifies a file containing event definitions. The quotation 
marks are required. 

Events read from the file are added to the set of current events. Events 
from the file overwrite current events with the same name. 

You can also restore events from a file with the Event window File 
menu Restore Events item. 

EventSave "<filename>" 

<filename> specifies the file in which to store current event definitions. 
The quotation marks are required. 

You can also save events to a file with the Event window File menu 
Save Events item. 

Exit the Shell exit 
window. 
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This command closes the Shell window. To exit the emulator, open the 
Toolbar File menu and choose Exit. You can also close the Shell 
window with the Shell window File menu Exit item. 
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Fill 

Fill memory with 
data. 

Related topics: 
Copy, Dump, 
RunAccess, 
Search, Size, 
Verify, Write 

Fill <addr1 > <addr2> <data> [Byte I Word I Long I Dword] 
[<space>] 

<addr1 > is the first address in the region to be filled. Addresses can 
be symbolic or numeric. 

<addr2> is the last address in the region to be filled. 

<data> is up to 256 bytes of data to be written. The value is 
repeated as needed to fill the region. 

Byte 

Word 

Long 

Dword 

<space> 

specifies the data is a byte value. 

specifies the data. is a word value. 

specifies the data is a double word value. 

is the same as Long. 

specifies the emulator address space as: 

• user, smm, or io for 386 EX emulators 

• user or smm for 386 CX and Intel486 SLE emulators 

• user or io for NS486 emulators 

• user for 386 SX and Intel486 non-SLE emulators 

The physical write uses the Size command settings rather than the 
format size specified in the Fill command. For example, if Size=Byte, 
Fill uses byte-sized memory accesses. 

Because reading and writing memory takes a small amount of processor 
time, memory access is initially disabled during emulation. Use 
RunAccess to enable Fill during emulation; however, such access can 
degrade your program execution. 

Fill 0 1234 OxO dword; /*Fills memory from 0 to 64K with OxO */ 
II Fill successful. 

You can also fill memory with the Memory window Edit menu Fill 
Memory item. 

Fi I IStackPattern 

Initialize the stack. 

Related topics: 
DisableAlarmlimit, 
DisableHighWater-

Mark, 

FillStackPattern 

With FillStackPattern, you can initialize the stack with a pattern to 
enable the stack usage statistics. 

Other commands can also initialize the stack: 
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DisplayStack, 
EnableAlarmLimit, 
EnableHighWater-

Mark, 
SetStackAlarm, 
SetStackArea, 
SetStackBase, 
SetStackSize, 
Stacklnfo 

Flush 

Flush the lnte/486 
cache. 

GOT 

• If you specify the stack base and size with FillStackArea, you can 
also initialize the stack in the single FillStackArea command. 

• Enabling the high-water mark (the EnableHighWaterMark 
command) automatically fills the stack with the pattern. 

Flush 

/*Disable cache so all code and data fetches appear on the bus*/ 
Signal KEN disable /*Disable KEN#*/ 
Flush I* Flush the cache*/ 

Displaythegtobal GDT (<selector> I <range> I <register>) [Base <address> 
descriptor table. [Limit <bytes>)] [All] 

Related topics: <Selector> specifies a selector. 
DT, IDT, LDT, PD, 
TSS <range> specifies the first and last of a range of selectors. 
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<register> is any CPU mnemonic specifying a register containing a 
selector in the first 16 bits. 

<address> specifies the descriptor table base address. The Base 
keyword is required. 

<bytes> specifies a range of selectors as a number of bytes. The 
Limit keyword is required. 

All displays all entries, including invalid or reserved. 

With no arguments, GOT shows all valid entries in the range gdt_base 
to gdt_base+gdUimit. 

GDT displays the global descriptor table entries for a selector or range 
of selectors. The selectors displayed are determined by <Selector>, 
<register>, Base <address> with either <range> or Limit <bytes>, 
or the current gdt_base and gdUimit. 

gdt OxOO Ox18 base 501010L; /*Display GDT entries*/ 
/*from 501018L (selector Ox08) to 501028L */ 

/*(selector Ox18). The table base is 501010L. */ 

127 Shell Window Reference 



Get Base 

Get one or all base 
names and their 
address offsets. 

Related topics: 
AddressOf, 
DisplaySymbols, 
NameOf, 
RemoveSymbols, 
Set Base 

Go 

Start emulation. 

Related topics: 
$BREAKCAUSE, 
$EMULATING, 
Cause, Golnto, 
GoUntil, Halt, 
ResetAndGo, Step, 
StepSrc 

Golnto 

Emulate to a 
stepped-into or 
returned-into 
function. 

Related topics: 
$BREAKCAUSE 
System Variable, 
$EMULATING 
System Variable, 
Cause, Go, GoUntil, 
Halt, ResetAndGo, 
Step, StepSrc 

GetBase [<basename>] 

<basename> displays only the specified base. 

With no arguments, all bases loaded into the symbol table are displayed 
along with their offset values. 

Compilers and linkers place symbols into groups called bases, assigning 
names to the groups. GetBase displays these symbol bases. 

Go 

This command is equivalent to any of the following: 

• Choose the Toolbar or Source window Go button. 

• Choose the Source window Run menu Go item. 

• Press the <F9> key. 

Golnto [ Call I Return ] [ Line I Statement ] 

Call If a call is executed within the current function, emulation 
continues through the call and into the called function, 
halting on the beginning of a line or statement. This line 
or statement can be the first instruction of the function or 
later, depending on how the compiler generates code and 
line-number start addresses. 

Return If a return is executed within the current function, 
emulation continues through the return, halting on the 
beginning of the next line or statement of the function 
returned to. 

Line breaks on a source line. 

Statement breaks on a source statement. 

With no arguments specified, the first Golnto you use defaults to 
Go Into Call Statement. If you have previously used Go Into with 
arguments, any Golnto without arguments defaults to the arguments 
you used before. 
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GoUntil 

Emulate until a call 
or return. 

Related topics: 
$BREAKCAUSE 
System Variable, 
$EMULATING 
System Variable, 
Cause, Go, Golnto, 
Halt, ResetAndGo, 
Step, StepSrc 

Halt 

You can also do these Go variations with the Source window buttons 
(configured by the Source window Options menu Set Go Buttons item) 
and from the Source window Run menu. 

GoUntil [Call I Return] [Line I Statement] 

Call within the current function, emulates until a call or return 
is executed. 

Return within the current function, emulates until a return 
instruction is executed. 

Line breaks on a source line. 

Statement breaks on a source statement. 

With no arguments, the first GoUntil you use defaults to GoUntil Call 
Statement. If you have previously used GoUntil with arguments, any 
GoUntil without arguments defaults to the arguments you used before. 

GoUntil emulates until a call or return is executed, then stops. 

Because of how Call and Return work, the assembly instructions 
immediately before the call or return are not necessarily executed. 

You can also do these Go variations with the Source window buttons 
(configured by the Source window Options menu Set Go Buttons item) 
and from the Source window Run menu. 

Halt emulation. Halt 

Help 

Show Shell 
command syntax. 
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Halt stops emulation when the current instruction finishes executing. 
This command is equivalent to any of the following: 

• Choose the Toolbar or Source window Halt button. 

• Choose the Source window Run menu Halt item. 

• Press the <F2> key. 

Help [ <Command> ] 

<command> is a Shell window command name. 
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History 

Control number of 
saved commands. 

IDT 

Display the interrupt 
descriptor table. 

Use Help to list, in the Transcript pane, the command syntax for one or 
more Shell window commands. With no argument, Help lists all 
commands alphabetically. 

You can also pop-up on-line help from any SLD window Help menu or 
by pressing the <Fl> key. 

History [ <Size> ] 

<size> specifies the number of commands (0 to 50) to save in the 
Shell command history buffer. 

With no arguments, History reports the current history buffer size. 

Press <Ctrl><Up Arrow> or <Ctrl><Down Arrow> to recall commands 
sequentially from the history buffer to the Command Entry pane. You 
can edit recalled lines before entering them. 

You can also set the history size with the Shell window Options menu 
History Size item. 

IDT (<index> I <range> I <register>) [Base <address> [Limit 
<bytes>]] [All] 

Related topics: <index> specifies an index. 
DT, GDT, LDT, PD, 
TSS <range> specifies the first and last of a range of selectors. 

<register> is any CPU mnemonic specifying a register containing a 
selector in the first 16 bits .. 

<address> specifies the descriptor table base address. The Base 
keyword is required. 

<bytes> 

All 

specifies a range of indexes as a number of bytes. The 
Limit keyword is required. 

displays all entries, including invalid or reserved. 

With no arguments, IDT shows all valid entries in the range idt_base to 
idt_base+idt_limit. 

IDT displays the interrupt descriptor table entries for an index or range 
of indexes. The selectors displayed are determined by <index>, 
<register>, Base <address> with either <range> or Limit <bytes>, 
or the current idt_base and idt_limit. 
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lf..Else 

idt OxOO Ox18 base 50101 OL I* Display IDT entries *I 
I* from 501018L (selector Ox08) to 501028L *I 

I* (selector Ox18). The table base is 50101 OL. *I 

Conditionally If (<condition>) {<block>} [Else {<block2>}] 
execute Shell 
window commands. <Condition> evaluates to nonzero or zero. The parentheses are required. 

Include 

Read commands 
from a file. 

Integer 

<block1 > is a list of Shell commands, delimited with semicolons, to 
be executed when <condition> evaluates to nonzero. The 
braces are required. 

<block2> is a list of Shell commands, delimited with semicolons, to 
be executed when <Condition> evaluates to zero. The 
braces and Else keyword are required. 

$a=O; 
If ($a) { 

"true"; 
} 
else { 

"false"; 
}; 
II false 

include "<filename>" 

<filename> identifies a file containing Shell commands (a script). The 
quotation marks are required. 

The commands are executed as if entered in the Command Entry pane. 
You can put an Include command in a script. 

include "d:\shell.cmd"; /* executes d:\shell.cmd *I 

You can also run a script with the Shell window File menu Include item. 

Identifies an integer. Integer (<variable>) 

Related topics: <Variable> is a Shell variable name. The parentheses are required. 
String 
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Use Integer to discover whether a variable value is an integer. Integer 
returns 1 if <variable> is an integer and 0 otherwise. 

$a=O; 
lnteger($a); 
111 1 

If (integer($a)) { "it is an integer"; } 
II it is an integer 

lsEmuHalted 

Discover whether 
emulator is halted. 

Related topics: 
EmuStatus, 
$EMULATING 

Lap Timer 

Takes a snapshot of 
the timer. 

Related topics: 
Start Timer, 
Stop Timer 

LDT 

Displays the local 
descriptor table. 

Related topics: 
DT, GOT, IDT, PD, 
TSS 

lsEmuHalted 

Use lsEmuHalted to discover whether the emulator is halted. No 
response indicates the emulator is not halted. If you get no response, 
also use EmuStatus or $EMULATING. 

isemuhalted; 

halt; 
II 961 C60 0000 0000 

isemuhalted; 
II The emulator is halted. 

ORl.B #00,DO 

The emulation status (halted or running) is also reported by the Status 
window or icon title and the $EMULATING system variable. 

Lap Timer 

Without stopping the timer, shows the number of milliseconds elapsed 
since the timer was started. 

Lap Timer; 
while {laptimer < 5000) {}; 

LDT (<selector> I <range> I <register>) [Base <address> [Limit 
<bytes>]] [All] 

<selector> specifies the selector from the GDT to identify the LDT 
base and limit. 
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Link 

<range> specifies the first and last of a range of selectors. 

<register> is any CPU mnemonic specifying a register containing a 
selector in the first 16 bits. 

<address> specifies the descriptor table base address. The Base 
keyword is required. 

<bytes> specifies a range of selectors as a number of bytes. The 
Limit keyword is required. 

All displays all entries, including invalid or reserved. 

With no arguments, LDT shows all valid entries in the range ldt_base 
to ldt_base+ldt_limit. 

LDT displays the interrupt descriptor table entries for a selector or range 
of selectors. The selectors displayed are determined by <Selector>, 
<register>, Base <address> with either <range> or Limit <bytes>, 
or the current ldt_base and ldt_limit. 

ldt OxOO Ox18 base 501010L; /*Displays LDT entries*/ 
I* from 501018L (selector Ox08) to 501028L */ 

/* (selector Ox18). The table base is 50101 OL. */ 

Establish source file Link ( <file1> ( <file2> ] ] 
links 

List 

List Shell variable 
values. 
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<file1 > 

<file2> 

is a filename that has or needs a link. 

is the filename to be linked to <file1 >. Omitting <file2> 
displays the link already defined for <file1 >. 

With no arguments, Link displays all file links. 

If the Source window fails to find <file1 >,it searches for <file2>. 

Link util.c util0215.c 

List ( <variable> ] 

II Use util0215.c wherever util.c 
II is specified for source display. 

<variable> is a Shell variable name. 

With no arguments, List displays all the Shell variables and their values. 

List; 
II (system) $SHELL_STATUS = 262158 
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Load 

Load code and 
symbols to mapped 
or target memory. 

Related topics: 
LoadSize 

Load "<filename>" [User I SMM] [[No]Code] [[No]Symbols] 
[[No]Demand] [[No]Demangle] [[No]UpdateBase] 
[Module <name>] [Reload] [[No]LoadRegister] [[No]Warn] 
[[No ]Status] 

<filename> 

User 

SMM 

is the pathname of the file to be loaded. The 
quotation marks are required. 

loads code into user memory. 

for 386 EX, 386 CX, or Intel486 SLE emulators, 
loads code into system management mode memory. 

[No]Code loads or does not load code. 

[No]Symbols loads or does not load symbols. 

[No]Demand initially loads only global symbols (variables, 
module names, global function names, type 
definitions) and defers loading local symbolic 
information (local variables and line numbers) until 
needed or initially loads all symbols. 

[No]Demangle demangles or does not demangle C++ names. 

[No]UpdateBase updates symbol bases or does not update symbol 
bases, for OMF386 loadfiles on x86 emulators. Use 
updatebase in conjunction with loadregister. 

<name> after on-demand loading, loads symbols for the 
specified module Use this option in a script for 
debugging specific modules. Load symbols with this 
option to eliminate any delay on viewing a module. 
The Module keyword is required. 

Reload purges old symbols and loads new ones. 

[No]LoadRegister loads or does not load initial register values from 
OMF386 loadfiles. 

[No]Warn displays or does not display warnings from the 
loader. 

[No]Status displays or does not display load statistics. 

With only <filename> specified, the default is Load "<filename>" 
User Code Symbols Demand NoDemangle NoUpdateBase 
NoLoadRegister NoWarn Status; 

You can load code and symbols during emulation. A void loading into 
an area of memory occupied by the executing code. Loading into 
memory that is being executed can stop the emulator in an unpredictable 
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Load Size 

Set the memory 
write-access size 
for the load 
command. 

Related topics: 
Load, Size 

Log 

Display or set the 
name of the log file. 

Related topics: 
Logging, Append, 
Overwrite, Echo, 
Results 
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state. 

Load demo.omf; 
II 1986 bytes code loaded. 
II 2 module(s) loaded. 
II Load complete. 

Load demo.omf module dm_main; I* load code and symbols */ 

load demo.abs nocode; 

Load demo.abs nosym; 

load demo.abs nodemand; 

/*from a module*/ 

/* load symbols only, on demand*/ 

/* load code only */ 

/*load all code; load*/ 
/*symbols on demand*/ 

load sample.abs reload nowarn; /*load code and symbols;*/ 
/* display no warnings*/ 

You can also load files with the Toolbar Load button or from the Source 
window File menu. 

LoadSize [ Byte I Word I Long I Dword ] 

Byte writes memory by bytes. 

writes memory by words. Word 

Long (default) writes memory by longs. Writing in Long is the 
fastest way to load code. 

Dword is the same as Long. 

Log ["<filename>"] 

<filename> is the name of the logfile to be opened or created. The 
quotation marks are required. 

With no arguments, Log displays the current log filename. 

Logfile "c:\shell.log"; 
Log; 
II log file name: c:\shell.log 

You can also open a log file with the Options menu Log File Name item. 
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Logging 

Display or toggle the 
logging setting. 

Related topics: 
Log, Append, 
Overwrite, Echo, 
Results 

Map 

Substitutes overlay 
memory for all or 
part of the target 
system memory. 

Related topics: 
Map Ranges, 
RestoreMap, 
Save Map 

Logging [ on I off ] 

on starts echoing commands and results to the logfile. 

off stops echoing commands and results to the logfile. 

With no arguments, Logging reports whether logging is on. 

In overwrite mode, each time you tum-on logging for a given logfile 
destroys prior information in that file. To preserve prior information, 
enter Append before Logging on. 

You can also toggle logging with the Options menu Log Results item. 

Map [Clear I <base> [<end>] [Target] [<access>]] [<space>] 

Clear 

<base> 

clears all map blocks. 

is the address to start a memory region. The address is 
rounded down to the nearest boundary block equal to the 
amount of memory mapped: 

• For PP-386 and SW-386 emulators, you can map any 
multiple of 4K bytes starting on any 4K address. 

• For EA-486 emulators, you can map any multiple of 
128K bytes starting on any 128K address. 

• For EA-NS 486 emulators, you can map any multiple 
of 64K bytes starting on any 64K address. 

<end> is the last address of the region. This address is rounded 
up to the top of the region containing the end address, as 
described for the <base> argument above. 

Target maps the memory region to target memory. 

<access> specifies access permissions. Your emulator offers some or 
all of the following ways to control and report your 
program's memory accesses: 

RAM allows read and write access (the default). 

ROM allows read access; prevents write access; does 
not break on attempted write access. (Intelx86 
emulators allow writes to target memory.) 

ROMbrk allows read access; prevents write access; breaks 
on attempted write access. (Intelx86 emulators 
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None 

allow writes to target memory but such writes 
break emulation.) This option is unavailable on 
NS486 emulators. 

prevents any access; breaks on attempted access. 
(Intelx86 emulators allow access to target 
memory but such access breaks emulation.) This 
option is unavailable on NS486 emulators. 

<Space> specifies the emulator address space as: 

• user, smm, or io for 386 EX emulators 

• user or smm for 386 CX and Intel486 SLE emulators 

• user or io for NS486 emulators 

• user for 386 SX and Intel486 non-SLE emulators 

With no arguments, Map displays the current map settings. 

map 0 ram; 
II Mapped block starting at address 00000000 to OOOOFFFF RAM 

You can also map memory with the Toolbar Map button. 

MaxB itFieldSize 

Set the maximum bit 
field size for 
OMF386 /oadfiles. 

NameOf 

Find the symbol 
representing an 
address. 

Related topics: 
AddressOf, 
DisplaySymbols, 
GetBase, 
RemoveSymbols, 
Set Base 
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MaxBitFieldSize [ 16 I 32 ] 

16 Sets the maximum bit field size to 16 bits for Borland C compiler­
generated OMF386 loadfiles. 

32 Sets the maximum bit field size to 32 bits (default) for all other 
loadfiles. 

NameOf <address> 

<address> is a numeric address. 

Use NameOf to look up a specified address and display the symbol that 
most closely matches the address. 

NameOf Ox0900; 
II #main#14#1 (function main) 
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Overwrite 

Overwrites the log 
file. 

Related topics: 
Append, Echo, Log, 
Logging, Results 

PD 

Display the page 
directory. 

Related topics: 
DT, GDT, IDT, LDT, 
TSS 

Pm ode 

Displays the 
processor mode. 

Overwrite 

When Overwrite has been specified, starting to log (Logging On) 
destroys any prior logfile contents. 

You can also configure logging to overwrite prior information with the 
Shell window Options menu Overwrite Log File item. 

PD [range] 

<range> is the address range of the entries to be displayed. 

With no argument, PD displays the first eight page directory entries. 

reg cr3 Ox5eOOOO; 
write Ox5eOOOOp Ox12345007 Ox56789067 OxO OxO OxO OxO OxO dword; 
II Write successful. 
pd; //same as pd OxOL Ox02000000L; 
II OOOOOOOOL present user read/write table=12345000 
II 00400000L present accessed dirty user read/write table=56789000 
II OOBOOOOOL NOT PRESENT 
II OOCOOOOOL NOT PRESENT 
II 01 OOOOOOL NOT PRESENT 
II 01400000L NOT PRESENT 
II 01800000L NOT PRESENT 
II 01 COOOOOL present dirty supervisor read/write table=6F04COOO 
II 

Pm ode 

The x86 processors operate in various address modes (pmodes). These 
are real, virtual-86 (V86), protected, and System Management Mode 
(SMM). Protected mode is further divided into 16-bit and 32-bit 
protected modes. 

The Intel386 DX and Intel386 SX processors have no SMM. 

pmode; 
II Processor mode= Prot32 

The pmode also appears at the bottom of the Status window icon. 
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Print 

Display a Shell 
variable or string 
constant value. 

RAMtst 

Run the memory 
hardware 
confidence tests. 

Related topics: 
Test 

Register 

Display or set 
register values. 

SW User's Manual 

Print ( <variable> I "<string>" ) 

<Variable> is the name of a Shell variable. 

<String> is a string constant. The quotation marks are required. 

The parentheses are required. 

$a=5; 
Print ("abc"); 
II abc 

Print($a); 
II Ox5 5 

RAMtst [Loop] <address1> <address2> [<space>] 

Loop repeats the low-level operations in the specified test so the 
operation can be observed on an oscilloscope. Press <Esc> 
to stop looping. An error does not halt the test loop. 

<address1 >is the first address in the range to test. 

<address2>is the last address in the range to test. 

<Space> specifies the emulator address space as: 

• user, smm, or io for 386 EX emulators 

• user or smm for 386 CX and Intel486 SLE emulators 

• user or io for NS486 emulators 

• user for 386 SX and Intel486 non-SLE emulators 

The tests appropriate for your emulator are described in the Hardware 
Reference. 

ramtst OxOOOO OxFFFF; /*Test memory from OxO to Oxffff. *I 

Register [<name> [<value>]] [ ... ] 

<name> is a CPU register mnemonic. 

<Value> is the value to be put into the register. 

With no arguments, Register displays all the registers. A <name> 

139 Shell Window Reference 



without a <Value> displays the value of the specified register. 

You can also view and edit the registers in the CPU window. 

RemoveSymbols 

Remove all loaded RemoveSymbols 
symbols and clear 
all allocated symbol 
tables. 

Related topics: 
AddressOf, 
DisplaySymbols, 
GetBase, Load, 
NameOf, SetBase 

Reset 

Reset the target or 
processor. 

Related topics: 
ResetAndGo 

Reset [ CPUonly I Target] 

CPUonly resets the processor without updating the SLD windows. 

Target 

Use this argument only if Reset without CPUonly fails to 
reset the processor: 

1. Enter Reset CPUonly, resetting the processor without 
updating the SLD windows. 

2. Reset your target. 

3. Enter Reset again, without CPUonly, to update the 
SLD windows. 

puts a pulse signal on the SW or EA emulator Reset Out 
pins for approximately one millisecond. For Reset Out 
signal values, see [Systemlnfo] in the "powerpak.ini File 
Reference" chapter. The Reset Out pins are on the front 
panel of the SW or EA emulator, as shown in the following 
figure. The bottom pin is grounded. Connect these pins to 
a reset or other appropriate input on your target board. 

~SJ=2-~r-i~--

I 

SAST 

~SJ=-'-1 -~,--,~---. 

I 
Reset 
Out Sync 

[40 
External Trace 

With no argument, Reset sends a RESET signal to the processor. All 
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CPU register contents are lost on reset: 

• The processor RESET pin is asserted. 

• The program counter and stack pointer are reset and other segment 
registers are set to 0. The Source window displays the program 
counter location. The Stack window display becomes invalid. 

• All SLD windows are updated. 

You can also reset the emulator from the Toolbar Configure menu, the 
Source window Run menu, or the CPU window Options menu. 

ResetAndGo 

Assert and release 
the target reset line. 

Related topics: 
Reset 

ResetAndGo 

This operation is required to start some target systems. For example, 
targets that use an external watchdog timer or power-saver hardware 
may require that you use ResetAndGo. 

You can also reset the processor and start emulation with the Source 
window Run menu Reset And Go item. 

Reset loaders 

Reinitialize the 
loaders when you 
get an error 
message telling you 
to do so. 

RestoreCS 

Restores the chip­
select register 
values. 

Related topics: 
SaveCS 
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ResetLoaders "<loadpath>" 

<loadpath> is the path to the directory containing loaders.ini. The 
quotation marks are required. 

With no argument, ResetLoaders uses the SLD directory. 

RestoreCS "<filename>" 

<filename> is an ASCII file describing chip select register values. 
The quotation marks are required. 

The ASCII file contains an entry for each register. Each entry can be 
up to 80 characters long, containing the following sequential fields: 

<REGISTER NAME in upper case> 
<1 to 20 spaces> 
<hexadecimal value> 
<new line or white space> 
<any comment text other than OA or 0> 
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Restore Map 

Restores a saved 
map configuration. 

Related topics: 
Map, MapRanges, 
Save Map 

Results 

Set the Transcript 
pane results display. 

Related topics: 
Append, Echo, Log, 
Logging, Overwrite, 
Results 

RunAccess 

Set the target 
processor access 
mode during 
emulation. 

Related topics: 
Copy, Dump, Fill, 
Search, Size, 
Verify, Write 

You can create the chip select file with a SaveCS command. For a 
processor-specific list ofregisters, see the Hardware Reference. 

You can also restore the chip selects with the Toolbar Configure menu 
Restore Chip Selects item. 

RestoreMap "<filename>" 

<filename> is a file containing a map configuration. The quotation 
marks are required. 

You can also restore the map from a file with Map dialog box Restore 
button, accessible via the Toolbar Map button. 

Results [ on I off ] 

on (default) displays Shell command results in the Transcript pane. 

off displays no Shell command results in the Transcript pane. 

Without arguments, Results displays the current setting. 

You can also toggle results with the View menu Show Results item. 

RunAccess [on I off] 

off (default) disables reading and writing memory during emulation. 

on enables reading and writing memory during emulation. 

Without arguments, RunAccess displays the current setting. 

Memory access is used for operations that read and write the peripheral 
registers and memory, including scrolling or updating the Peripheral 
and Memory window displays. Because reading and writing memory 
takes a small amount of processor time, memory access is initially 
disabled during emulation. Use RunAccess to enable memory 
accesses during emulation; however, such access can degrade your 
program execution. 

You can also toggle Run Access with the Toolbar Configure menu Run 
Access item. 
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SaveCS 

Saves the chip­
select registers. 

Related topics: 
RestoreCS, 
ConfigCS 

SaveMap 

Saves a memory 
map configuration. 

Related topics: 
RestoreMap 

Search 

Search for a pattern 
in memory. 

Related topics: 
Copy, Dump, Fill, 
RunAccess, Size, 
Verify, Write 
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SaveCS "<filename>" 

<filename> is the filename where the chip select register values are to 
be saved. The quotation marks are required. 

Different chip select registers are saved for different processors. See 
the processor-specific lists in the Hardware Reference. 

Restore the register values from the file with RestoreCS. 

You can also save the chip selects with the Toolbar Configure menu 
Save Chip Selects item. 

SaveMap "<filename>" 

<filename> specifies the pathname of the file where the memory map 
is to be saved. The quotation marks are required. 

Restore the map from the file with RestoreMap. 

You can also save the map from the Map dialog box, accessible from 
the Toolbar Map button. 

Search <start> <end> [Not] <data> [ Byte I Word I Long I Dword ] 
[<space>] 

<Start> 

<end> 

Not 

<data> 

is the first address in the address range to be searched. 
Addresses can be symbolic or numeric. 

is the last address in the range to search. 

searches for the first pattern mismatch rather than the first 
pattern match. 

is a pattern for which to search, up to 256 bytes long. 

Byte specifies the data is a byte value. 

Word specifies the data is a word value. 

Long specifies the data is a double word value. 

Dword is the same as Long. 

<Space> specifies the emulator address space as: 

• user, smm, or io for 386 EX emulators 
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Set Base 

Relocate symbols. 

Related topics: 
AddressOf, 
DisplaySymbols, 
GetBase, NameOf, 
RemoveSymbols 

• user or smm for 386vCX and Intel486 SLE 
emulators 

• user or io for NS486 emulators 

• user for 386 SX and Intel486 non-SLE emulators 

The physical read of memory uses the Size command settings rather 
than the format size set by the Search command. For example, if 
Size=Byte, Search reads memory in byte-sized memory accesses. 

Because reading and writing memory takes a small amount of 
processor time, memory access is initially disabled during emulation. 
Use RunAccess to enable Search during emulation; however, such 
access can degrade your program execution. 

Fill O ffff oxo user; 
Write 400 Ox1234 user; 

Search 0 ffff Ox1234 user; 
II pattern found at 400 

You can also search for a pattern in memory with the Memory window 
Edit menu Search Memory item. 

SetBase <base> <address> 

<base> is the base name for the symbols to be relocated. Case is 
significant. 

<address> is the new numeric or symbolic base address. 

SetBase relocates the symbols in the specified <base> to their offset 
addresses plus the specified <address>. The default base address is 0. 

You can use SetBase to quickly relocate all symbols in a base. For 
example, if code is loaded by the target program into memory other 
than where it was linked, you can set the base address to the new load 
address using SetBase, thus matching the code symbol addresses to 
the memory where the code is loaded. 

To discover the base names and their address offsets, use GetBase. 
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SetStackAlarm 

Set the stack alarm 
limit. 

Related topics: 
DisableAlarmlimit, 
DisableHighWater-

Mark, 
DisplayStack, 
EnableAlarmlimit, 
EnableHighWater-

Mark, 
FillStackPattern, 
SetStackArea, 
SetStackBase, 
SetStackSize, 
Stacklnfo 

SetStackAlarm <percent> 

<percent> is a percentage of the stack area, from 1 to 99. 

Use SetStackAlarm to set the stack alarm limit as a percentage of the 
stack. The alarm appears as a red line on the stack meter in the Stack 
window. 

When enabled (see EnableAlarmlimit), the stack alarm notifies you if 
the stack usage is exceeding the alarm limit when emulation halts. 

You can also set the stack alarm with the Stack window Options menu 
Alarm Limit item. 

SetStackArea 

Redefine the stack 
location and size. 

Related topics: 
DisableAlarmlimit, 
DisableHighWater-

Mark, 
DisplayStack, 
EnableAlarmlimit, 
EnableHighWater-

Mark, 
FillStackPattern, 
SetStackAlarm, 
SetStackBase, 
SetStackSize, 
Stacklnfo 
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SetStackArea [<address> <size> [fillArea]] 

<address> is a numeric or symbolic base address. 

<size> 

fillArea 

is the stack size in bytes. 

initializes the stack area. 

With no arguments, SetStackArea shows the current settings (the 
same as Stacklnfo). 

This command changes the addresses used by the emulator for stack 
monitoring and does not affect your program's stack allocation. 

Separate Shell commands (SetStackBase and SetStackSize) exist to 
set the stack base and size. Because of the delay between command 
executions, using the separate commands to redefine the stack can 
temporarily define an invalid stack area for the emulator's stack 
monitoring operations. SetStackArea sets the stack base and size in a 
single command. 

To fill the stack area with a pattern without changing the base and size, 
use FillStackPattern. 

setstackarea Ox1000 Ox500 fillarea; 

You can also set the stack base and size with the Stack window Options 
menu Stack Area item. 
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SetStackBase 

Set the stack base SetStackBase <address> 
address. 

Related topics: 
DisableAlarmLimit, 
DisableHighWater-

Mark, 
DisplayStack, 
EnableAlarmLimit, 
EnableHighWater-

Mark, 
FillStackPattern, 
SetStackAlarm, 
SetStackArea, 
SetStackSize, 
Stack Info 

<address> is a numeric or symbolic base address. 

This command changes the base address used by the emulator for stack 
monitoring and does not affect your program's stack base address. 

Separate Shell commands exist to set the stack base and size. Because 
of the delay between command executions, using separate commands to 
redefine the stack can temporarily define an invalid stack area for the 
emulator's stack monitoring operations. SetStackArea sets the stack 
base and size with a single command. 

To show the current stack settings, use Stacklnfo. 

SetStackBase FOOO; 

You can also set the stack base with the Stack window Options menu 
Stack Area item. 

SetStackSize 

Set the stack size. 

Related topics: 
DisableAlarmLimit, 
DisableHighWater-

Mark, 
DisplayStack, 
EnableAlarmLimit, 
EnableHighWater-

Mark, 
FillStackPattern, 
SetStackAlarrn, 
SetStackArea, 
SetStackBase, 
Stacklnfo 

Signal 

Display or set 
whether signals are 
enabled. 

SetStackSize <size> 

<size> is the stack size in bytes. 

This command changes the stack size used by the emulator for stack 
monitoring and does not affect your program's stack size. 

Separate Shell commands exist to set the stack base and size. Because 
of the delay between command executions, using separate commands to 
redefine the stack can temporarily define an invalid stack area for the 
emulator's stack monitoring operations. SetStackArea sets the stack 
base and size with a single command. 

To show the current stack settings, use Stacklnfo. 

SetStackSize 200; 

You can also set the stack size with the Stack window Options menu 
Stack Area item. 

Signal [[<name> [Enable I Disable]] I [All Enable I All Disable]] 

Enable drives the specified signal by your target system. 
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Size 

Selects memory 
access size. 

Related topics: 
Copy, Dump, Fill, 
RunAccess, 
Search, Verify, 
Write 

Stacklnfo 

Display the stack 
information. 

Related topics: 
DisableAlarmLimit, 
DisableHighWater-

Mark, 
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Disable drives the specified signal by the emulator. 

All Enable connects all signals. 

All Disable disconnects all signals. 

<name> identifies a signal. For a processor-specific list of 
configurable signals, see the Hardware Reference. 

With no arguments are specified, Signal displays the status of all 
signals. To display the status of a particular signal, specify only 
<name>. 

signal; 
II READY# ENABLE 
II RESET DISABLE 
II HOLD DISABLE 
II NMI DISABLE 
II NA# DISABLE 
II INTR DISABLE 
II Coprocess DISABLE 

signal reset enable; 
II RESET ENABLE 

You can also toggle the signal connections with the CPU window 
Options menu Signals item. 

Size [Byte I Word I Long I Dword] 

Byte, Word, Long, and Dword specify the size of subsequent memory 
accesses. Dword is the same as Long. The memory access size is 
independent of the display size. 

With no argument, Size reports the current setting. 

You can also specify the memory access size from the Memory window 
Options menu. 

Stacklnfo 

This command displays the current stack information. The number of 
frames shows the call nesting level. 

Stacklnfo; 
II stack base = 12345678 
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DisplayStack, 
EnableAlarmLimit, 
EnableHighWater-

Mark, 
FillStackPattern, 
SetStackAlarm, 
SetStackArea, 
SetStackBase, 
SetStackSize 

StartTimer 

Start the timer. 

Related topics: 
Lap Timer, 
Stop Timer 

Step 

Emulate one or 
more instructions. 

Related topics: 
$BREAK CAUSE 
System Variable, 
$EMULATING 
System Variable, 
Cause, Go, Golnto, 
GoUntil, Halt, 
ResetAndGo, 
StepSrc 

StepSrc 

Step emulation by 
source lines or 
statements. 

Related topics: 
$BREAKCAUSE 

II size= 0 
II current stack pointer = 87654321 
//frames= 0 
II alarm limit = 0%, DISABLED 
II high water mark = 00000000 
II stack type = high to low 

The same information appears in the Stack window. 

StartTimer 

This command resets the elapsed time to zero and starts the timer. 

Step [Into I Over] [<count>] 

Into 

Over 

<count> 

(default) if a function call is encountered, executes the 
function call as a step and continues according to 
<count> within the called function. 

if a function call is encountered, executes the entire 
function (including any functions it calls) as a single step 
and continues according to <Count> within the calling 
function. 

specifies how many steps to do. A large <count> can 
cause stepping to go for a long time. Press <ESC> to 
break out of stepping before the step count is finished. 

The default granularity and count are determined by the Source 
window Options menu Source Step Granularity and Step Count items. 

You can also step with the Toolbar Step button, various Source window 
buttons, and the Source window Run menu. 

StepSrc [Into I Over] [Line I Statement] [<count>] 

Into (default) if a function call is encountered, executes the 
function call as a step and continues according to 
<Count> within the called function. 
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System Variable, 
$EMULATING 
System Variable, 
Cause, Go, Golnto, 
GoUntil, Halt, 
ResetAndGo, Step 

Stop Timer 

Stop and report on 
the timer. 

Related topics: 
Lap Timer, 
Start Timer 

String 

Discover whether a 
variable is a string. 

Related topics: 
Integer 
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Over if a function call is encountered, executes the entire 
function (including any functions it calls) as a single step 
and continues according to <count> within the calling 
function. 

Line sets the step granularity as one source line. A source line 
can contain more than one statement. Lines can be out­
of-order relative to the sequence of instructions the 
compiler generates. 

Statement sets the step granularity as one statement. 

<Count> specifies how many steps to do. A large <count> can 
cause stepping to go for a long time. Press <ESC> to 
break out of stepping before the step count is finished. 

The default granularity and count are determined by the Source 
window Options menu Source Step Granularity and Step Count items. 

You can also step with the Toolbar Step button, various Source window 
buttons, and the Source window Run menu. 

Stop Timer 

Stop the timer and show the number of milliseconds elapsed since the 
previous StartTimer command. 

String (<variable>) 

<variable> is a Shell variable name. The parentheses are required. 

String returns 1 if the variable is a string and 0 otherwise. 

$a= "qrs"; 

String($a); 
II Ox1 1 

if (string($a)) { "it is a string"; } 
II it is a string 
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SymbolCloseFile 

Close the symbol 
text file. 

DisplaySymbols, 
SymbolOpenFile 

SymbolCloseFile 

Closes the file opened by SymbolOpenFile. 

SymbolOpenFile 

Open a text file. 

DisplaySymbols, 
SymbolCloseFile 

Test 

Run the hardware 
confidence tests. 

Related topics: 
Ra mt st 

SymbolOpenFile "<filename>" 

<filename> is the name of a file. The quotation marks are required. 

Opens a text file with the specified filename. Subsequent output from 
DisplaySymbols is directed to the specified file. The file can be 
viewed with an editor or file browser. 

Test [Loop] [Repeat I Continue] [Brief I Verbose] [Except] 
[<name> I <number>] 

Loop repeats the low-level operations in the specified test so the 
operation can be observed on an oscilloscope. Press 
<Esc> to stop looping. 

Repeat repeats the specified test until you press <Esc>. 

Continue continues through all tests, even if one fails. 

Brief displays only the final test result. 

Verbose displays every test result and progress report. 

Except excludes the specified tests and runs all others. 

<name> specifies one or more tests by name. 

<number> specifies one or more tests by number. 

With no arguments, Test runs all tests and displays the results. 

To run these tests, connect the Stand-Alone Self-Test (SAST) or null 
target board as described in the Hardware Reference. The tests 
appropriate to your emulator are also described in the Hardware 
Reference. 
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Time 

Show the current 
date and time. 

Transcript 

Set the number of 
lines saved in the 
transcript pane. 

Related topics: 
Echo, Results 

TSS 
Displays task state 
segments. 

Related topics: 
DT, GDT, IDT, 
LDT, PD 

Verify 

Time 

Transcript [<size>] 

<size> is the number (0 to 1000) of lines to be saved in the 
scrollable Transcript pane. 

You can also set the transcript size with the Options menu Set 
Transcript Size item. 

TSS (<selector> I <register>) [Base <address> [Limit <bytes>]] 
[Tss286 I Tss386] ] [All] 

<Selector> specifies the selector from the GDT to identify the TSS 
base and limit. With no selector specified, the current 
tss_base and tss_limit are used. 

<register> is any CPU mnemonic specifying a register containing a 
selector in the first 16 bits. 

<address> specifies the descriptor table base address. The Base 
keyword is requried. 

<bytes> 

All 

Tss286 

specifies a range of selectors as a number of bytes. The 
Limit keyword is required. 

Displays all entries, including invalid or reserved entries. 

specifies Intel286 processor segmentation. 

Tss386 specifies Intel386 processor segmentation. 

With no entries, TSS displays all task state segments plus the 1/0 bit 
map in the range tss_base to tss_limit. 

TSS displays the task state segments for any selector or base address. 

Togglesonandoffa Verify [on I off] 
read-after-write. 

on checks values written to memory (default). 
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Related topics: 
Copy, Dump, Fill, 
Load, RunAccess, 
Search, Size, Write 

Version 

off does not check writes. 

Verify checks writes by reading-back the written value and comparing 
the read value with the value supposedly written. If they do not match, 
an error is returned. Verification can happen after a Write, Fill, or 
Load. Verification does not affect the target processor during 
emulation. 

You can also toggle write verification with the Memory window 
Options menu Write Verify item. 

Report the emulator Version 
version information. 

While 

Repeatedly execute 
statements while the 
condition is true. 

Related Topics: 
If... Else 

Write 

Write to a memory 
address. 

Related topics: 
Copy, Dump, Fill, 
RunAccess, 
Search, Size, Verify 

Use version when logging an emulator session to record which version 
of the emulator hardware, software, and firmware is in use. The 
information from this command is also needed when you contact 
Microtek for technical support or product upgrades. 

You can also view some version information from the Toolbar Help 
menu About item. 

While ( <condition> ) { <block> } 

<condition>evaluates to true (non-zero) or false (zero). The 
parentheses are required. 

<block> is one or more Shell commands delimited with 
semicolons. The braces are required. 

While <Condition> is true, the <block> executes. 

$a = O; While ($a < 500) {$a = $a + 1 ;} 

Write [Loop] <address> <data> [Byte I Word I Long I Dword] 
[<space>] 

Loop repeats the write without printing, even if errors occur. 

<address> is a numeric or symbolic starting address. 

<data> is up to 256 data values to be written. 
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Xlt 

Translates an x86 
numeric address. 

Related topics: 
AddressOf, 
NameOf 

SW User's Manual 

Byte 

Word 

Long 

Dword 

<space> 

specifies the data is a byte value. 

specifies the data is a word value. 

specifies the data is a double word value. 

is the same as Long. 

specifies the emulator address space as: 

• user, smm, or io for 386 EX emulators 

• user or smm for 386 ex and Intel486 SLE 
emulators 

• user or io for NS486 emulators 

• user for 386 SX and Intel486 non-SLE emulators 

The physical write to memory uses the Size command settings rather 
than the format size specified in the Write command. For example, if 
Size=Byte, Write commands write by byte-sized memory accesses. 

Because reading and writing memory takes a small amount of 
processor time, memory access is initially disabled during emulation. 
Use RunAccess to enable Write during emulation; however, such 
access can degrade your program execution. 

Xlt <address> 

<address> is a numeric or symbolic address. 

Xlt translates any numeric or symbolic address to its equivalent linear 
or physical form, according to x86 numeric addressing rules. For a 
virtual address, Xlt displays the linear and physical equivalents. For 
linear or physical addresses, Xlt displays the physical equivalent. 

Xlt #upper#startup 
II 0020:00F35BDO = OOF35BDOL = F35BDOP 
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Source Window Ref ere nee 

file _Edit Yiew Bun .6_reakpoints Qptions ytindows .!::!elp 

Go Halt Ste) Into Ste Over Into Call Into Return Go To Cursor 

[000167] for (i = 0: i < cellPtr->length; i++) ( ~ 
[000167] 0200:0128 C746F60000 MOU WORD PTR [BP-0A],0000 
[000167] 0200:012D E90400 JMP dm_func~167 (printall) 
[000167] 0200:0130 8346F601 ADD WORD PTR [BP-0A],01 

>>[000167] 0200:0134 885EFA MOU BX, [BP-06] 
000167 0200:0137 884704 MOU AX BX+04 

Source Window Contents 

The Source window displays: 

• when enabled, the source line numbers 

• when available, the source lines 

• when enabled, the disassembly corresponding to each source line, 
including the load address, hexadecimal code, and instructions 

You can display two independently scrolling Source window panes. 
To reveal the second pane, drag the split box cursor (see figure at left) 
above the top arrow of the vertical scroll bar. To change focus to a 
pane, click in the inactive pane or press <Tab>. 

Source Window Menus 

SW User's Manual 

Some items are on/off toggles, on when a check mark ( '°') appears. 
Others take immediate action. Items with ellipses pop-up dialog boxes. 

Menu 

File 

Edit 

View 

Run 

Breakpoint 

Options 

Use To: 

Load and view modules; close the Source window. 

Navigate through source. 

Configure the source and disassembly display. 

Start or stop emulation; step; reset. 

Define and manage breakpoints. 

Manage source display options and emulation 
controls. 
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File menu, showing 
previously loaded files 
demo386.omf and 
demo.emf 

Load Information 
dialog box, describing 
a successful 
demo.emf load 

Windows 

Help 

File Menu 

Open another SLD window. 

Open a window for help on the SLD software. 

_load Code ... 
Load Information ... 

.!!rowse Modules ... 
Erevious Browsed Module 
Next Browsed Module 

E~it 

1 •.. ERPAK\SAMP386\DEM0386.0MF 
l ... POWERPAK\SAMP386\DEMO.OMF 

Load Code .•• opens the Load dialog box to load code or symbols from a 
loadfile. This has the same effect as choosing the Toolbar Load button, 
as described in the "Toolbar Reference" chapter. To reload a file, 
choose from the (up to four) files listed at the bottom of the Source 
window File menu. 

Load Information ••• opens an information box describing the loadfile 
and what has been loaded into the emulator. The display differs 
between processors. 

Load Complete 

Loadfile: C:\PO\llEAPAK\SAMP3B6\DEMO.OMF 

Module: 

Bytes: BB6 Lines: 213 
Modules: 3 
Symbols: 96 PC: 0200:01AO 

Types: 333 Stack Base: 0026:1000 
Functions: 5 Stack Size: OxlOOO 

.Q.K I I Jielp 

Browse Modules ... opens a dialog box to change the module (source, 
disassembly, and symbols) displayed in the Source window. 
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Browse Modules dialog 
box, with dm_func 
selected 

SW User's Manual 

m func 
dm_main 
startup 

l+I 

----
Browse Modules 

~oad C:\POWERPAK\SAMP386\DE 
T~~~:uage: Assembly 
Address: 8/12/1994 - 14:21 :30 
Path: 0200:0040 __ 0198 

l+I I l•I 

~--=OK_~I I J;;_ancel I I !:!_elp 

To select a module, click on the module name or use the <Up Arrow> 
and <Down Arrow> keys to scroll the cursor. For the selected module, 
the dialog box displays: 

Load File: 

Language: 

Time: 

Address: 

Path: 

The loadfile path and filename 

The language of the source file 

The date and time the loadfile was created 

Where in memory the module is loaded 

The source file path and filename 

Choose OK to browse to the selected module or Cancel to exit the 
dialog box without changing the Source window display. 

Previous Browsed Module changes the Source window display back to 
the module you last viewed. The SLD software maintains a list of 
which modules you have browsed and in what order you browsed them. 

Next Browsed Module changes the Source window display to the next 
module in the browse history. 

Exit closes the Source window. To exit the SLD software, use the 
Toolbar File menu Exit item. 

1, 2, 3, 4 lists the last four files you loaded. Reload a file by choosing it 
from this list. This method of reloading a file bypasses the Load and 
Load Options dialog boxes. 

Edit Menu 

Search ... 
Search Next 

Go To J)ne ... 
Go To ~ddress ... 
Go To CS:El_e 

Search opens a dialog box for searching the Source window text for a 
specific string. Case is significant in the search string. The search 
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Search dialog box, for 
finding a string in the 
source display 

Go To Line dialog box, 
for finding a line 
number in the source 
display 

Go To Address dialog 
box, for finding code 
load address 
FFFFE3E4 in User 
space 

starts from the Source cursor and stops at the first instance of the string 
found. If the string is not found, the search stops at the end of the 
module. To search the entire module, position the Source cursor at the 
beginning of the module before starting the search. 

Search 

.Search for: 

OK I !;.ancel !!elp 

Search Next searches again for the last string you entered in the Search 
dialog box. The search starts from the cursor and stops at the first 
match or the end of the module. 

Go To Line ••• opens a dialog box to move the Source cursor to a 
specific line. If you specify a line number beyond the last line in the 
current module, the Source cursor moves to the end of the module. 

Go To Line 

!,ine Number: 

llill 
OK !;.an eel !!elp 

Go To Address ••• opens a dialog box to move the Source cursor to a 
specific address. If no source is available for the address you specify, 
the Source window shows disassembled code beginning at that address. 

------
Go To Address 

Address: 

I CS:FFFFE3E4 

Spac~: Op_erand/Address Size: 

jAuto liJ 

QK I I ~ancel I I !::!elp I 

You can specify: 

Space: 

Operand/ Address 
Size: 

User or SMM (system management mode), 
depending on the processor 

Use16 (16-bit), Use32 (32-bit), or Auto (pmode­
derived) addressing mode. 
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View menu, showing 
the Operand/ Address 
Size sub-menu 

Run menu, listing the 
keyboard-shortcut 
function keys for 
emulation control 

SID User's Manual 

Go To CS:EIP moves the Source cursor to the current program 
counter. 

View Menu 

,/.Source Only 
Mixed Source and Asm 

,/Line Numbers 

OJl_erand/Address Size ,/Auto 
Use16 
Use;)_2 

Source Only, when checked, displays only your source code. 

Mixed Source and Asm, when checked, displays the source code lines 
interleaved with the corresponding disassembly lines from memory. 

Line Numbers, when checked, displays the source file line numbers 

Operand/Address Size opens a sub-menu with the following choices to 
display disassembly text: 

Auto Operand/address size is 16-bit or 32-bit, depending on the 
pmode. 

Use16 Operand/address size is 16-bit. 

Use32 Operand/address size is 32-bit. 

Run Menu .. 
§o 
!!alt 
.Step Into 
Step .Qver 

Go Until kall 
Go Until Ret.!!.rn 
Go Into Call 
Go Into Beturn 

Go!o Cursor 
Go [rom Cursor 

Ste]! Into Continuously 
Step Oyer Continuously 

R!;_set 
Reset And Go 

Go or pressing <F9> starts emulation. 
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F9 
F2 
F7 
F8 
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Halt or pressing <F2> stops emulation. 

Step Into or pressing <F7>, when the program counter is on a function 
call, executes the call to the function and stops before the first 
instruction in the function. Step Into and Step Over are the same 
operation when the program counter is not on a function call. 

To step into a function with no associated source, before stepping 
enable the View menu Mixed Source and Asm item to display 
disassembly in the Source window. Otherwise, Step Into operates the 
same as Step Over for that function. The Source window must be able 
to display the program counter where emulation halts. 

Step Over or pressing <F8>, when the program counter is on a 
function call, executes the call as a single step. This step executes the 
function, returns, and stops before the first instruction following the 
return. (However, encountering a breakpoint in the stepped-over 
function stops emulation at the breakpoint.) The Source window 
continues to display the calling function. 

Go Until Call executes from the program counter to the beginning of a 
statement or line (depending on the granularity) containing a call. 

Go Until Return executes from the program counter to the beginning 
of a statement or line (depending on the granularity) containing a 
return. 

Go Into Call executes from the program counter and stops before the 
first instruction in the next called function. 

Go Into Return executes from the program counter through the first 
return instruction and stops before the first instruction after the return. 

Go To Cursor executes from the program counter and stops before the 
selected line or statement in the Source window. 

Go From Cursor moves the program counter to the selected line or 
statement in the Source window, then starts emulation. 

Step Into Continuously does Step Into operations until you halt it. 

Step Over Continuously does Step Over operations until you halt it. 

Reset asserts the RESET pin of the target processor, causing the CPU 
to reset the internal registers, the program counter, and the stack 
pointer. The RESET pin is then released. All SLD windows are 
updated; the Source window displays the beginning of code (where the 
program counter points) and the Stack window display is invalid. 

Reset And Go does a Reset, as above, and starts emulation from the 
power-up reset vectors. The reset vectors must be previously set. 
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Breakpoints menu with 
all items enabled, 
indicating at least one 
breakpoint is defined 

Set Breakpoint dialog 
box to set a 
permanent, initially 
enabled breakpoint at 
address 73 
(hexadecimal) in the 
dm_main module main 
function 

SLD User's Manual 

Breakpoints Menu 

Set Permanent Breakpoint, Set Temporary Breakpoint, Set 
Breakpoint..., and Show All ... are always available; Clear, Enable, and 
Disable are available when you have selected a breakpoint from those 
listed in the Breakpoint window; Clear All, Enable All, and Disable All 
are available when one or more breakpoints are listed. To select a 
breakpoint, click on it or move the highlight with <Up Arrow> and 
<Down Arrow> keys. .. - 01.J! I 

Set eermanent Breakpoint 
Set Iemporary Breakpoint 
Set Breakpoint... 

!;_I ear 
.Enable 
Qisable 

Clear !!JI 
Errable All 
Disable All 

JihowAll ... 

Set Permanent Breakpoint sets a permanent breakpoint at the cursor. 

Set Temporary Breakpoint sets a temporary breakpoint at the cursor. 

Set Breakpoint ••• opens a dialog box to set a breakpoint at a specific 
address. 

----------------------
Set Breakpoint 

.H_reakpoint at: ltdm_func#insert 

Modules 

ldm_func 

Stnte---~ 

@En.able 

0 g_isable 

Jiet 

Eunctions 

TllJle 
@ £.ermanent 

0 Iemporary 

I Clg_se 

Fill-in the dialog box as follows: 

!user 

I !:!_elp 

Breakpoint at: can be a numeric or symbolic address. For symbolic 
addresses, choose a module and a function from the 
drop-down list boxes. 

State can be toggled to Enable or Disable. The emulator 
ignores a disabled breakpoint. 
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Type can be permanent or temporary. A temporary 
breakpoint is removed after it causes the break. 

Space: can be User or SMM for some processors. 

Choose the Set button to define the breakpoint or the Close button to 
close the dialog box without defining a new breakpoint. 

Clear removes a breakpoint at the Source cursor. 

Disable marks the breakpoint at the Source cursor to be ignored when 
emulation executes through the code where the breakpoint is located. A 
disabled breakpoint highlight in the Source window is grey. 

Enable marks the breakpoint at the Source cursor to cause a break 
when emulation executes through the code where the breakpoint is 
located. An enabled breakpoint highlight in the Source window is red. 

Disable All disables all currently defined breakpoints. The breakpoints 
remain defined. 

Enable All enables all currently defined breakpoints. 

Clear All removes all breakpoints. No breakpoints remain defined. 

Show All ... opens the Breakpoint window, described in the Breakpoint 
Window Reference chapter. 

Options Menu 

Source Eath ... 
Iab Width ... 

Source Step yranularity • 
Step .Qount... 

B_rowser History Depth ... 

Source Line .Qelimiter • 

~et Go Buttons • 

Source Path opens a dialog box to add, delete, or change the paths to 
the source files used in generating your loadfile. You can define up to 
50 source paths. The path list is saved in powerpak.ini. 

When you browse a module in the Source window, the emulator 
searches the source paths for the corresponding source file in the order 
they appear in the dialog box, from top to bottom. 
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Source Path dialog 
box, specifying 
c:\powerpak\samp386 
as the path for all 
source files 

Edit Path dialog box for 
changing the 

Source Path 

I Add... 11 .E_diL 11 !!_elele 11 CIQse 11 f;_ancel 11 .!::!_elp 

To select a source path for editing or deleting, click on it or use the <Up 
Arrow> and <Down Arrow> keys to move the highlight. 

The Source Path dialog box buttons are: 

Add... opens a dialog box for adding a new source path to the 
emulator's list of source paths. Select a source file; choose OK 
to add the path or Cancel to close the dialog box without 
adding the path. 

Edit... opens a dialog box for editing the selection. 

Edit Path 

c:\powerpak\samp386 fath: 
entry in the Source 
Path dialog box 

Tab Width dialog box, 
replacing tabs with 8 
spaces 

Tab Width And 
Statement-Level 
Breakpoints 

SW User's Manual 

C \PO\llERPAK\SAMP386\ 

J;!_K I f;_ancel I I .!::!_elp j 

Delete removes the selection from the source path list. 

Cancel closes the Source Path dialog box, first asking you whether to 
keep or abandon the Add, Edit, and Delete changes. 

Close replaces Cancel when you click on OK. This button closes the 
Source Path dialog box, keeping all changes you have made. 

Tab Width ••• opens a dialog box to specify the number of spaces the 
Source window uses to replace a tab character in your source file. The 
default is eight spaces. 

------
Tab Width 

Iab Width (1-32): 

l!il 
OK I f;_ancel I t1e1p 

To set a breakpoint at the statement level, you must know how many 
spaces your compiler uses for a tab character. For example: 

<tab><tab>for( i = O; i < MAX_NUM; I++){ /*source line*/ 
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Source Step 
Granularity sub-menu 
specifying source line 
stepping 

Step Count dialog box 
specifying one step per 
Step command 

Source Line Delimiter 
sub-menu set for DOS 
source files 

The compiler generates column range information for the three 
statements in this line, using a tab width of 8: 

i = 0 columns 0 to 26 

i < MAX_NUM columns 27 to 39 

i++ columns 40 to 45 

If you set the Source window Tab Width to 4, then use the Source 
cursor to set a breakpoint on the first i (column 13) or the second i 
(column 20), the breakpoint is within the first statement's column 
range. The third i is within the second statement's range. 

Source Step Granularity opens a sub-menu to specify whether a Step 
command steps by source lines or by source statements. Some C 
compilers allow more than one statement per line, separated by 
semicolons. You can step through such a source line by statements. 

. , ,J Source Line 
Step .Count. .. Source ~tatement 

Step Count opens a dialog box to set the steps (1 to 100) executed per 
Step command. 

Step Count 

.S.tep Count: 

111 

OK I Cancel Help 

Browser History Depth opens a dialog box to set the maximum 
number of browsed modules (0 to 50) that can be recalled. The 
emulator maintains a list of the modules you browse and the order in 
which you browse them. Use the Previous Browsed Module and Next 
Browsed Module items in this menu to cycle through the modules. 

Previous Browsed Module displays the next earlier module in your 
browse history. 

Next Browsed Module displays the next later module in your browse 
history. 

Source Line Delimiter opens a sub-menu to set the ASCII string used 
by the compiler to delimit a source line. 

Source Line Qelimiter ../.Carriage Return/Linefeed 
,__S_e_t_G_o_B_u_tt_o_n_s ___ __, Linefeed Only 
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Set Go Buttons sub­
menu specifying Into 
Call/Return buttons 

Into Call/Return and 
Until Call/Return 
buttons 

Carriage 
Return/ 
Linefeed 

Linefeed 
Only 

(the default) recognizes a carriage return followed by a 
linefeed as the string indicating the end of a line. This is 
the DOS standard line delimiter. Displaying a UNIX file 
with Source Line Delimiter as Carriage Return/Linefeed 
shows the entire source file as a single line. 

recognizes a linefeed as the end-of-line indicator. This is 
the UNIX standard line delimiter. Displaying a DOS 
source file with Source Line Delimiter set to Linefeed Only 
shows a black dot at the end of each line. 

Set Go Buttons opens a sub-menu to toggle the operation of the Call 
and Return buttons between Go Until and Go Into. 

.S.et Go Buttons .\,!_ntil Call/Return 
.,/ lnto Call/Return 

Into Call !! into Return I 

Until Call II Until Return I 

Source Window Buttons 

Source window button 
bar configurations 

SW User's Manual 

These buttons provide quick access to commonly used Run menu items, 
described earlier in this chapter. 

The Source window button bar has two possible configurations. To 
toggle between them, choose the Options menu Set Go Buttons item 
and choose Until Call/Return or Into Call/Return. 

Go 

Go 

Button 

Go 

Halt 

Step Into 

Step Over 

Until Call 

Halt Step Into II Step Over II Into Call !! Into Return l§o To Cursol 

Halt Step Into !! Step Over II Until Call !!Until Return!(io To Cursof 

Use To: 

Start emulation from the program counter, the same as 
the Run menu Go. 

Stop emulation, the same as the Run menu Halt. 

Step into a function call at the program counter, the 
same as the Run menu Step lnto.stepping:Source 
window 

Step over a function at the program counter, the same 
as the Run menu Step Over. 

Go from the program counter and break before the next 
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Into Call 

Until 
Return 

Into Return 

function call, the same as the Run menu Go Until Call. 

Go from the program counter and break after the next 
function call, before executing the function, the same as 
the Run menu Go Into Call. 

Go from the program counter and break before the next 
return instruction, the same as the Run menu Go Until 
Reti.Jrn. 

Go from the program counter and break after the next 
return instruction, the same as the Run menu Go Into 
Return. 

Function Popup Menu 

Function menu 
popped-up by double­
clicking on a printall 
string in the source 
display 

Load Address dialog 
box showing the 
printall load address 

To pop-up the Function menu, select a function name in a source line. 
The selected function name is highlighted. 

II Function: printall 
Y.o To Source 
.Show Load Address 
Set f!erm. Breakpoint 
Set Iemp. Breakpoint 
!;.lear Breakpoint 

Go To Source puts the Source cursor at the beginning of the function 
source code. If no source is available, the Source window can display 
the function in disassembly. To enable the disassembly display, open 
the View menu and choose Mixed Source and Asm. 

Show Load Address opens an information box listing the memory 
address range occupied by the function. 

PowerPack SLD 

Function printall: Address starts at: 
0200:00FC .. 0198. 

I QK I I tlelp \ 

Set Perm. Breakpoint sets a permanent breakpoint at the highlight. 

Set Temp. Breakpoint sets a temporary breakpoint at the highlight. 

Clear Breakpoint clears the breakpoint at the highlight. 
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Variable Popup Menu 

Variable menu, 
popped-up by double­
clicking on a 
staticlterations string in 
the source display 

SW User's Manual 

To pop-up the Variable menu, select (double-click on) a variable name 
in a source line. The selected variable name is highlighted. 

II Variable: staticlterations 
Inspect Variable 

Set Eerm. Breakpoint 
Set Iemp. Breakpoint 

Inspect Variable adds the variable to the Variable window, described 
in the Variable Window Reference chapter. If the Variable window is 
not already open, Inspect Variable opens it. 

Set Perm. Breakpoint sets a permanent breakpoint on the highlight. 

Set Temp. Breakpoint sets a temporary breakpoint on the highlight. 
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Variable Window Reference 

.Eile I;dit Yiew V_!!riable Windows .t!_elp 
struct LIHKS *top = DS:OOOO; + 
LIHKS *top { 

} 

struct LIHKS *next = DS:OOOO; 
signed char *StringPtr = DS:OOOO; 
signed short int length = OxO = O; 

LIHKS top->*next { 

} 

struct LIHKS *next = DS:OOOO; 
signed char *StringPtr = DS:OOOO; 
signed short int length = OxO = O; 

signed char top->next->*stringPtr = OxO = 

Variable Window Contents 

SLD User's Manual 

The Variable window displays the types, symbolic names, and values of 
global and local variables. Variable symbolic information appears in 
the following colors: 

Red indicates an editable value. Integer variables can be edited 
in hexadecimal or decimal, floating point variables in 
floating point format, and characters in ASCII or the 
hexadecimal equivalent. To edit a value, either double-click 
on the value; or single-click on the value, open the Edit 
menu, and choose Edit. Press <Enter> to end or <Esc> to 
cancel editing. 

Blue indicates a pointer variable you can dereference by double 
clicking. To dereference a pointer, either double click on the 
pointer name or open the View menu and choose Show. A 
new entry is added to the Variable window, showing the 
variable that was pointed to. 

Magenta indicates a variable. For enum type variables, the 
enumerated name follows the hexadecimal value. 
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Variable Window Menus 

Search dialog box, 
finding the string top­
>next-> *stringPtr in the 
Variable window 

Variable window 
showing Edit field on 
the value of the *next 
symbol 

Some items are on/off toggles, on when a check mark ( ,./) appears. 
Others take immediate action. Items with ellipses pop-up dialog boxes. 

Menu Use To: 

File Close the Variable window. 

Edit Find and edit a listed variable. 

View Reorganize or refresh the display. 

Variable Add or remove variables from the display. 

Windows Open another SLD window. 

Help Open a window for help with the SLD software. 

Edit Menu 

.s_earch ... 
Search Next 

Edit 

Search ••• opens a dialog box to find a variable in the display. The case­
sensitive search stops at the first occurrence or at the end of the display. 

--------
Search 

.[earch for: 

I .. '. 

I !lK I I;.ancel I !ielp I 

Search Next finds the next occurrence of the last variable searched for. 

Edit puts an edit field on an editable (red) value. Type a new value in 
the field. Floating-point values use floating-point format. Characters 
use hexadecimal or ASCII. Integers use decimal or hexadecimal. 

LI HKS *top { 
struct LIHKS *next = DS:~ 
signed char *StringPtr = DS:OOOO; 
signed short int length = OxO = O; 
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View menu showing 
Sort sub-menu to 
display variables in the 
order they are added to 
the Variable window 

Variable window 
dereferencing the 
*stringPtr pointer 

Variable window in 
compressed mode 

Variable menu 

SW User's Manual 

View Menu 

~how 

.Qompress 
Refresh Display 

I By History 
By Name 

Show adds a line to the Variable window dereferencing the selected 
variable. This item is available when you have put the Variable cursor 
on a dereferenceable (blue) symbol, such as a pointer. 

•11.li• 
file J;.dit l[iew V.!!_riable Y'!"indows !:felp 

LIHKS *top { 

} 

struct LIHKS *next = DS:OOOO; 
signed char *StringPtr = DS:OOOO; 
signed short int length = OxD = o; 

H 
signed char top->*stringPtr = Ox O = ""; ~ 

~l ~ 

Compress collapses multi-line variables to the first line. 

il1J•I. ~ . 
file J;.dit l[iew V.!!_riable Y'!"indows !:felp 

LIHKS *top { • H 

f-+-1 
•II I• 

Refresh Display updates the displayed symbols and values. 

Sort opens a sub-menu to arrange the variables: 

By History in the order they were added to the display. 

By Variable Name alphabetically. 

Variable Menu 

Md ... 
Qelete 
l!ndelete 

Add ••• opens a dialog box to add a variable name to the display. 
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Add dialog box to 
display the bufCount 
variable from the 
printall function 

Add Variable 

Y.ariable: 

1am1omn;m;,o 

QK I ~ancel I J::!.elp 

Delete removes the selected variable from the display. 

Undelete restores to the display the last variable removed. 
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Breakpoint Window Ref ere nee 
il~~~~~~~~~~~B-re-ak_p_o-in-t~~~~~~~~~~-11-iil 

file f!.reakpoints Windows .!::!elp 
Set JL Clear J~o To Sourc~[ Enable JL Disable Jl Enable All JL Disable All 

State l)tii_e Brealg1oints .. . . rnillIBlillil I . :io:1 
Enable Perm. 0000200FL dm main,main,line67,col0-1 

J 
Enable Perm. 000020FCL dm=func,printall,line153,col0-1 

Breakpoint Window Contents 

The Breakpoint window displays the following information about each 
breakpoint: 

State Whether the breakpoint will cause a break (Enable) or 
not (Disable) when emulation executes through the 
code where the breakpoint is located. 

Type 

Breakpoints 

Whether the breakpoint will remain defined (Perm.) 
or be removed (Temp.) after causing a break. 

The load address, module name, function name, 
source line number, and source column number where 
the breakpoint is located. The column number can be 
affected by the number of spaces the compiler and 
emulator use for tab characters (the Tab Width). 

Breakpoint Window Menus 

SW User's Manual 

Some items are on/off toggles, on when a check mark ( ./) appears. 
Others take immediate action. Items with ellipses pop-up dialog boxes. 

Menu Use To: 

File Exit the Breakpoint window. 

Breakpoints Define, remove, enable, and disable breakpoints. 

Windows Open another SLD window. 

Help Open a window for help with the SLD software. 
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Breakpoints menu with 
all items enabled, 
indicating at least one 
breakpoint is defined 

Set Breakpoint dialog 
box defining a 
permanent, initially 
enabled breakpoint at 
the first instruction of 
the printall function in 
the dm_func module 

File Menu 

Exit closes the Breakpoint window. 

Breakpoints Menu 

The items available in the Breakpoints menu depend on whether 
breakpoints are defined and selected. Set Breakpoint... and Go To 
Source are always available; Clear, Enable, and Disable are available 
when you have selected a breakpoint from those listed in the Breakpoint 
window; Clear All, Enable All, and Disable All are available when one 
or more breakpoints are listed. To select a breakpoint, click on it or use 
the <Up Arrow> and <Down Arrow> keys to move the highlight. 

Set .6.reakpoint. .. 

!:;I ear 
.Enable 
Qisable 

Clear .811 
Enable All 
Disable All 

.Go To Source 

Set Breakpoint opens a dialog box to define a new breakpoint. 
~--~~~~~~--~~ 

Set Breakpoint 

f!.reakpoint at: 1~nm1mmnnm11 I 
Modules Eunctions 

ldm_func l"'I lprintall l"'I 
rStAte rT)(Pe Spacg_: 

@Enable @ E.ermanent I user l"'I 
0 Q.isable 0 Iemporary 

I .S,et I I Clg_se I I !:!.elp I 

Fill-in the dialog box as follows: 

Breakpoint at: a numeric or symbolic address. You can choose a 
module and function from the drop-down list boxes. 

State toggled to Enable or Disable. The emulator ignores a 
disabled breakpoint. 

Type permanent or temporary. A temporary breakpoint is 
removed after it causes the break. 

Space: User or SMM, depending on the processor. 
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Choose the Set button to define the breakpoint or the Close button to 
close the dialog box without defining a new breakpoint. 

Clear removes the selected breakpoint. 

Disable marks the selected breakpoint to be ignored when emulation 
executes through the code where the breakpoint is located. 

Enable marks the selected breakpoint to cause a break when emulation 
executes through the code where the breakpoint is located. 

Disable All disables, without removing, all breakpoints. 

Enable All enables all breakpoints. 

Clear All removes all breakpoints. No breakpoints remain defined. 

Go to Source opens the Source window, described in the "Source 
Window Reference" chapter, and positions the source cursor at the 
specified breakpoint. 

Breakpoint Window Buttons 

SW User's Manual 

These buttons provide quick access to commonly used Breakpoints 
menu items, described earlier in this chapter. 

Set Clear lfuo To Sourcdl Enable II Disable II Enable All II Disable All II 

Button Use To: 

Set Open a dialog box to set a breakpoint, the same as the 
Breakpoints menu Set Breakpoint... item 

Clear Remove a selected breakpoint, the same as the 
Breakpoints menu Clear item. 

Go To Source Open the Source window to show the specified 
breakpoint in source or disassembly, the same as the 
Breakpoints menu Go To Source item. 

Enable Define that the specified breakpoint will cause a 
break next time it is encountered in emulation, the 
same as the Breakpoints menu Enable item. 

Disable Define that the specified breakpoint will cause no 
break next time it is encountered in emulation, the 
same as the Breakpoints menu Disable item. 

Enable All Enable all breakpoints, the same as the Breakpoints 
menu Enable All item. 

Disable All Disable all breakpoints, the same as the Breakpoints 
menu Disable All item. 
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Stack Window Ref ere nee 

file Qptions Windows !:!elp 

Stack Return 50.0% 
SS:000005CC CS:FFFFE40C remove ... 
SS:00000508 CS:FFFFE315 main( ... ) 

Parameters & Local Uariables 
signed long remouenplace = 0x3 = 3; ~ 
signed long remoueni = 0x0 = 0; 
struct LINKS *remouenptr DS:000001DA; 
struct LINKS *remouencur = OS:00000158; 

Stack Window Contents 

The Stack window has three panes: 

SW User's Manual 

Frame List 

Parameters and 
Local Variables 

Stack Meter 

lists the stack address, the return address, and the 
name of each function on the current call stack. 
Each line is a stack frame. 

lists the type, name, and value of each parameter 
and local variable in the selected stack frame. The 
format and colors are the same as in the Variable 
window. 

graphically shows the stack usage statistics, 
including the percent of the stack area currently in 
use, an alarm marker at a specified usage level, and 
a mark at the highest percent usage for the current 
emulation. 
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Stack Window Menus 

Options menu with all 
stack statistical options 
enabled 

Stack Area dialog box 
setting the base 
address and size of 
the area to be 
monitored for stack 
activity 

Some items are on/off toggles, on when a check mark ( ~) appears. 
Others take immediate action. Items with ellipses pop-up dialog boxes. 

Menu 

File 

Options 

Use To: 

Close the Stack window; refresh the stack display. 

Configure the stack area; toggle the Frame List address 
display; manage stack usage statistics; inspect the 
source. 

Windows Open another SLD window. 

Help Open a window for help on the SLD software. 

File Menu 

Refresh Display reads memory and updates the displayed information. 

Exit closes the Stack window. 

Options Menu 

Alarm Limit ... 

,/Include S!ack Address 
,/Include Return .C.ode Address 

,/Enable !:!.igh-Water Mark 
,/Enable Alarm Limit 

Inspect Source 

Stack Area .•• opens a dialog box to set the stack base address and size. 
-------

Stack Area 

Base Address: 
1unt~11111um1~1111 

Number of Bytes: 

11504 

.QK I .Qancel I !!elp 

Alarm Limit ••• opens a dialog box to define the alarm limit as a 
percentage (1 to 100) of the Stack Meter. 
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Alarm Limit dialog box 
setting the alarm at 
95% of the monitored 
stack area 

SW User's Manual 

Alarm Limit 

eercent of Size (1 - 100%): 

l[ilil 
OK l hancel I t!elp 

Include Stack Address, when checked, displays stack addresses in the 
Frame List, in a column labeled Stack. The stack address is the address 
of the frame in the stack area 

Include Return Code Address, when checked, displays code addresses 
in the Frame List, in a column labeled Return. The code address is the 
return address to the calling function. 

Enable High Water Mark, when checked, displays the high-water 
mark on the Stack Meter. The high-water mark indicates the highest 
percentage that has been used of the stack area. 

Enable Alarm Limit displays a warning message each time emulation 
stops while the alarm limit is exceeded. 

Inspect Source opens the Source window, described in the "Source 
Window Reference" chapter, and positions the Source cursor to show 
the selected function's source. To select a function, in the Frame List 
click on the frame or use the <Up Arrow> and <Down Arrow> keys to 
move the highlight. 
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CPU Window Reference 

Qptions 
EFLtlCS 00000002 

urnOoditszapc ~ 
EIP FFFFE3E4 
EtlX 00000000 
EBX 00000000 
ECX 00000000 
EDX 00000000 
EBP 000005EO 
ESP 000005EO 
EDI 00000000 
ESI 00000000 
cs 0018 
DS 0020 
ES 0020 
FS 0020 
cs 0020 
SS 0020 

CDTBtlSE FFFFEOOO 
CDTLIHIT 003F 

CDTtlR FFFFEOOO 
IDTBtlSE 000005EO 

IDT LIMIT DOFF 
IDTtlR FFFFFFFF 

LDTR 0000 
LDTBtlSE 00000000 

LDTLIMIT FFFF 
LDTtlR FFFF7FFF • 

CPU Window Contents 

Register Edit dialog 
box for changing the 
EIP register 

SW User's Manual 

The CPU window lists the processor registers by mnemonic. Different 
registers appear for different processors, as listed in the Hardware 
Reference. The register values are updated and the changed values 
highlighted each time emulation halts. 

To edit the register values, double-click on a register value; or, move 
the cursor with <Up Arrow> and <Down Arrow> then press <Enter>. 

Register: PC 

Hex: 000006A2, Decimal: 1698 

I U§1UUUHld·!'4 

OK ~ancel Help 
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Options Menu 

Options menu showing 
the EA-486 signals 
controlled by the 
emulator 

R.eset 
Reset CPU .Qnly 

-.f RUY# Enable 
,/BESET Enable 

Yiindows ,__ ____ ___,,/ .!:!OLD Enable 

Help 1ndex -.f NMI Enable 
.!::!elp With Help ,f 1NTR Enable 
Help With .CPU ,/ 820M# Enable 

,/ fLUSH# Enable 
,__E_~_it ___ ___,,f ~EN# Enable 

,/ .S.LE Enable 

Reset resets and reinitializes the target processor: 

• The processor RESET pin is asserted. 

• The program counter is read from memory; the Source window is 
scrolled to the beginning of code. 

• The stack pointer is read from memory, resetting the stack; the 
Stack window display becomes invalid. 

• All SLD windows are updated. 

Reset CPU Only resets only the processor and does not update the 
windows. Use Reset CPU Only if Reset fails to reset the processor. 

Signals opens a sub-menu to specify whether certain signals are 
controlled by the target (unchecked) or by the emulator (checked). 
Different signals can be enabled for different processors. For a list of 
the signals configurable in your emulator, see the Hardware Reference. 

Windows opens a sub-menu to open another SLD window. This item 
is equivalent to the Windows menu in other SLD windows. 

Help Index opens a window with the table of contents for SLD help. 

Help With Help opens a window on using a Windows help facility. 

Help With CPU opens a window with SLD CPU window help. 

Exit closes the CPU window. 
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Memory Window Reference 

.Eile _Edit Y:iew .Qptions 

DS:OOOO 88~3 CD58 8E2D F200 8839 7A3A C478 33FC •,,[i-%.09,,:z{ • 
DS:0010 F9F8 8FEE 8790 5FA4 5FD5 E9F6 FCC3 eoFo uui 6•·~ o oe 
DS:0020 718F FEB8 E332 9940 AF77 FFBF 67FF 378F iq,,1i2a@i~1-iir 
DS:0030 FFFF FFEA FE85 9AA5 C86E DEEE 888F FF33 yyeyµjl¥1~Ei~· 

Memory Window Menus 

The window title identifies the Memory window by number, describes 
the display format, and identifies the address space. You can have up 
to 20 Memory windows open simultaneously for a variety of views. 

The leftmost column is the address. Address formats differ for different 
processors. To view another area of memory, double-click in the 
address column of the Memory window. Enter a numeric or symbolic 
address in the Go To Address dialog box. Any symbol you enter must 
have a fixed address; you cannot Go To local variables or stack-resident 
parameters. 

The memory contents can be in disassembly or numeric format. 
Numeric format shows the hexadecimal or decimal values and, in the 
rightmost column, the equivalent ASCII values. You can edit memory 
contents directly in the numeric and ASCII formats by positioning the 
cursor (a vertical bar) with the mouse, then overtyping the memory 
display. Disassembly can include symbols; in the Toolbar Configure 
menu, toggle Symbolic Disassembly. 

Memory Window Menus 

Some items are on/off toggles, on when a check mark ( V') appears. 
Others take immediate action. Items with ellipses pop-up dialog boxes. 

Menu 

File 

Edit 

View 

Options 

Memory Window Reference 

Use To: 

Exit the Memory window. 

Edit memory; navigate the memory display. 

Choose numeric or disassembly display formats. 

Manage memory access options. 
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Go To Address dialog 
box for finding address 
O:O in user space 

Search Memory dialog 
box for finding a 
pattern in an address 
range 

Windows Open another SLD window. 

Help Open a window for help with the SLD software. 

Edit Menu 

Go To £1,ddress .. . 
Sgarch Memory .. . 
Eill Memory ... 
.Copy Memory ... 

Go To Address ••• opens a dialog box to change the Memory window 
display to a specified numeric or symbolic address. For some 
processors, you can specify User or SMM space. 

Go To Address 

Address: 

SpacJ;,: OJ!.erand/Address Size: 

I user Iii Iii 
__ Q__K __ l J ~ancel I I !:!elp I 

Search Memory ••. opens a dialog to search a specified address range 
for a specified pattern. The search stops at the first occurrence of the 
pattern in the range. If the pattern is not found, the Memory cursor 
does not move. 

~~~~~~~~~ 

Search Memory 

from 

I_o 

fallern 

OK I Cancel f Help 

Fill Memory ••• opens a dialog box to fill an address range with a 
specified pattern. 
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Fill Memory dialog box 
for writing a repeating 
pattern to an address 
range 

Copy Memory dialog 
box for copying 
memory contents from 
one address range to 
another 

View menu, displaying 
memory contents as 
disassembly 

fu>ace IMH Iii 
~ J ~ancel I J !:!_elp I 

Copy Memory ••• opens a dialog box to copy one address range to 
another or to copy target memory to overlay memory. 

From: 

itart: [ 

I @End 
: 0 bength 

l 
@.Map 

0 !_arget 

View Menu 

Copy Memory 

To: 

J Start: [ 

JI 
@Ma11. 

0 Target 

Sp_!!ce !user l!I OK 

Disgssembly 

Hex Bytes 
I Hex .Words 

Hex.D_Words 
Decimal B'fles 
Decimal W2rds 
Decimal DWords_ 

I Auto 
Usel6 
UseJ.2 

I .!.!.ser 
S.MM 

Refresh Display 

J 
Space luser 1~J 

•mm }J 

I J;;,ancel I I !:!_elp 

Disassembly displays memory disassembled. In Disassembly view, you 
can double-click on a disassembled line to open the Single Line 
Assembler dialog box (described later in this chapter). 

Hex Bytes displays memory as hexadecimal 8-bit integers with values 
from 0 to FF. 

Memory Window Reference 185 SW User's Manual 



Options menu, 
specifying 8-bit 
memory access and 
verification of memory 
writes 

Hex Words displays memory as hexadecimal 16-bit integers with 
values from 0 to FFFF. 

Hex Dwords displays memory as hexadecimal 32-bit integers with 
values from 0 to FFFFFFFF. 

Decimal Bytes displays memory as decimal 8-bit integers with values 
from 0 to 255. 

Decimal Words displays memory as decimal 16-bit integers with 
values from 0 to 65,535. 

Decimal DWords displays memory as decimal 32-bit integers with 
values from 0 to 4,294,967,295. 

Auto uses the pmode to determine whether operands and addresses are 
interpreted as 16-bit or 32-bit values. For a description of pmodes, see 
the Hardware Reference. 

Use16 interprets operands and addresses as 16-bit values. 

Use32 interprets operands and addresses as 32-bit values. 

User displays processor user memory. 

SMM displays processor system management mode memory (available 
in some processors). 

Refresh Display re-reads memory and refreshes the screen. This 
happens automatically when emulation halts. 

To update or scroll the Memory window during emulation, enable Run 
Access before starting emulation. Check the Toolbar Configure menu 
Enable Run Access item; or enter a RunAccess Shell command. 

Any run-time memory access, such as that used to update the Memory 
window, takes a small amount of time from the processor and thus can 
degrade your program performance. 

Options Menu 

• 
.f ftyte Access 

Word Access 
.!).Word Access 

.f Write ~erify 

Bead Ahead 

R~read On Write 

Byte Access specifies 8-bit cycles for memory access. 
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Word Access specifies 16-bit cycles for memory access. For writing a 
byte, the word containing the byte is read, the appropriate byte replaced, 
and the word re-written. Words at even addresses are read and written 
as words. Words at odd addresses are read and written as two words. 
For example, for writing a word of data at an odd address: 

1. The word containing the first byte (odd address minus 1) is read. 

2. The lower byte of the data is put into the upper byte of the word. 

3. The word is re-written at odd address minus 1. 

4. The word containing the second byte (odd address plus 1) is read. 

5. The upper byte of the data is put into the lower byte of the word. 

6. The word is re-written at odd address plus 1. 

DWord Access specifies two 16-bit cycles for memory access. Long­
word memory writes act as follows: 

1. Long-word writes on long-word boundaries use long accesses. 

2. Word writes and byte writes read long words, replace the byte or 
word, and write back as long words. 

Set the memory access size to long (dword) for faster loading. 

Write Verify, when checked, compares any value written with write, 
fill, or copy with the expected value and reports discrepancies. 

Toggling Write Verify does not affect load verification. Use the verify 
Shell command to toggle load verification. With Verify=On, a byte 
read back that does not match the byte written returns an error. 

Read Ahead, when checked, reads ahead and caches more data than is 
displayed in the Memory window screen, for faster scrolling. 

With read-ahead enabled, scrolling through peripheral registers or near 
invalid memory regions can cause Unterminated Memory Access 
errors. 

Reread On Write, when checked, refreshes the memory display when 
you edit the numeric or ASCII fields in the display. Toggling Reread 
On Write does not affect Memory window refreshing for memory 
changes done outside of the memory display. For example, load, fill, 
write, and copy operations always refresh the memory display. 

Single-Line Assembler Dialog Box 

You can patch code into memory an assembly-line at a time with the 
single-line assembler. With the Memory window in Disassembly view, 
double-click on the line you want to replace. 
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Single-Line Assembly 
dialog box, assembling 
a DEC instruction at 
location CS:FFF3 

----
Single-Line Assembly 

~ource Line: CS:FFF3 

I• 
Spac~: Op_erand/Address Size: 

I user 0 
j ~ancel I Assem I S!>;ip I j !::!elp I 

Type a line of assembly language in the text box. 

Source Line: shows the address where the line will be assembled. 

Space: for some processors, can be User or SMM. 

Operand/ is unavailable. 
Address Size: 

Cancel closes the single-line assembler dialog box without 
assembling. Once you have assembled a line, this 
button changes to Done. Choosing Done closes the 
dialog box; your assembled changes remain in 
memory. 

Assem 

Skip 

Help 

assembles the line into memory; advances the address. 

advances the address without assembling the line. 

opens a window for help on the single-line assembler. 
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Peripheral Window Ref ere nee 

Eile J;dit 1,'iew ~indows Help 
+ OMA 

[+) MST 
[+) TMR 
[+) SLV 
[+) CO Ml 
(+) COM2 
(+) PORT92 
(+) CSU 
(+) SSIO 
[+) RFSH 
(+) WOT 
[+) CLK 
(+) CCR 
(+) PIO 

.. • 

Peripheral Window Contents 

Different peripherals are supported for different processors. 

The Peripheral window shows the peripheral register information 
heirarchically. Click on the ( +) or(-) at the left of a line to expand or 
collapse the hierarchy. At the top level (the only level visible when the 
heirarchy is fully collapsed) are the peripherals. Expanding a 
peripheral shows its registers. Expanding a register shows its bit fields. 
Full expansion lists the register address, bit field bit position, value, 
name (mnemonic), and description. 

Peripheral Window Menus 

Some items are on/off toggles, on when a check mark (v') appears. 
Others take immediate action. Items with ellipses pop-up dialog boxes. 

Menu Use To: 

File Exit from the Peripheral window. 

Edit Edit a register; navigate the Peripheral display. 

View Refresh, expand, or compress the display. 

Windows Open another SLD window. 

Help Open a window for help with the SLD software. 
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Go To Peripheral 
dialog box for finding a 
peripheral by name 

Go To Register dialog 
box for finding a 
peripheral register by 
name 

Go To Address dialog 
box for finding a 
peripheral register by 
hexadecimal address 

Edit Menu 

Register ... 
Go To Eeripheral. .. 
Go To Begister .. . 
Go To Address .. . 

Register ••• opens a Register Edit dialog box (described later in this 
chapter) to edit the selected register. To select a register or bit field, use 
the mouse or <Up Arrow> and <Down Arrow> keys to move the 
highlight. Selecting a peripheral selects its the first register. 

Go To Peripheral ••• opens a dialog box to scroll to the peripheral 
specified by name. 

Go To Peripheral 

eeripheral Name: 

I .QK I ~ancel 11 t!elp I 
Go To Register ••• opens a dialog box to scroll to the register specified 
byname. 

Go To Register 

Register Name: 

.QK J ~ancel 11 t!elp I 

Go To Address ••• opens a dialog box to scroll to the register specifed by 
address. 

Go To Address 

Address: 

.QK !;.ancel t!elp 
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View menu 

View Menu 

J;xpand All 
~ompress All 

Refresh Display 

Expand All expands the hierarchy completely, showing all peripheral, 
register, and bit field mnemonics, with the addresses or bit positions, 
values, and descriptions of the registers and bit fields. 

Compress All collapses the hierarchy completely, showing only the 
peripheral mnemonics. 

Refresh Display re-reads the readable registers and refreshes the 
screen. This also occurs automatically when emulation halts. 

To update or scroll the Peripheral window during emulation, enable 
Run Access before emulating. Check the Toolbar Configure menu 
Enable Run Access item; or enter a RunAccess Shell command. Any 
run-time memory access, such as that used to update the Peripheral 
window, takes a small amount of time from the processor and thus can 
degrade your program performance. 

Write-only register fields display the most recent value you entered 
using the Peripheral or Shell window interface. Values written by 
program execution are not captured by the emulator. 

Register Edit Dialog Boxes 

Register Edit dialog 
box for changing the 
CSO low address 
register value 

Different registers have different field values. 
---------

CSU CSOADL - Chip-select 0 Low Address Register 

Begister Value: I• 
~----~ 

fields: 
CA5:1 address bits 5:1 
CASMM 
BS16 
MEM 
ROY 
reserve 
WS4:0 

activate channel only if not in SMM mode 
enable the automatic BSB# signal generation. 
1/0 bus cycle 
external READY# ignored. 
must be zeros 
wail states 

Field Value: 15: Chip-select 0 lower 5 address bits 
I OxO 1$1 address bits 5:1 

~rile 11 ~lose I I « erev 11 Next» I I !::!elp 
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Register Value shows the register contents in hexadecimal. You can 
edit this field. 

Fields 

Field Value 

lists each bit field mnemonic in the register and its 
effect on the processor. To select a bit field, click or 
use the <Up Arrow> and <Down Arrow> keys to move 
the highlight. 

is a spin box showing the value of the bit field selected 
in the Fields box. You can edit this field. To ensure 
you enter an acceptable value for the bit field, click on 
the spin arrows or use the <Up Arrow> and <Down 
Arrow> keys to change the value. Editing the Field 
Value changes the Register Value. 

The selected bit field position and a description of the bit field 
according to its current value are listed under the Fields box, to the 
right of the Field Value spin box. This description changes when you 
change the bit field value. 

Write writes the value shown in Register Value:. 

Close closes the Register Edit dialog box. 

<<Prev displays the Register Edit dialog box for the previous 
register in the Peripheral window list. 

Next>> displays the Register Edit dialog box for the next register in 
the Peripheral window list. 

Help opens a help window on the Register Edit dialog box. 
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Trace Window Ref ere nee 

file .Edit Yiew Irace Tjmestamp _Goto 'f{indows Help 

times tamp 

-'l'I -1. 3200 us 
-'13 -1. 3200 us 
-'12 -1. 2800 us 
-'11 -1. 2'100 us 

l .. ll 

9 
a address 
p 

00002130 
00002130 
00002130 
00002130 

bbbb mdw rb bbsk hh rsni pp ae f p b f xxxxxxxx 
data eeee icr dr slme 11 srmn cw ha e c o 1 ....... . 

3210 o yy 86an da tsit dt ld r k f u 0123'1567 r-:-
000E0000 1110 ICW 01 1110 00 0000 10 01 1 1 1 1 00000000 ~ 
0F010ss3 0000 MCR 01 1110 00 0000 10 01 1 1 1 1 00000000f-'-
01FG'IGS3 0000 MCR 01 1110 00 0000 10 01 1 1 000000001--
01FG'l683 0000 MCR 01 1110 00 0000 10 01 1 1 00000000~ .. 

Trace Window Contents 

Trace features differ between the PP, EA, and SW emulators. Different 
signals are available for different processors. Grayed-out menu names 
and items indicate unavailable features. 

The Trace window has three views: 

Bus 

Clock 

Instruction 

displays every cycle of bus activity. 

(PP, EA) displays address, data, and processor status 
signals aligned on clock cycles. 

displays disassembled instructions. The first 
instruction must follow a change in execution flow. 

Each trace frame (one line in the Trace window) contains the following 
information, in columns from left to right: 

Frame number The number of the trace frame relative to the clock 
cycle on which tracing stopped. The frame number 
increments by one for each captured frame. For 
unqualified trace, a frame is captured on each clock or 
bus cycle. EA qualified trace captures a frame on 
each cycle meeting the qualification criteria. In 
instruction and bus views, the frame numbers are 
discontinuous because multiple clock cycles make up 
a single bus or instruction frame. 

Timestamp (PP, EA) The time the trace frame occurred, relative 
to a specified frame or time. 

Address The value on the address bus. 

In bus or clock view: 
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Data 

Signals 

The value on the data bus 

The values of processor-specific signals. The signal 
mnemonic labels are formatted vertically. For a list of 
traced signals, see the Hardware Reference. 

In instruction view, disassembly is shown instead of data and signals. 
Also, the number of clock cycles between instruction frames describes 
how many cycles have elapsed between signals appearing on the target 
processor external pins (for example, the number of cycles between 
successive prefetches); this number does not, for example, report how 
many clocks the processor used to execute an instruction. 

Trace Window Menus 

File menu 

Some items are on/off toggles, on when a check mark (,I) appears. 
Others take immediate action. Items with ellipses pop-up dialog boxes. 

Menu 

File 

Edit 

View 

Trace 

Times tam 
p 

Goto 

Windows 

Help 

File Menu 

Use To: 

Save trace to a buffer; close the Trace window. 

Open the Event window; search for an event; clear trace. 

Configure the trace display; link the Source window 
display to scroll with the Trace window cursor. 

Control and configure trace capture. 

Configure the timestamp and the system clock 
frequency. 

Navigate through the Trace buffer. 

Open another SLD window. 

Open a window for help on the SLD software. 

Save As •.• opens a dialog box to save the trace buffer to a file. Enter 
the filename. If a file with the specified name already exists, it will be 
overwritten. The (Trace) Save As dialog box differs between emulators: 

File Name: 

Save Format 

is the drive, directory, and filename you specified in 
the first dialog box. You can edit this string. 

(PP) saves the trace in bus, clock (when available), or 
instruction format. 

Trace Window Reference 194 SW User's Manual 



PP Edit menu, with 
Events and Search 
items available 

PP Search Buffer 
dialog box to search 
for event ev1 in trace 
buffer 0, from frame 
-105 to the end of the 
buffer 

Buffer 

Frame 

(PP) with multiple buffers configured, saves a 
specified range of buffers. 

(PP) saves a specified range of frames. 

Exit closes the Trace window. 

Edit Menu 

E~ents .. . 
Sgarch .. . 

.QlearTrace 

Events ••• opens the Event window. 

Search ... opens a dialog box to find an event in the currently displayed 
trace buffer. For PP emulators, the title bar shows the buffer searched. 

Search Event 

Start Frame 

Search Buffer: 0 

!;!.earch Event: I evl li.J 
:======~ 

Start frame: l~-1_0_5 ___ ~1 

QK !;_ancel I ttelp 

select an event from the list of defined events. 

select the frame to start searching. 

Clear Trace clears all trace buffers and resets the buffer pointer to 
zero. (The current trace buffer is automatically cleared and reset when 
you start emulating or tracing.) 

View Menu 

Different items are available for different emulators. 
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PP view menu 
displaying trace as 
clock cycles, 
displaying timestamps, 
and collecting BTM 
cycles to allow 
disassembly 
(Instruction instead of 
Clock view) 

J .Clock 
_6.us 
lnstruction 

J .Linked Cursor 

J BTM cycles 

J Iimestamp 

J 8uto 
Usel6 
Use~2 

Clock (PP, EA) displays trace as clock cycles. Capture trace in clock 
mode for clock cycle display. 

Bus displays trace as bus cycles. Trace captured in bus mode can be 
displayed only as bus cycles. 

Instruction displays trace as disassembly . Capture trace in clock mode 
and capture branch trace messages for instruction mode display. 
Frames prior to any such messages cannot be disassembled. To capture 
branch trace messages, in the PP enable the View menu BTM cycles 
item or in the EA enable the Trace menu Trace Capture dialog box 
Instruction Mode Assist. 

Linked Cursor synchronizes the Source and Trace window cursors, so 
scrolling the Trace window displays the corresponding code in the 
Source window. This feature is available only in instruction view. 

BTM Cycles (PP) generates Intel-x86 BTM cycles and collects them in 
trace. A BTM cycle is a special bus cycle executed by the Intel bondout 
processor when execution is discontinuous (e.g., at a jump, call, 
interrupt, or return). BTM generation degrades real-time execution 
slightly. For trace to be displayed as instructions, BTM cycles must be 
collected. Toggling BTM Cycles clears the trace buffer. 

Timestamp displays the timestamps. 

Auto uses the pmode to determine whether operands and addresses are 
interpreted as 16-bit or 32-bit values. 

Use16 interprets operands and addresses as 16-bit values. 

Use32 interprets operands and addresses as 32-bit values. 

Trace Menu 

The Trace menu differs between emulators. 
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EA Trace menu, with 
Trace Capture item 
instead of PP Trace 
Control 

PP Trace Control 
dialog box with one 
buffer configured and 
the trigger positioned 
near the end of the 
buffer 

~tart 

Sto11 

Irace Capture ... 

F3 
F4 

Start (or pressing the F3 key) starts trace collection. This occurs 
automatically when emulation begins. 

Stop (or pressing the F4 key) stops trace collection. 

Trace Control .•. (PP) opens a dialog box to configure how trace 
information is collected. 

Trace Control 

D H.!!11 When Last Trace Buffer Full 

IIrigger Position 

L @ E're 0 Center 0 Po?.t 

Nymber of Trace Buffers [x Size) 
@ 1 (x256KJ 0 B (x32KJ 

0 2 (x128KJ 0 16 [x16KJ 

0 4 (x64KJ 0 32 (xBKJ 

0 64 [x4KJ 

0 128 [x2KJ 

0 256 (xlKJ 

[Qi(] I .C.ancel I I !::lelp I 

Halt When Last stops emulation after the last trace buffer has been 
Trace Buffer Full filled. This overwrites the first trace buffer. 

Trigger Position positions the trigger frame in the trace buffer: 

Number of Trace 
Buffers (x Size) 

Pre collects cycles before the trigger. The 
event appears near the end of the buffer. 

Center collects cycles before and after the trigger. 
The event appears in the middle of the 
buffer. 

Post collects cycles after the trigger. The event 
appears near the beginning of the buffer. 

with 256 bytes of trace memory installed, 
configures 256 trace buffers each of which is lK 
byte (512 frames) long, or a single trace buffer 
256K bytes long, or any of various combinations 
in between. With 128K bytes of trace memory, 
you have the same choices for number of buffers 
but each buffer is half the size. 

Trace Capture ... (EA) opens a dialog box to configure how trace 
information is collected. 
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Trace Capture dialog 
box to: 

• position the trigger 
as the last frame 

• collect trace as 
clock cycles 

• include branch 
trace messages 

• start tracing when 
emulation starts 

Trigger Position 

Trace Capture 

rTrigger Position- rCapture Mode -i 

@[ei~J @ Clock Cycles 

0 Center 0 J!us Cycles 

0Po.l!_t 

l2J tnstruction Mode Assist 

l2J Collect Irace When Emulation Starts 

.Q_K I I .Qancel [ I .!:!_elp 

positions the trigger frame (the frame matching 
a Trigger window condition with a Trig action) 
in the trace buffer: 

Pre saves any frames before the trigger to 
the limit of the trace buffer and stops 
trace after the trigger. 

Center stops trace 125000 clocks after the 
trigger. 

Post stops trace 250000 clocks after the 
trigger. 

For Center and Post collection, the number of 
frames collected after the trigger depends on 
whether trace is initially on, qualified, or turned 
on or off during the time limit. Frames before 
the trigger are lost only as needed to make room 
for frames after the trigger. 

Capture Mode collects trace as clock or bus cycles. Trace 
collected as bus cycles can be viewed only as 
bus cycles 

Instruction Mode collects branch trace messages generated when 
Assist execution flow is discontinuous. Such messages 

provide address synchronization necessary for 
disassembly. 

Collect Trace When starts trace collection when emulation starts 
Emulation Starts rather than waiting for a manual start or trigger 

action. 

Timestamp Menu 
Timestamp is available for PP and EA emulators. 
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EA Timestamp menu 
calculating timestamps 
relative to a base frame 
specified in Zero At 
Frame 

PP Setup dialog box 
specifying the system 
clock frequency as 
25.000 MHz 

llbsolute 
J Relative To Frame 

Qelta 

Zero At Frame ... 

./ Rgset Timestamp When Halted 

Reset Iimestamp Now 

Relative To Frame shows timestamps as elapsed time from a base 
frame specified in Zero At Frame. 

Delta shows timestamps as incremental time between frames. 

Absolute (EA) shows timestamps as elapsed time from the last 
timestamp reset. 

Zero At Frame ••• sets the base frame for calculating the Relative To 
Frame timestamp. In the trace display, the zero frame is marked with 
dashes(--). 

Setup ••• (PP) opens a Setup dialog box to set the system clock 
frequency, used in calculating the PP timestamp. Enter a floating-point 
value from 0.01 Hz to 40 MHz. 

lemm 

OK I !;_ancel 

®MHz 

O_t:;Hz 

OH;:_ 

.!::!elp 

The EA timestamp increments at a constant rate of 33 MHz, 
independent of the system clock. 

Reset Timestamp Now (EA) resets the timestamp to 0. 

Reset Timestamp When Halted (EA) resets the timestamp every time 
emulation halts. 

Goto Menu 
The Trigger Frame is available for EA and PP emulators. 

Multiple buffer navigation (Next Buffer, Previous Buffer, and Buffer ... ) 
is available for PP emulators when multiple buffers are configured. 
Frame navigation (Start Frame, Trigger Frame, and End Frame) apply 
to the current buffer. 
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PP Goto menu with 
multiple buffers 
configured 

Frame dialog box for 
finding a frame 
number 

PP Buffer dialog box, 
with four buffers 
configured, for 
displaying buffer O 

EA emulator qualified trace captures separate frames or blocks of 
frames in a single buffer rather than separate blocks of frames in 
separate buffers. Use frame navigation to find specific events. 

.S.tart Frame 
Irigger Frame 
.End Frame 
frame ... 
Next Buffer 
frevious Buffer 
B.uffer ... 

Start Frame scrolls to the first frame. 

Trigger Frame (EA, PP) scrolls to the trigger frame. 

End Frame scrolls to the last frame. 

Frame ••• opens a dialog box to scroll to a specified frame in the 
displayed trace buffer. 

Frnme 

Erame Number: 
OK 

(-2 to 26315) 
.Cancel 

l!il tlelp 

Previous Buffer (PP) displays the next lower numbered buffer. 

Next Buffer (PP) displays the next higher numbered buffer. 

Buffer ••. (PP) opens a dialog box to display the specified buffer. 
-----

Buffer 

Irace Buffer: 
OK 

(0 to 3) 
!;,ancel 

1~ tlelp 
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Event Window Ref ere nee 
Event: evl a 

Eile _Edit Windows !:!elp 

Active Event:! ~e_vl _______ ~liJ-
not start ® End Addr 0 Length mask 

addr: D l~ox_O_I -----~I ~I O-xF_F _____ .....____,l !ox3FFFFFF I 
start end mask 

data: D ~I ox_0_05_5 _____ ~[ l~ox_O_OM-----~l loxFFFF I 

OlX OlX OlX OlX OlX 

0 0 @ BHE# 0 0 @ RESET 0 0 @ BUSY# 0 0 @ P2.1 0 0 @ P3.1 
0 0 @ M/10# 0 0 @ NMI 0 0 @ ERROR# 0 0 @ P2.2 0 0 @ P3.2 
0 0 @ DIC# 0 0 @ INT.ti 0 0 @> PEREO 0 0 @ P2.3 0 0 @ P3.3 
0 0 @ W/R# 0 0 @ INT5 0 0 @ CS6# 0 0 @ P2.4 0 0 @ P3.4 
0 0 @ ADS# 0 0 @ INT6 0 0 @ Pl .5 0 0 @ P2.5 0 0 @ P3.5 
0 0 @ READY# 0 0 @ INT7 0 0 @ Pl .6 0 0 @ P2.6 0 0 @ P3.6 
0 0 @ NA# 0 0 @ SMI# 0 0 @ Pl.7 0 0 @ P2.7 0 0@ P3.7 
0 0 @ BSB# 0 0 @ SMIACT# 0 0 @ P2.0 0 0 @ P3.0 

Event Window Contents 

Events are available for EA and PP emulators. Different signals are 
available for different processors, as listed in the Hardware Reference. 

The Event window defines an event to be used as a condition for 
triggering or as a pattern for searching in trace. The fields are: 

Active Event names the event described in the Event window. This 
name identifies the event in the Trigger and Trace 
windows. 

addr 

data 

mask 

not 

Event Window Reference 

describes a single address or range of numeric or 
symbolic addresses. Select End Addr to specify the last 
location in a range or Length to specify the number of 
bytes in the range. 

describes a data value or range of data values. 

is a hexadecimal value to be bitwise-ANDed with the 
described addresses or data. Use all F's to include all 
contiguous values in the described range. Vary the 
mask to describe a discontinuous pattern of values. 

when checked, defines the event as any memory access 
that does not match the described range or pattern. 
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01 x specifies each signal value as low (0), high (1), or 
don't-care (X). Active-low signals are shown with a 
hash mark (#). The signals available depend on the 
target processor. 

Event Window Menus 

File menu 

Edit menu 

Some items are on/off toggles, on when a check mark ( ,/) appears. 
Others take immediate action. Items with ellipses pop-up dialog boxes. 

Menu Use To: 

File Save and restore events in files; close the Event window. 

Edit Add, delete, and redefine events. 

Windows Open another SLD window. 

Help Open a window for help with the SLD software. 

File Menu 

.S.ave Events As .. . 
Restore Events .. . 
Ei-;it 

Save Events As ••• opens a dialog box to save the events to a file. 

Restore Events ••• opens a dialog box to add events from a previously 
saved file. Currently defined events are not deleted; events with 
duplicate names are overwritten from the file. 

Exit closes the Event window. 

Edit Menu 

8dd Event .. 
.Q.elete Event 
~lear Event 
Dg,lete All Events 

Add Event ••• opens a dialog box to create a new event. Enter the name 
of a new event in the box and choose OK. The new event then appears 
as the Active Event, with all fields cleared, in the Event window. 
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Add Event dialog box 
for naming a new event 

Add Event 

Name: 

f evll 

QK I ~ancel I f !!elp 

Delete Event deletes the currently displayed event. 

Clear clears the event definition fields without deleting the event name 

Delete All Events deletes all currently defined events. 
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Trigger Window Ref ere nee 

file Edit _Qptions Level .Windows Help 

event! ... [Z] D DODD D 
- ! D 

:tD r----+-:t_, D 
:tD 

If----+-!--! D 
:tD 

If----+-!-< D 

rou==JD 
r1u==JD 

ext D 

Trigger Window Contents 

Triggers are available for PP and EA emulators. 

The Trigger window has two panes: 

Condition describes one or more conditions, including events, an 
external trigger-low signal, and either two counter values 
or a timer value. 

Actions specifies one or more actions to be taken for each 
condition met during emulation. When multiple 
conditions are met simultaneously, all associated actions 
are taken. 

The title bar displays a level number from 0 to 3. The level 0 trigger is 
enabled when you start emulation. Each trigger can, as one of its 
actions, disable itself and enable the next level trigger. Thus you can 
define up to four sequential triggers. 
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Trigger condition fields 
showing paired timers, 
paired counters, or a 
single timer 

Condition Fields 

Condition Condition Condition 
event name en ab le e:.i event name enable ext event name enable ext 
event_! :! 13] D event I :! 13'.l D event 1 :! 13] D 

:! D :! D ! D 
:! D :! D :! D 
:! D :! D :! D 
:! D :! D ! D 
:! D :! D :! D 
:! D :! D :! D 
:! D :! D ! D 

jtmroBD 
1tmr1 1 D 
ext D 

cntoBD 
cntl J D 
ext D 

itml I ID 

ext D 

event name Select an event by the name defined in the Event 
window. You can use up to 8 events per trigger. If no 
event is defined when you click on an event name 
condition, the Event Name dialog box appears for 
defining a new event. 

enable Activate a condition. You can define several conditions 
and actions, then vary your triggering scheme by 
enabling them in different combinations. 

ext (This is the ext that appears when an event, timer, or 
counter is enabled.) Specify that the condition must 
occur at the same time as an external trigger signal. The 
PP external trigger is active-low. Set the EA external 
trigger input active-low or active-high with the Options 
menu Trigger In Active items. 

cntO/l To configure the PP Trigger window for a pair of 10-bit 
counters (each with a value range of 1 to 1023), enable 
the Options menu Counter item. To configure the EA 
Trigger window for a pair of 16-bit counters (each with a 
value range of 1 to 65535), enable the Options menu 2 
Counters item. 

Type a target value in a counter field and enable the 
counter. Trigger actions can reset (to 1) or increment 
(by 1) the counter. When the count matches the 
specified number, the counter condition is met and the 
associated actions occur. 

tmrO/l, trnr To configure the EA Trigger window for a pair of 10-bit 
timers, enable the Options menu 2 Timers item. Each 
timer has a value range of 1 to 1023 clock cycles. 

Trigger Window Reference 206 SW User's Manual 



EA trigger action fields 
showing controls for 
paired timers, paired 
counters, or a single 
timer 

ext 

To configure the PP Trigger window for a single 20-bit 
timer, enable the Options menu Timer item. To 
configure the EA Trigger window for a single 32-bit 
timer, enable the Options menu Cascaded Timer item. 
The timer has a value range of 1 to 1,048,575 (PP) or 
4,294,967 ,295 (EA) clock cycles. 

Type a target value in a timer field and enable the timer. 
Trigger actions can start counting clock cycles from the 
current number; stop counting without resetting the 
timer; or reset the timer to 1. You can combine resetting 
with either starting or stopping the PP timer; for such 
combinations in the EA, define two identical conditions. 
When the timer count matches the specified time, the 
timer condition is met and the associated actions occur. 

The timer increments at the clock rate of the emulation 
processor and wraps to 0 after reaching its maximum 
value. To calculate how much time is represented by a 
complete cycle of the timer, use: 

PP _wrap_time = (220) I (clock_period) 

EA_wrap_time = (222) I (clock_period) 

For example, at 25 MHz, the PP timer wraps in about 42 
ms; at 16 MHz, in about 65.5 ms. The EA timer, always 
at 33 MHz, wraps in about 128 seconds. 

(This is the ext in the lower left comer of the Trigger 
window.) Detect an external trigger signal. The PP 
external trigger is active-low. Set the EA external 
trigger input active-low or active-high with the Options 
menu Trigger In Active items. 

Action Fields 

Actions 

DDDDD 

Actions 
se rst brk ton toff trac tri incO rstO incl rstl ei.1 out rst I 

DODOO DODD D 

Actions 
reset ext out rst I 

DDDDD D DD 

seq Disable the current trigger and enable the next level trigger. 
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rst Disable the current trigger and enable the level 0 trigger. 

brk Halt emulation. 

toff (EA) Suspend trace until another tracing command or 
action. 

toff (PP) Fill the current buffer according to the Trace Control 
dialog box settings, then tum trace off until emulation is 
halted and restarted. 

next (PP) With multiple buffers defined, fill the current trace 
buffer according to the Trace Control dialog box settings, 
then start collecting trace in the next buffer. 

ton (EA) Start trace. 

trig (EA) Fill the trace buffer according to the Trace Capture 
dialog box settings, then tum trace off until emulation is 
halted and restarted. 

trac (EA) Collect the current bus or clock cycle. 

incO/l Increment ctrO or ctrl by 1. 

rst0/1 Reset ctrO or ctrl to 0. 

start Start tmr from its current value. 

stop Stop tmr at its current value. 

reset Reset tmr to 0. 

strtO/l (EA) Start tmrO or tmrl from its current value. 

stopO/l (EA) Stop tmrO or tmrl at its current value. 

rst0/1 (EA) Reset tmrO or tmrl to 0. 

ext out (EA) Put a low, high, or open-collector value on the 
external trigger signal. Set the EA external trigger output 
with the Options menu Trigger Out items. 

ext lo/hi (PP) Put a low or high value on the external trigger signal. 

rst ts (EA) Reset the timestamp. 

Trigger Window Menus 

Some items are on/off toggles, on when a check mark ( v') appears. 
Others take immediate action. Items with ellipses pop-up dialog boxes. 

Menu Use To: 

File Exit the Trigger window. 

Edit Specify an event using the Event window. 
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EA Options menu 
configured for 
conditions with 
counters and an 
active-low external 
trigger input; and for 
actions with open­
collector external 
trigger output and bus­
cycle event recognition 

Options 

Level 

Windows 

Help 

Configure the trace buffers; toggle counter/timer 
conditions and actions; toggle bus/clock cycle triggering. 

View a specified trigger level. 

Open another SLD window. 

Open a window for help with the SLD software. 

Edit Menu 

Events ••• opens the Event window 

Options Menu 

Irace Capture ... 

,/ 2 .Qounters 
Z Timers 
C_gscaded Timer 

,/~us 

Clock 

Trigger In Active .!::!igh 
,/ Trigger In Active LQW 

Trigger Out Active High 
Trigger Out Active Low 

,/ Trigger Out .Qpen Collector 

Trace Control ••• (PP) or Trace Capture ••• (EA) opens the Trace 
Control or Trace Capture dialog box, described in the "Trace Window 
Reference" chapter. 

Counter (PP) or 2 Counters (EA) configures two 10-bit (PP) or 16-bit 
(EA) counters for use in trigger conditions and actions. 

Timer (PP) or Cascaded Timer (EA) configures a 20-bit (PP) or 32-bit 
(EA) timer for use in trigger conditions and actions. 

2 Timers (EA) configures two 10-bit (PP) or 16-bit (EA) timers for use 
in trigger conditions and actions. 

Bus lets the trigger recognizes conditions on valid bus cycles only. 
Choose Bus mode except when: 

• tracking hardware bus problems possibly caused by processor 
cycles between valid address, data, or status cycles 

• triggering on the initial transition of a hardware signal 
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Level menu showing 
the first level 

Clock uses clock cycles as trigger conditions. Address, data, and status 
events occur at different clocks. Chose Clock mode for a single event 
that tests conditions including address, data, and status. 

Trigger In Active High (EA) configures the external trigger input 
active high. 

Trigger In Active Low (EA) configures the external trigger input 
active low. 

The Trigger Out (EA) items configure the external trigger output: 

Menu Item Active Inactive 

Trigger Out Active High +5V GND 

Trigger Out Active Low 

Trigger Out Open Collector 

Level Menu 

GND 

GND 

+5V 

Resistor pull-up to +5V 

Choosing a level displays the conditions and actions for that trigger. 

./ Show Level .Q 
Show Levell 
Show Levell 
Show Level 3. 

Level 0 shows the triggers active when emulation starts or after a Rst 
action. 

Level 1 shows the triggers active after a Level 0 trigger's Seq action. 

Level 2 shows the triggers active after a Level 1 trigger's Seq action. 

Level 3 shows the triggers active after a Level 2 trigger's Seq action. 
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Index 

A 

$BREAKCAUSE system variable, 108 
$EMULATING system variable, 108 
$PROCESSOR system variable, 109 
$PROCFAMILY system variable, 109 
$PROCTYPE system variable, 109 
$SHELL_STATUS system variable, 110 
$SYSTEMTYPE system variable, 110 

Active Event, 202 
Add dialog box, 172 
Add Event dialog box, 58, 203 
address 

assembly, 113 
breakpoint, 24, 174 
bus, 193 
event, 57, 58, 201 
function, 32 
load, 11, 111, 157, 158, 166 
mode, 72, 138 
numeric,40 
radix, 96 
register, 190 
Shell commands, 113 
stack, 74, 119, 177, 179 
stack monitoring, 34 
symbol base, 13, 84, 91, 116, 144 
symbolic, 14, 40, 84, 120 
tracing, 51 
translation, 111, 137, 153 
virtual, 14 

AddressOf command, 111 
alarm limit, 33, 74, 118, 119, 124, 145, 

178, 179 
Alarm Limit dialog box, 179 
Alias command, 111 
Always On Top, 75 
Append command, 112 
Asm command, 112 
AsmAddr command, 113 
assembly 

address, 113 
modified code, 29 
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Shell commands, 112, 113 
Single-Line Assembler dialog box, 

185 
source display, 21 

automatic variables, 119 

baud rate, 4, 7, 68 
Bkptcommand, 113 
BkptClear command, 114 
bondout processor, 8, 110 
Borland C, 11 
branch, 60 
break 

cause, 108, 115 
memory access, 10, 89, 136, 137 

breakpoints 
C++, 24 
configuring,26, 175 
hardware (debug registers), 68, 121 
inline functions, 25 
line numbers, 26 
line vs statement, 25 
listing,23 
overview, 23, 161, 173 
removing, 26, 166, 175 
setting, 23, 166, 167, 174, 175 
Shell commands, 113, 114 
source, 23, 175 
tab width, 163 

Browse Modules dialog box, 157 
Browser History Depth dialog box, 164 
BTM Cycles, 51, 60, 77, 79, 196 
Buffer dialog box, 200 
bus 

address, 193 
BusRetry command, 114, 115 
code and data fetches, 127 
contention, 114, 115 
data, 194 
external master, 115 
HLDA,115 
timeout, 114, 115 
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bus cycles, 51, 60, 77, 78, 79, 80, 196, 
198,208,209 

BusRetry command, 114 

C++ 
breakpoints, 24 
documentation, 2 
loading, 13,69, 70,91, 134 
source, 29 
stepping, 28 

cache, 127 
carriage return/linefeed, 72, 164 
Cause command, 115 
chip select registers, 18, 84, 141, 143 
Clear command, 115 
Clipboard, 94 
clock, 77, 78, 199 
clock cycles, 51, 60, 77, 78, 79, 80, 196, 

198,206,207,208,210 
code address, 32 
colors 

Source window, 23, 24, 27 
Stack window, 32 
Variable window, 31, 169 

COM port 
see serial port, 7 

commands 
aliases, 111, 118 
closing the Shell window, 125 
command line, 96 
completion status, 110 
history, 95, 96, 130 
lap timer, 132, 148, 149 
log, 95 
see script, 96 
see Shell commands, 93 
see Shell variables, 93 
see system variables, 93 
syntax, 97 
transcript, 95, 96, 115, 124, 142, 151 

comment lines, 16 
communication 

baud rate, 4, 7, 68 
network, 68, 71 
serial port, 4, 7, 68, 71 

compiler 
see toolchains, 11 
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D 

confidence tests, 139, 150 
Configcommand, 115 
config.sys, 4 
ConfigSymbols command, 116 
contention, 114, 115 
Copy command, 116 
Copy Memory dialog box, 185 
counters, 56 

see trigger actions, 79, 80 
see trigger conditions, 79, 80 

CPU Configuration dialog box, 7, 76 
CPU registers 

access during emulation, 17 
editing, 37, 181 
initializing, 13, 69, 70, 91 
modifying, 139 
reset, 160 
resetting, 38, 160 

CS:EIP 
see program counter, 21 

cursor 
cross-hair in Source window, 23 
editing in Memory window, 183 
emulation control, 160 
linked Source and Trace windows, 

61,77, 78 
location in Source window, 158 
Memory window, 41 
Shell window, 93 
split-box in Source window, 22, 155 

Dasm command, 117 
DasmSym command, 117 
data bus, 194 
debug registers, 68, 121 

breakpoints, 23 
decimal, 96 
Delete command, 118 
descriptor tables 

DT, 122 
GDT, 84, 127 
IDT, 130 
LDT, 84, 132, 133 
loading, 69, 70 
symbol base addresses, 116 
task state segments, 151 

DisableAlarmLirnit command, 118 
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DisableHighWaterMark command, 119 
disassembly 

inline functions, 25 
memory display, 117, 185 
source, 30 
source display, 21, 72, 77, 78, 159, 

196 
stepping into functions, 29 
symbols, 22, 84, 117 
trace, 30 
trace display, 51, 60, 77, 78, 196 

DisplayStack command, 119 
DisplaySymbols command, 120 
DOS newline, 72, 165 
DR command, 121 
DT command, 122 
Dump command, 123 

EA, I 
Echo command, 124 
Edit Path dialog box, 163 
email, 3 
emulation control 

breakpoints, 23 
calls and returns, 27, 128, 129, 160 
examples of triggering, 61 
function keys, 18 
Halt When Last Trace Buffer Full, 

79,80, 197 
lines vs statements, 128, 129 
reset, 141, 160 
script, 108 
see stepping, 28 
source cursor, 160 
Source window, 28, 72, 159, 165 
starting emulation, 27, 128, 129, 141 
status, 28, 108, 115, 124, 132 
stopping emulation, 28, 129 
Toolbar, 28, 87 
trigger actions, 79, 80, 205, 208 

EmuStatus command, 124 
EnableAlarmLimit command, 124 
EnableHigh WaterMark command, 125 
eventftle, 18,60, 125,202 
EventRestore command, 125 
events 

address, 58 
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data, 59 
defining, 202 
event file, 18 
mask, 59 
overview, 57, 201 
removing, 203 
searching trace, 195 
signals, 60 
trigger condition, 53, 206 
Trigger In signal, 53 

EventSave command, 125 
Exit command, 125 
Exit dialog box, 83 
exiting SLD, 83 
expanded UO space (Intel386), 19 

fax, 3 
Fill command, 126 
Fill Memory dialog box, 185 
FillStackPattem command, 126 
Flush command, 127 
Frame dialog box, 200 
frame number, 51 
function keys, 18 
Function menu, 166 
Function pop-up menu, 59, 111 

GDT command, 127 
Get symbol address, 111 
GetBase command, 128 
global descriptor table, 127 
global variables, 30, 120 
Go command, 128 
Go From Cursor, 28 
Go To Address dialog box, 158, 184, 190 
Go To Cursor, 28 
Go To Line dialog box, 158 
Go To Peripheral dialog box, 190 
Go To Register dialog box, 190 
Golnto command, 128 
GoUntil command, 129 
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J 

Halt, 28 
Halt command, 129 
Halting emulation, 129 
hardware breakpoints, 23 
Hardware Reference, 1 
help 

function key, 18 
online Help window, 2 
Shell command syntax, 129, 130 

Help command, 129 
hexadecimal, 96 
high-water mark, 33, 74, 119, 125, 126, 

127, 179 
History command, 130 
HLDA signal, 115 

ICE Peripheral Disable Register dialog 
box,84 

ICECFGO register, 84 
IDT command, 130 
If .. Else command, 131 
Include command, 131 
include file 

see script, 17 
include.me, 96 
initialization script, 17, 69, 96 
inline functions, 25 
Instruction Mode Assist, 51, 60, 77, 79, 

198 
Integer command, 131 
Intel Evaluation Board, 115, 116 
Intel386 debug registers, 121 
Intel386 EX HLDA pin, 115 
Intel386 symbol base addresses, 134 
interrupt descriptor table, 130 
Into Call, 28 
Into Return, 28 
IsEmuHalted command, 132 

jumper, 7 
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keyboard, 19 

LapTimer command, 132 
layout, 6, 69, 75, 77, 83, 85 
LDT command, 132 
Level, 54 
levels, 210 
line numbers, 25, 26 

displaying, 72 
finding, 158 
listing, 16, 120 

linear address, 153 
linefeed, 72, 164 
Link command, 133 
Linked Cursor, 30, 61, 77, 78, 196 
linker 

see toolchains, 11 
List command, 133 
loacator 

see toolchains, 11 
Load Address dialog box, 59, 166 
Load command, 134 
Load Complete dialog box, 14 
Load dialog box, 12, 90 
Load Information dialog box, 14, 156 
Load Options dialog box, 12, 90 
loaders, 141 
loadfile 

formats, 5, 11 
load address, 11 
path, 72, 73, 157 
preparing, 5 
startup code, 13 

loading 
C++, 13 
code, 13 
during emulation, 91, 134, 135 
Load Complete dialog box, 14 
Load dialog box, 12 
Load Options dialog box, 12 
memory access size, 187 
options, 69, 70 
register initialization, 13, 134 
reloading, 12, 157 
Shell commands, 11, 12, 134, 135 
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Source window, 12 
Source window File menu, 156 
symbols, 13, 134, 140 
Toolbar, 12, 86, 89 

LoadSize command, 135 
local descriptor table, 132, 133 
local variables, 30, 111, 119, 120, 177 
Log command, 135 
log file 

configuring, 9 
Log File Name dialog box, 9 
logfile 

opening, 8, 95 
previous information, 9, 95, 112, 138 
starting, 9, 95, 135, 136 
status, 135, 136 
stopping, 9, 136 

Logging command, 136 

Map Add dialog box, 88 
Map command, 136 
Map dialog box, 87 
Map Edit dialog box, 88 
map file, 10, 18, 88, 142, 143 
mapping 

see memory mapping, 136 
MaxBitFieldSize command, 137 
memory access 

access rights, 10, 89, 136 
access size, 42, 123, 135, 143, 144, 

147, 152, 153, 186 
during emulation (Run Access), 39, 

84, 116, 123, 126, 142, 143, 144, 
152, 153 

failure, 41, 187 
Inte1386expanded1/0 space, 19 
read ahead, 41, 187 
re-read on write, 187 
write verification, 151, 152, 187 

memory contents 
ASCII,40 
copying, 116, 185 
disassembly, 40, 84, 117, 185 
display formats, 183 
filling repetitively, 126, 184 
modifying, 39, 41 
multiple Memory windows, 86, 183 
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numeric,40, 123, 185 
searching, 143, 144, 184 
Single-line Assembler dialog box, 

41, 185 
viewing, 40 
writing, 151, 152, 153 

memory mapping 
emulator differences, 10 
Map dialog box, 9 
map file, 10, 18 
overlay, 10, 89 
regions, 88, 89, 136 
Shell commands, 11, 136 
target, 10, 89 
Toolbar, 9, 84, 85 

Memory window selection dialog box, 86 
Microtek, 3 
multiple buffers, 49 

NameOf command, 137 
network, 68, 71 
newline, 72 
NONE access right, 10, 136, 137 
non-executable statement, 23 

on-line help, 18 
online help, 2 
optimization, 5 
OS/2 LAN server, 68 
overlay memory, 9, 10, 89, 115 
Overwrite command, 138 

page directory, 138 
parameters, 32, 119, 177 
PC-NFS network, 68 
PD command, 138 
peripheral registers 

access during emulation, 16 
configuring the display, 43 
Inte1386 expanded 110 space, 19 
modifying, 44, 191 
overview, 189 
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physical address, 153 
pmode, 138 
Pmodecommand, 138 
pointers, 30 
PowerPack, 1 
PP, 1 
Print command, 139 
printable symbols, 120 
processor 

bondout, 110 
emulator probe head, 8, 110 
Intel386 emulator and target CPUs, 

7, 75 
Intel386 stepping, 8, 76 
target, 8, 109 

program counter 
>>source marker, 21 
location, 159 
resetting,38,85, 140, 141, 160, 182 
source cursor, 160 
stepping, 29 

program variables 
dereferencing pointers, 169, 171 
displaying, 30, 31, 111, 167, 169, 

170, 171 
modifying, 31, 169, 170 
stack, 177 

protected modes, 138 
public symbols, 120 

qualified trace, 193, 208 

radix, 96 
RAM access right, 10, 136 
RamTst command, 139 
Read Ahead, 187 
read-after-write, 151, 152 
real mode, 138 
Register command, 139 
Register dialog box, 38 
Register Edit dialog box, 44, 181, 190, 

191 
registers 

access during emulation, 84 
ICECFGO, 84 
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initializing, 134 
see chip select file, 143 
see chip select registers, 84 
see CPU registers, 13, 121 
see debug registers, 23, 121 
see peripheral registers, 13, 121 

relocating, 144 
RemoveSymbols command, 140 
repairs, 3 
Reread On Write, 187 
reset 

CPU registers, 38, 140, 160, 182 
display, 38, 85, 140, 141, 160, 182 
emulation control, 141, 160 
program counter, 38, 85, 160, 182 
stack pointer, 38, 85, 160, 182 
target, 28, 38, 108, 115, 140 

Reset And Go, 28 
Reset command, 140 
Reset Out signal, 38, 76, 140 
RESET signal, 85, 160, 182 
ResetAndGo command, 141 
ResetLoaders command, 141 
RestoreCS command, 141 
RestoreMap command, 142 
Results command, 142 
return address, 179 
Return symbol address, 111 
ROM break access right, 10, 136 
ROM nobreak access right, 10, 136 
RS-232C, 7 
Run Access, 17, 40, 43, 84, 116, 123, 

126, 142, 143, 144, 152, 153 
RunAccess command, 142 

SAST board, 150 
SaveCS command, 143 
SaveMap command, 143 
scope, 14 
screen layout, 6, 69, 75, 77, 83, 85 
script, 17, 18 

conditional statements, 131, 152 
running,94, 96, 131 

Search Buffer dialog box, 195 
Search command, 143 
Search dialog box, 158, 170 
Search Memory dialog box, 184 
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section names, 77 
Select Baud Rate dialog box, 7, 68 
Select COM Port dialog box, 7, 71 
serial port, 4, 7, 68, 71 
service, 3 
Set Breakpoint dialog box, 24, 174 
SetBase command, 144 
SetStackAlarm command, 145 
SetStackArea command, 145 
SetStackBase command, 146 
SetStackSize command, 146 
Setup dialog box, 199 
Shell commands 

AddressOf, 111 
Alias, 111 
Append, 112 
Asm, 112 
AsmAddr, 113 
Bkpt, 113 
BkptClear, 114 
BusRetry, 114 
Cause, 115 
Clear, 115 
Config, 115 
ConfigSymbols, 116 
Copy, 116 
Dasm, 117 
DasmSym, 117 
Delete, 118 
DisableAlarmLimit, 118 
DisableHighWaterMark, 119 
DisplayStack, 119 
DisplaySymbols, 120 
DR, 121 
DT, 122 
Dump, 123 
Echo, 124 
EmuStatus, 124 
EnableAlarmLimit, 124 
EnableHigh W aterMark, 125 
EventRestore, 125 
EventSave, 125 
Exit, 125 
Fill, 126 
FillStackPattern, 126 
Flush, 127 
GDT, 127 
GetBase, 128 
Go, 128 
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Golnto, 128 
GoUntil, 129 
Halt, 129 
Help, 129 
History, 130 
IDT, 130 
lf..Else, 131 
Include, 131 
Integer, 131 
IsEmuHalted, 132 
LapTimer, 132 
LDT, 132 
Link, 133 
List, 133 
Load, 134 
LoadSize, 135 
Log, 135 
Logging, 136 
Map, 136 
MaxBitFieldSize, 137 
NameOf, 137 
Overwrite, 138 
PD, 138 
Pmode, 138 
Print, 139 
RamTst, 139 
Register, 139 
RemoveSymbols, 140 
Reset, 140 
ResetAndGo, 141 
ResetLoaders, 141 
RestoreCS, 141 
RestoreMap, 142 
Results, 142 
RunAccess, 142 
SaveCS, 143 
SaveMap, 143 
Search, 143 
SetBase, 144 
SetStackAlarm, 145 
SetStackArea, 145 
SetStackBase, 146 
SetStackSize, 146 
Signal, 146 
Size, 147 
Stacklnfo, 147 
StartTimer, 148 
Step, 148 
StepSrc, 148 
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StopTimer, 149 
String, 149 
SymbolCloseFile, 150 
SymbolOpenFile, 150 
Test, 150 
Time, 151 
Transcript, 151 
TSS, 151 
Verify, 151 
Version, 152 
While, 152 
Write, 152 
Xlt, 153 

Shell variables 
integers, 131 
listing, 133 
printing, 139 
strings, 149 

Show Load Address dialog box, 111 
Signal command, 146 
Signals 

controlled by emulator, 38, 146, 147, 
182 

event, 57, 60, 202 
HLDA,115 
RESET,38,85,140,141, 160,182 
Reset Out, 38, 76, 140 
target, 38, 60 
tracing, 60, 194 
Trigger In, 53, 79, 80, 206, 207, 210 
Trigger Out, 54, 57, 79, 80, 208, 210 

Single-line Assembler dialog box, 41, 
112, 185, 188 

Size command, 147 
SLD software, 1 
software breakpoints, 23 
source 

Index 

assembly, 21 
breakpoints, 23, 175 
browsing modules, 72, 156, 157, 

162, 164 
disassembly, 22, 84, 117, 159 
function on stack, 179 
functions, 33 
lines vs statements, 25, 128, 129 
program counter, 21 
searching, 158 
Source Path dialog box, 21 
Source window configuration, 22, 72 
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trace disassembly, 61, 77, 78, 196 
source delimiter, 72, 164 
source file, 21, 72, 73, 118, 133, 157, 162 
Source Path dialog box, 21, 163 
source-level debugger, 1 
SS:ESP 

see stack pointer, 34 
stack address, 32, 74, 177, 179 
Stack Area dialog box, 34, 178 
stack base, 34 
stack frames, 32, 119 
stack pointer 

monitored stack area, 34 
resetting, 38, 85, 140, 141, 160, 182 

stack size, 34 
stack usage 

alarm limit, 74, 118, 119, 124, 145, 
178, 179 

configuring,32 
configuring the display, 33, 74 
function source, 179 
high-water mark, 74, 119, 125, 126, 

127,179 
monitored area, 34, 74, 126, 127, 

145, 146, 178 
overview, 177 
stepping, 33 

Stacklnfo command, 147 
StartTimer command, 148 
static variables, 30 
status 

break cause, 28, 108, 115 
emulation, 28, 108, 124, 132 
tracing, 60 

Step command, 148 
Step Continuously, 28 
Step Count dialog box, 164 
stepping 

break cause, 108, 115 
C++,28 
calls and returns, 29, 148, 149, 160 
configuring, 72 
inline functions, 25 
lines vs statements, 148, 149, 164 
overview, 27 
program counter, 29 
Shell commands, 148, 149 
Source window, 160, 165 
speed,28 
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StepSrc command, 148 
StopTimer command, 149 
String command, 149 
string constant, 139 
SW, 1 
symbol file, 120, 150 
symbol table 

C++, 13 
contents, 14 
displaying bases, 128 

SymbolCloseFile command, 150 
symbolic address, 14 
symbolic debugging 

address translation, 137, 153 
breakpoint, 174 
breakpoints, 23, 24, 26 
C++, 13,24,29,69, 70 
descriptor tables, 116 
disassembly, 22, 40, 84, 117 
event address, 58, 201 
function scope, 32 
list symbols, 120 
loading, 13,69, 70,90,91, 134, 140 
memory, 40, 183, 184 
name resolution, 14 
name scope, 14 
preparing loadfile, 5 
program variables, 30, 169 
single-line assembly, 112 
source, 21, 22 
stack, 32, 119 
symbol base address, 84, 91, 116, 

144 
symbol scope, 120 

SymbolOpenFile command, 150 
syntax, 97 
system variables 

$BREAKCAUSE, 108 
$EMULATING, 108 
$PROCESSOR, 109 
$PROCFAMILY, 109 
$PROCTYPE, 109 
$SHELL_STATUS, 110 
$SYSTEMTYPE, 110 

tab width, 72 
Tab Width dialog box,, 163 
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target memory, 10, 16, 89 
task state segments, 151 
telephone, 3 
temporary breakpoint, 23 
Test command, 150 
Time command, 151 
timeout, 114, 115 
timer 

see trigger actions, 56 
see trigger conditions, 56 
Shell lap timer, 132, 148, 149 
Trigger window, 210 

timestamps, 51, 52, 77, 78, 193, 196, 
199,208 

Toolbar 
exiting the SLD software, 6 
loading, 12 
mapping memory, 9, 84 
overview, 6 

toolchains 
Borland C, 11, 77, 137 
HiWare, 81 
linker directives, 13 
loadfile format, 5 
MaxBitFieldSize, 11, 77, 137 
section names, 77 
unsupported, 5 

trace buffers 
also see trace frames, 60 
clearing, 195 
contents, 50 
Linked Cursor, 61 
multiple buffers, 79, 197, 199, 208 
overview, 49 
searching, 195 
trigger position, 50, 79, 197, 198 
viewing, 60 

Trace Capture dialog box, 47, 49, 198, 
208 

trace control 
bus cycles, 51, 77, 79, 208 
clock cycles, 51, 77, 79, 208 
disassembly, 51, 77, 79, 196 
function keys, 18 
manual, 47, 197 
qualified trace, 200 
starting with emulation, 47, 77, 79 
Toolbar buttons, 87 
triggering,48,49,50, 77, 79,208 
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Trace Control dialog box, 49, 197, 208, 
209 

trace file, 194 
trace frames 

contents, 48, 51, 193 
disassembly, 51, 77, 78, 117, 196 
display formats, 77, 78, 193, 195 
timestamps, 52, 77, 78, 196, 199 
trigger frame, 200 

Trace Save As dialog box, 194 
trademarks, iv 
Transcript command, 151 
Transcript pane 

commands, 8 
emulator responses, 8 
logging, 8 

trigger actions 
condition sequencing, 210 
counters, 56, 79, 80, 208, 209 
emulation control, 79, 80 
overview, 207 
precedence,50,54 
timers, 56, 79, 80, 208, 209 
trace control, 48, 49, 50 
Trigger Out signal, 54, 57, 79, 80, 

210 
trigger conditions 

bus or clock cycles, 51, 79, 80, 209 
counters, 56, 79, 80, 206, 209 
events, 53 
overview, 53, 206 
sequencing, 54, 210 
timers, 56, 79, 80, 206, 207, 209 
Trigger In signal, 79, 80, 210 

Trigger In signal, 53, 79, 80, 206, 207, 
210 

Trigger Out signal, 54, 57, 79, 80, 208, 
210 

TSS command, 151 

UNIX newline, 72, 165 
Unterminated Memory Access error, 187 
Up & Running, 1 
updates, 3 
User's Manual, 1 
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Variable pop-up menu, 30, 167 
variables 

see program variables, 30 
see Shell variables, 30 

Verify command, 151 
Version command, 152 
virtual address, 14 
virtual-86 (V86) mode, 138 

warranty, 3 
While command, 152 
Windows 

communications, 7, 68 
documentation, 2 
host system requirements, 3 
interface, 69, 75, 77, 83, 85, 94 
stepping speed, 28 
window navigation keys, 18 

World Wide Web, 3 
Write command, 152 
write verification, 187 

Xltcommand, 153 
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